
 

 



 

The information in this publication is provided for reference only. All information contained in 
this publication is believed to be correct and complete. Thermo Fisher Scientific shall not be liable 
for errors contained herein nor for incidental or consequential damages in connection with the 
furnishing, performance or use of this material. All product specifications, as well as the 
information contained in this publication, are subject to change without notice. 
 
This publication may contain or reference information and products protected by copyrights or 
patents and does not convey any license under our patent rights, nor the rights of others. We do 
not assume any liability arising out of any infringements of patents or other rights of third parties. 
 
We make no warranty of any kind with regard to this material, including but not limited to the 
implied warranties of merchantability and fitness for a particular purpose. Customers are ultimately 
responsible for validation of their systems. 
 
© 1995-2007 Thermo Fisher Scientific Inc. All rights reserved. No part of this publication may be 
stored in a retrieval system, transmitted, or reproduced in any way, including but not limited to 
photocopy, photograph, magnetic or other record, without our prior written permission. 
 
For technical assistance, please contact: 
 
Technical Support 
Thermo Fisher Scientific 
5225 Verona Road 
Madison WI  53711-4495 
U.S.A. 
 
Telephone:  1 800 642 6538 (U.S.A.) or +1 608 273 5017 (worldwide) 
Fax:  +1 608 273 5045 (worldwide) 
E-mail:  us.techsupport.analyze@thermofisher.com 
World Wide Web:  http://www.thermo.com/spectroscopy
 
Windows, Windows NT, Windows Vista and MS-DOS are either trademarks or registered 
trademarks of Microsoft Corporation in the United States and/or other countries. 
ENVI is either a trademark or registered trademark of Research Systems, Incorporated in the 
United States and/or other countries. 
All other trademarks are the property of Thermo Fisher Scientific Inc. and its subsidiaries. 
 
269-170502 

 

http://www.thermo.com/spectroscopy


 

 Contents 
 
 
 

Introduction............................................................................................................1 
Manual conventions................................................................................2 
Starting OMNIC Atlµs ...........................................................................3 

About Z-axis initialization for Continuµm microscopes .......................3 
On-line Help ..........................................................................................5 
Exiting the software ................................................................................6 
Questions or concerns.............................................................................6 

 
Overview ................................................................................................................7 

Introduction to mapping.........................................................................7 
The three kinds of maps.......................................................................7 
The importance of sample focus.........................................................11 

About autofocus..............................................................................11 
What is calibration?............................................................................13 
Collecting backgrounds for FT-IR experiments..................................14 
Using an aperture...............................................................................15 

Performing an FT-IR or FT-Raman mapping experiment.....................16 
Before you start ..................................................................................16 
Step 1:  Position the sample on the stage and focus ............................17 
Step 2:  Specify the map sequence ......................................................17 
Step 3:  Set the data collection parameters..........................................18 
Step 4:  Set the profile and display options (optional).........................19 
Step 5:  Collect the map.....................................................................19 

Performing a visible Raman mapping experiment .................................20 
Before you start ..................................................................................20 
Step 1:  Position the sample on the stage and focus ............................20 
Step 2:  Specify the map sequence ......................................................21 
Step 3:  Set the data collection parameters..........................................21 
Step 4:  Set the profile and display options (optional).........................21 
Step 5:  Collect the map.....................................................................22 

 
Configuring the System .....................................................................................23 

Configuring the video ...........................................................................25 
Setting the video source parameters....................................................25 
Video calibration................................................................................26 

Calibrating the video image.............................................................27 
Opening a saved calibration ............................................................33 

 



 

Editing a saved calibration...............................................................33 
Copying a saved calibration.............................................................34 
Deleting a saved calibration.............................................................34 

ATR calibration .................................................................................36 
Performing an ATR calibration .......................................................37 
Opening a saved ATR calibration....................................................41 
Deleting a saved ATR calibration ....................................................41 

Aligning the video cross hairs .............................................................42 
Specifying the video input type ..........................................................43 
Specifying the video connector type or camera resolution...................43 

Microscope configuration......................................................................44 
Selecting a microscope configuration..................................................44 
Initializing the stage ...........................................................................44 

Initializing the stage on an FT-IR or FT-Raman system..................44 
Initializing the stage on a visible Raman system...............................45 

Initializing the automated Reflex aperture ..........................................45 
Limiting the stage travel .....................................................................46 
Configuring the microscope ...............................................................48 

Specifying the microscope model ....................................................49 
Specifying the stage model ..............................................................49 
Specifying the motorized Z-axis ......................................................50 
Setting the Auto Apertures, Autofocus and Auto ATR options........50 
Calibrating the Reflex aperture........................................................51 
Calibrating the stage........................................................................52 
Configuring the joystick..................................................................53 

 
Preparing for Data Collection.......................................................................... 55 

The Atlµs window.................................................................................55 
The navigation pane...........................................................................56 
The video pane...................................................................................57 
The tool palette ..................................................................................59 
Changing the view by moving the stage..............................................62 

Changing the view with the stage movement buttons......................62 
Moving the stage by clicking a point ...............................................62 
Moving the stage by dragging the cross hairs ...................................63 
Moving the stage to its home position.............................................63 
Moving the stage to the origin point ...............................................63 
Moving the stage to a sample point .................................................64 
Moving the stage to a background point .........................................64 
Moving the stage to every sample and background point.................64 
Moving the stage to a marker ..........................................................65 
Moving the stage with the Move Stage command ...........................65 

 



 

Zooming in or out .............................................................................68 
Using the zoom buttons..................................................................68 
Zooming in on a map .....................................................................69 
Displaying the full range of stage travel ...........................................69 

Using the focus buttons .....................................................................69 
Autofocus calibration ......................................................................71 

Selecting a calibration ...........................................................................72 
Specifying a map sequence ....................................................................73 

Opening a map sequence ...................................................................73 
Drawing maps and other items in the Atlµs window ..........................74 

Drawing a line map.........................................................................74 
Drawing an area map (or Mosaic) ...................................................76 
Specifying discrete sample points ....................................................78 
Specifying an ordered array of discrete points..................................80 
Setting the Z position for a discrete point to the current Z  
 position............................................................................82 
Specifying a background point ........................................................82 
Drawing an aperture .......................................................................83 
Displaying a ruler............................................................................84 
Adding text annotation ...................................................................86 
Adding a marker .............................................................................88 

Moving maps and other items in the Atlµs window............................89 
Moving a line map ..........................................................................89 
Moving an area map or box drawn to specify a Mosaic ...................89 
Moving a discrete sample point or background point ......................90 
Moving the ruler .............................................................................90 
Moving text annotation ..................................................................91 
Moving a marker.............................................................................92 

Resizing maps and other items in the Atlµs window...........................92 
Resizing a line map .........................................................................92 
Resizing an area map or box drawn to specify a Mosaic...................93 
Resizing a drawn aperture ...............................................................94 
Resizing the ruler ............................................................................95 

Deleting maps and other items in the Atlµs window ..........................95 
Deleting a line map.........................................................................95 
Deleting an area map ......................................................................96 
Deleting a sample point ..................................................................96 
Deleting a background point...........................................................96 
Deleting a drawn aperture...............................................................97 
Deleting a ruler ...............................................................................97 
Deleting text annotation .................................................................97 

 



 

Deleting a marker ...........................................................................98 
Deleting all the displayed markers ...................................................98 

Editing text annotation ......................................................................98 
Rotating a drawn aperture ..................................................................99 
Setting the Mapping options ............................................................100 

Specifying annotation colors .........................................................103 
Specifying a default step size..........................................................104 
Connecting text annotation with a line .........................................104 
Displaying a border around text annotation ..................................105 
Focusing after each stage movement..............................................105 
Specifying how to print map windows ..........................................105 

Clearing a map sequence .....................................................................106 
Restoring a cleared map sequence.....................................................106 

Saving a map sequence ........................................................................107 
Setting the data collection parameters for FT-IR and FT-Raman  
 experiments ....................................................................107 

Saving interferograms with the map .................................................109 
Background handling .......................................................................109 
Setting the gain ................................................................................111 
Specifying the sample location and collection mode .........................111 
Specifying the frequency range .........................................................112 
Specifying the detector for the Continuµm XL.................................112 
Setting the beam path for the Continuµm XL ..................................112 
Setting the Mapping parameters.......................................................113 

Setting the Dimensions parameters ...............................................113 
Setting the Background parameters ...............................................115 
Setting the Profile parameters........................................................115 
Setting special mapping options ....................................................116 
Specifying the automated Reflex aperture......................................120 
Setting the focus parameters ..........................................................122 

Setting the data collection parameters for visible Raman experiments..124 
Specifying the sample location..........................................................125 
Specifying the spectral range.............................................................125 
Setting the Mapping parameters.......................................................126 

Setting the Dimensions parameters ...............................................126 
Setting the Profile parameters........................................................131 
Setting special mapping options ....................................................132 
Setting the focus parameters ..........................................................133 

Working with video images and Mosaics.............................................135 
Capturing and saving the video image for sample points ..................135 
Saving the video image .....................................................................136 

 



 

Using Mosaics..................................................................................137 
Capturing a Mosaic of video images for a sample area ...................137 
Clearing a Mosaic from the navigation pane .................................138 
Copying a Mosaic .........................................................................139 
Saving a Mosaic ............................................................................139 

Setting the automated Reflex aperture.................................................140 
Adjusting the automated Reflex aperture graphically ........................140 
Setting the automated Reflex aperture numerically...........................141 
Setting the automated Reflex aperture to the default ........................142 

Setting the FT-Raman View Stage origin ............................................143 
 

Collecting Data..................................................................................................145 
Collecting a map background..............................................................145 

Collecting a background spectrum at the current stage location .......148 
Collecting an FT-IR or FT-Raman map .............................................150 
Collecting a visible Raman map ..........................................................154 

Collecting a depth profile.................................................................156 
Collecting a sample spectrum at the current stage location ..................158 

Collecting an FT-IR or FT-Raman spectrum at the current stage  
 location ..........................................................................158 
Collecting a visible Raman spectrum at the current stage location ....160 

Collecting ATR data with autofocus ...................................................161 
Using auto ATR contact .....................................................................163 

 
Opening and Importing Map Data .................................................................167 

Opening a map or files from a split map .............................................167 
Importing map data ............................................................................169 

 
Displaying Map Data .......................................................................................171 

Using map windows............................................................................171 
Contour maps ..................................................................................176 

Line and line depth profile contour maps......................................177 
Area and area depth profile contour maps .....................................179 
Discrete point location maps.........................................................180 

Video pane.......................................................................................181 
Spectral display pane ........................................................................184 
Using the 3-D display ......................................................................185 

3-D image for line maps and line depth profiles ............................185 
3-D image for area maps and area depth profiles ...........................186 

Profile panes.....................................................................................188 
Profile pane for line maps and line depth profiles ..........................189 
Profile panes for area maps and area depth profiles........................190 

 



 

Adjusting the display with the sky view control ................................190 
Zooming in and out on map data.....................................................193 
Zooming in on an area in the spectral display pane ..........................195 
Animating your view of the map data...............................................196 
Copying the 3-D image, video image, displayed spectra or contour  
 map................................................................................197 

Viewing information about a map.......................................................198 
Viewing information about a profile....................................................200 
Viewing information about quantitative analysis results ......................201 
Setting the display parameters .............................................................202 

Mapping – General display parameters.............................................203 
Specifying the items to display ......................................................204 
Selecting a color scheme................................................................206 
Specifying the background and foreground thresholds ..................207 
Setting the thresholds automatically ..............................................207 
Setting the spectral display parameters...........................................208 
Setting the color limits ..................................................................208 
Inverting the color scheme ............................................................208 

2-D View display parameters............................................................209 
Selecting the resolution for the contour map .................................209 
Selecting the smoothing type for the contour map ........................210 
Selecting a cursor style for the contour map or discrete point  
 location map ..................................................................210 
Specifying a color for the contour map or discrete point location  
 map cursor .....................................................................211 
Hiding the contour map or discrete point location map cursor .....211 
Setting the contour parameters......................................................211 
Preserving the X-Y proportion.......................................................213 

3-D View display parameters............................................................213 
Selecting the resolution of the 3-D image......................................214 
Setting the opacity of the 3-D image .............................................214 
Selecting a cursor style for the 3-D image......................................215 
Selecting a navigation mode ..........................................................216 
Displaying the 3-D image in perspective .......................................217 
Clipping the data outside the color range ......................................217 
Displaying an outline box .............................................................218 
Displaying the map title above the 3-D image...............................218 
Displaying surfaces in the 3-D image ............................................219 
Displaying the 3-D image as a wireframe ......................................219 
Smoothing the 3-D image.............................................................220 
Displaying the full volume of the 3-D image.................................220 
Specifying a color for the 3-D image cursor...................................221 

 



 

Hiding the 3-D image cursor ........................................................221 
Setting the number of iso-surfaces or contours to display ..............221 
Displaying profile lines in the 3-D image ......................................222 
Specifying the orientation of the profile lines ................................223 
Setting the number of profile lines in the 3-D image.....................225 

Video display parameters..................................................................226 
Changing the brightness and contrast ...........................................226 
Selecting a cursor style for the video image....................................227 
Setting the video annotation parameters........................................228 
Displaying markers .......................................................................228 
Specifying colors for the video image cursor and markers ..............228 

Setting the display limits .....................................................................229 
Displaying the current profile or a saved profile ..................................239 
Overlaying the video image and contour map or discrete point  
 location map ..................................................................240 

 
Processing and Analyzing Map Data ...........................................................243 

Creating a profile ................................................................................243 
Using the tool palette .......................................................................250 

Zooming in on a portion of a spectrum.........................................250 
Selecting a spectral region .............................................................250 
Finding the X and Y values of a data point....................................251 
Specifying peak locations and baselines .........................................251 
Specifying peak areas and baselines ...............................................253 

Converting a map to other units .........................................................255 
Reprocessing a map.............................................................................256 
Retrieving interferograms saved with map spectra ...............................257 
Saving an area map profile as a CSV text file .......................................257 
Truncating the spectral and spatial ranges of a map.............................258 
Extracting a line map from an area map ..............................................260 
Viewing, editing or creating functional groups ....................................262 
Correcting map spectra .......................................................................266 

Correcting the baselines of map spectra automatically ......................266 
Using Advanced ATR Correction ....................................................266 
Correcting map spectra for dispersion effects or water and carbon  
 dioxide absorptions ........................................................267 

Blanking a spectral region ...................................................................267 
Replacing a spectral region with a straight line ....................................270 
Smoothing map data...........................................................................272 

Smoothing map spectra by specifying the number of smoothing  
 points.............................................................................272 
Smoothing map spectra automatically ..............................................275 

 



 

Changing the data spacing ..................................................................276 
Performing math operations on map spectra .......................................280 

Performing a scaled subtraction on map spectra ...............................280 
Subtracting a component or contaminant from map spectra ............282 
Multiplying map spectra by a number ..............................................283 
Converting map spectra to their first and second derivatives.............283 
Performing spectral math operations ................................................288 

Normalizing the frequency of the data ................................................292 
Normalizing the scale of the data ........................................................292 
Shifting and unshifting FT-Raman map data ......................................293 
Splitting a map into separate data files.................................................293 
Quantifying a map ..............................................................................296 

Specifying a quant method ...............................................................296 
Quantifying the map........................................................................296 

Principal component analysis (PCA) ...................................................302 
Performing a principal component analysis ......................................302 
Recalculating principal component analysis results ...........................309 

Using Multivariate Curve Resolution ..................................................311 
Finding component locations..............................................................319 

 
Analyzing Images ............................................................................................. 323 

Using gray scale filters .........................................................................324 
Morphology options ...........................................................................327 
Performing an image analysis ..............................................................333 

 
Saving and Exporting Map Data.................................................................... 347 

Saving a map.......................................................................................347 
Saving a map with a new file name or in a different location ............347 

Saving the current map background ....................................................349 
Exporting map data.............................................................................350 

 
Printing ............................................................................................................... 351 

Printing a map window, profile window or quant results window .......351 
Printing items displayed in a map window, profile window or quant 
results window ....................................................................................352 
Printing a Mosaic ................................................................................353 

 
Index ................................................................................................................... 355 
 

 



 

 Introduction 
 
 
This manual explains how to use Thermo Scientific OMNIC™ Atlµs™ 
software to perform automated data collection and spectral mapping 
experiments as well as image analysis with your microspectrometer system. 
You can automatically collect different types of compositional maps and 
display the collected data in a variety of formats. You can also create reports 
containing map data and print contour maps, 3-D displays, and 
comprehensive video images of the sample. 
 
Before you begin working with the software, read the overview of 
automated data collection in the “Overview” chapter, which describes the 
main steps of performing an experiment. Then refer to the remaining 
chapters as you use the software. They describe in detail how to use the 
special windows and menu commands to collect and manipulate mapping 
data. 
 

 
 

 

This manual covers only those features that are of special importance to 
OMNIC Atlµs. For information about standard OMNIC or OMNIC For 
Nicolet™ Almega™ features, choose OMNIC Help Topics from the Help 
menu. For information about optional OMNIC For Raman features, 
choose Raman Help Topics from the Raman menu (if present). For 
detailed information about using your microscope, motorized stage and 
video equipment, see the manuals or on-line documentation that came with 
each product. 
 
For information about system requirements, see the document titled 
Computer Requirements for Instruments Controlled by OMNIC Software that 
came with your software. 
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Manual conventions The following conventions are used in this manual to draw your attention 
to important information: 
 

 Note Notes contain helpful supplementary information. S 
 

 Important Follow instructions labeled “Important” to avoid damaging the system 
hardware or losing data. S 
 

  Caution Indicates a potentially hazardous situation which, if not avoided, may result 
in minor or moderate injury. It may also be used to alert against unsafe 
practices. S 
 

   Warning Indicates a potentially hazardous situation which, if not avoided, could 
result in death or serious injury. S 
 

   Danger Indicates an imminently hazardous situation which, if not avoided, will 
result in death or serious injury. S 
 

  This symbol marks the start of a list of helpful tips for using the feature 
being discussed. 
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Starting OMNIC Atlµs Follow these steps to start OMNIC Atlµs: 
 
1. Start Windows®. 
 
 
2. Click the Start button on the Windows taskbar and then click All 

Programs (Programs in Windows 2000). 
 
 
3. In the Thermo Scientific OMNIC folder, click the OMNIC 

program. 
 
 The OMNIC window appears with the Atlµs menu present in the 

menu bar. You can now define and collect a new map by using Show 
Atlµs Window in the Atlµs menu or open a stored map by using the 
Open in the File menu. See “The Atlµs window” in the “Preparing for 
Data Collection” chapter or “Opening a map or files from a split map” 
in the “Opening and Importing Map Data” chapter for details. 

 
 Note The first time you start OMNIC Atlµs, the Microscope Configuration 

dialog box appears allowing you to configure the microscope stage and 
other hardware. You will be able to change your settings later by using 
System Configuration in the Atlµs menu. See “Configuring the 
microscope” in the “Configuring the System” chapter for instructions for 
using this dialog box. S 

 
 

About Z-axis 
initialization for 

Continuµm microscopes 

If you have a Continuµm microscope with one of the optional automation 
packages, you can use OMNIC Atlµs to control stage movement along the 
Z-axis (up and down). Each time you turn on the Continuµm microscope 
power, the Z-axis position of the stage must be initialized before you can 
use OMNIC Atlµs to control movement of the stage in the Z dimension. 
Z-axis initialization is not completely automatic; you must take steps to 
protect the microscope hardware. 
 
Follow these steps to initialize the Z-axis: 
 
1. Lower the condenser all the way and remove the nosepiece from the 

microscope. 
 
 
2. Turn on the Continuµm microscope power. 
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3. Start OMNIC Atlµs. 
 
 
4. Choose System Configuration from the Atlµs menu. 
 
 The System Configuration dialog box appears. Here is an example: 
 

  
 
 
5. Click the Z-Axis button and then follow the instructions that 

appear on the screen. 
 

 Important To prevent damage to the microscope, make sure the condenser has been 
lowered all the way and the nosepiece has been removed from the microscope 
before initialization begins, as explained in the on-screen instructions. Do not 
choose OK (or Yes) before lowering the condenser and removing the nosepiece. 
S 
 

• If you choose OK (or Yes) to initialize the Z-axis, the stage moves to its 
upper and lower limits and then back to the origin. The initialization 
takes a minute or two; a message is displayed until the process is 
complete. After initialization, the stage returns to its former position. 
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• If you cancel the initialization, a message informs you that all 
automation involving control of movement along the Z-axis has been 
disabled. This includes auto ATR contact, software control of Z-axis 
movement, and autofocus. Choose OK. If you want to use these 
features later, you must restart the microscope, start OMNIC Atlµs and 
then initialize the Z-axis. 

 
 

6. Reinstall the nosepiece. 
 
 

On-line Help To see Help information about the unique OMNIC Atlµs features, choose 
Atlµs Help Topics from the Help menu. From the Help window that 
appears, you can display information about the feature of interest. 
 
You can also use context-sensitive Help to display information: 
 
• You can see information about many features in OMNIC Atlµs (such 

as a parameter in a dialog box) by clicking the feature using the right 
mouse button. (If the active dialog box or window includes a question 
mark button near the upper-right corner, you may need to first click 
that button and then click the feature of interest using the left mouse 
button.) A brief description of that feature appears along with a 
Discussion button or How To button, or both. (This type of Help may 
not appear for some features.) Click the Discussion button to see a 
more detailed discussion of the feature or dialog box. Click the How 
To button to see a step-by-step procedure for using the dialog box. 

 
• To see information about a menu command, click the menu name to 

display the menu, use the down arrow key to highlight the name of the 
command, and then press the F1 function key. You can also press F1 
when the dialog box or window for a command is displayed. 

 
• If a dialog box or window contains a Help button, click it to see 

information about the features in the dialog box. 
 
To see information about standard OMNIC features, choose OMNIC 
Help Topics from the Help menu. To see information about optional 
OMNIC For Raman features, choose Raman Help Topics from the Raman 
menu (if present). You can also use context-sensitive Help as explained 
above for both OMNIC and OMNIC For Raman features. 
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Exiting the software Choose Exit from the File menu to exit OMNIC Atlµs. 

 
 Note You can also exit OMNIC Atlµs by clicking the OMNIC window’s Close 

button (labeled “X”) in the upper-right corner of the window. S 

 
 

Questions 
or concerns 

In case of emergency, follow the procedures established by your facility. If 
you have questions or concerns about safety or need assistance with 
operation, repairs or replacement parts, you can contact our sales or service 
representative in your area or use the information at the beginning of this 
document to contact us.  
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 Overview 
 
 
This chapter provides an overview of collecting and working with 
microspectrometry data. It includes a summary of how to use OMNIC 
Atlµs to perform compositional mapping experiments, including 
automated point-of-interest analyses (at discrete sample points). 
 
The software commands mentioned in this chapter are described in detail 
in later chapters. 
 
 

Introduction 
to mapping 

Compositional mapping in infrared, Raman and visible Raman 
microspectroscopy is a powerful analytical technique. By obtaining a series 
of spectra over a sample area, you can record the changes in the chemical 
composition of a sample and relate them to the visible image. Often, 
mapping is the only way that such detailed information can be obtained. 
 
Mapping allows you to collect a large number of spectra quickly and 
automatically. By linking the parts of the mapping system—the 
microscope, motorized stage, video image and software—OMNIC Atlµs 
lets you efficiently analyze complex, microspectroscopic-size samples. 
Mapping performed using a Continuµm XL microscope with an array 
detector (also known as “imaging”) lets you collect a map very quickly. 
 
 

The three 
kinds of maps 

You can use OMNIC Atlµs to collect three different types of maps:  line 
maps (including line depth profiles), area maps (including area depth 
profiles), and maps consisting of data collected at discrete sample points 
(for example, discrete points in an ordered array). (Collecting a depth 
profile requires a visible Raman microscope.) 
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A line map consists of a series of spectra collected at sample points evenly 
spaced along a straight line on the sample. The following example shows 
the locations of the sample points for a line map. 

 
 
 
 
 
 
 
 
 

The tick marks on the line indicate 
the locations of the sample points. 

 
 
Line maps are useful for profiling across a boundary, such as a diffusion 
gradient of a solvent migrating across a polymer. 
 
See “Setting up data collection” in the “Preparing for Data Collection” 

 Note ectra 
 vertical axis within the sample using a visible Raman 

icroscope. In this manual the term “map” includes depth profiles. See 
 

 Note fter data collection you can extract a line map from an area map, as 
explained in “Extracting a line map from an area map” in the “Processing 
and Analyzing Map Data” chapter. S 

 

chapter or “Drawing a line map” in the “Preparing for Data Collection” 
chapter for complete information on specifying a line map. 
 
Similar to a line map is a line depth profile, an evenly spaced series of sp
collected along a
m
“Collecting a depth profile” in the “Collecting Data” chapter for more
information. S 

 
A
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An area map is a series of spectra collected at sample points within a 
rectangular array. Here is an example showing the locations of the sample 
points for an area map. 

 
 
 
 
 
 
 
 
 
 
 

The dots indicate the 
locations of the sample points. 

 
 
Area maps are most useful for compositional mapping of a discrete artifact 
within a sample, such as an inclusion in a film. 
 

 Note Similar to an area map is an area depth profile. This is created by collecting 
evenly spaced spectra along a series of evenly spaced vertical axes within the 
sample using a visible Raman microscope. See “Collecting a depth profile” 
in the “Collecting Data” chapter for more information. S 
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If a sample has one or several areas of interest, you can use OMNIC Atlµs 
to specify discrete points at which to collect spectra. Examples of this type of 
sample are scattered contaminants on a metal surface or a polymer film 
whose uniformity you want to measure. The following example shows 
some individually specified sample points. The points are labeled with 
consecutive numbers. 

 

 
 
See “Specifying discrete points” in the “Preparing for Data Collection” 
chapter for complete information on specifying individual sample points. 
 
You can also collect spectra of individual samples positioned in an ordered 

d spectrum. (A 
background point is not needed for FT-Raman or visible Raman mapping 
experiments.) OMNIC Atlµs lets you easily specify these points by using 
the mouse or entering coordinates. The points you specify are labeled with 
consecutive numbers. 
 
After you choose a map type, the next step in a mapping experiment is to 
define the area to be mapped (including the background location if needed) 
and set the data collection parameters. The map information is called a 
sequence and is part of the current experiment. You can save a sequence, 
and the rest of the experiment parameter settings, in an experiment file that 
can be opened later and used for other samples. 

array, such as samples regularly spaced on a microscope slide. See 
“Specifying an ordered array” in the “Preparing for Data Collection” 
chapter for details. 
 
Even the most routine FT-IR analysis of a single point of interest requires a 
sample point and a background point for a ratioe
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After the sequence is defined, you can collect the map. The software lets 
you display the collected data in several different ways, depending on what 
information about the sample is of interest. For example, you can display a 
contour map, with colors or lines representing different spectral intensities. 
You can also display individual spectra from a map. 
 
See the “Preparing for Data Collection” chapter for complete information 
on specifying line maps, area maps, discrete sample points and depth 
profiles. 
 
 

The importance 
of sample focus 

One of the most important steps in any microspectroscopy experiment is 
properly presenting the sample to the microscope. For mapping 
experiments it is very important that the sample be level over the entire 
mapping region. If the sample is not level, the focus will change as the 
microscope stage moves different areas of the sample into the path of the 
beam. The spectra collected from areas that are not in focus could lead to 
baseline drifts, loss of spatial resolution and decreased signal-to-noise ratios.
 
Therefore, the first step in setting up a mapping experiment is to ensure 
that the sample is level on the microscope stage. If you cannot make the 
sample level over the entire mapping region, it will be necessary to refocus 
the stage before each spectrum is collected during the experiment. You can 
use Auto-Pause Before Each Spectrum (available through the Collect 
button on the Mapping tab of the Experiment Setup dialog box) to set the 
software to pause before collecting each spectrum so that you can adjust the 
focus. If you have the optional autofocus feature, you can use Autofocus At 
Each Map Point (All Map Types) (available through the Focus button on 
the Mapping tab of the Experiment Setup dialog box) to specify that the 
microscope be focused automatically before collecting each sample 
spectrum. See “Setting the focus parameters” in the “Preparing for Data 
Collection” chapter for details. 
 
 

About autofocus The optional autofocus feature lets you focus the microscope automatically 
using the focus buttons. When you initiate focusing with the buttons, the 
motorized autofocus equipment raises or lowers the stage (along the Z-axis) 
to bring the view of the sample surface into focus. 
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 Note If you have the autofocus option, leave the Autogain switch (if present) on 
the video camera turned off unless you are performing a reflection 
experiment on a highly reflective substrate such as a gold mirror. S 

 
On the Mapping tab of the Experiment Setup dialog box (available through 
Experiment Setup in the Collect menu), the Focus button lets you specify 
whether and how to focus the microscope automatically during data 
collection. See “Setting the focus parameters” in the “Preparing for Data 
Collection” chapter for details. 
 

 Note If you have a Centaurµs microscope with a motorized XL stage and the 
optional motorized Z-axis, you can use the Autofocus button in the Atlµs 
window. See “Using the focus buttons” in the “Preparing for Data 
Collection” chapter for more information. S 

 
 
Tips for using autofocus 
 
Autofocus operates by optimizing video image contrast as it moves the stage 
up and down. The maximum distance moved in either direction is 1.0 mm. 
If the system does not detect an optimum video image contrast, the 
software informs you that autofocus has failed. If you are performing a 
mapping experiment, the microscope continues to collect the map even if 
autofocus has failed. 
 
Some low-contrast samples or samples with multiple focal planes (such as a 
sample in a diamond compression cell) can confuse the autofocus feature 
and cause a failure. 
 
There are a number of things you can do to improve the system’s autofocus 
performance and avoid failures: 
 
• Bring the sample’s vertical position to within 1.0 mm of correct focus. 

To do this, view the sample from the side (not through the eyepieces or 
on the video monitor) and raise or lower the stage to sharply focus the 
dot of white light hitting the sample surface. 
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• Adjust the illumination for optimum viewing. You should be able to 
see contrasting sample features. If the illumination is too high or too 
low, the autofocus feature will not be able to make use of contrast to 
optimize the focus. 

 
• If your microscope has field apertures, adjust them so that they are apparent 

in the field of view. For difficult samples, first adjust the aperture so that 
its opening is completely within the field of view and then use 
autofocus. The edges of the aperture provide additional contrast that 
helps the system focus automatically. 

 
Autofocus is generally successful when the above techniques are used. 
However, there are some notable samples that may still be difficult to focus: 
 
• A sample with a perfectly smooth surface; for example, a new gold 

mirror. This sample is difficult because it has no sample features. A 
used gold mirror generally has a few imperfections that increase 
autofocus success. 

 
• Highly diffuse samples. Samples that have multiple points of focus 

(paper, powder, etc.) generally cannot be focused automatically. 
 
There is a way to overcome the limitations of autofocus for samples with 
poor contrast or with multiple points of focus:  Use the Use Stored Focus 
Locations (Discrete Points Only) option to make use of stored focus 
positions. See “Focus parameters” in the “Preparing for Data Collection” 
chapter for details. 

 
 

What is calibration? When you use a video camera with a microscope, the magnification and 
field of view displayed on the video screen are different from what you see 
through the microscope eyepiece. When you change the microscope 
objective, the dimensions of the video system’s field of view change. 
Because the video image is directly related to the stage position and 
magnification of the objective, there must be a way to tell the software the 
new size, in micrometers, of the video system’s field of view so that the map 
can be defined correctly. This is known as calibrating the video image. 
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Your software provides a way to create and save calibrations for your 
different objectives. This lets you retrieve the appropriate video calibration 
when you change the objective, rather than having to recalibrate the video 
image. 
 
The first time you use the software and microscope together, you are 
prompted to create a new calibration. (The prompt also appears when you 
choose Show Atlµs Window from the Atlµs menu if a calibration has not 
been performed.) Once a calibration has been created, the calibration used 
as the default when you start the software will be the last calibration 
selected the last time the software was run. 
 

 Note Whenever there is no current calibration for the video image, the stage will 
not function properly. Use the Video Calibration button in the System 
Configuration dialog box to calibrate the video image or to open a 
calibration. S 

 
See “Calibrating the video image” in the “Configuring the System” chapter 
for complete information on creating and saving a calibration and opening 
a stored calibration. 
 
 

Collecting backgrounds 
for FT-IR experiments 

One or more background spectra are normally needed when you perform 
an infrared mapping experiment. It is very important that the background 
for a map be collected at the proper location. The background spectrum 
should not show any infrared absorptions but effectively compensate for 
any instrumental responses. A list of suggested background materials is 
provided in the section called “Collecting a background” in the “Collecting 
Data” chapter. 
 
If your sample does not have an area suitable for collecting a background, 
you can collect one using a different material before setting up the sample 
for data collection. An example of this situation is a reflection-absorption 
experiment in which a background spectrum is collected using a separate 
mirror. The map will be ratioed against the last background you collected. 
 

 Important Background points remain defined in the map even after you have collected 
the background, so if the background point is on another sample, use Clear 
Map Sequence in the Edit menu before defining your new map. S 
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If your sample has a suitable background area, you can collect a 
background on the sample and use it to ratio the map sample spectra. 
 
For information on specifying background points and collecting 
backgrounds, see “The tool palette” and “Background handling” in the 
“Preparing for Data Collection” chapter and “Collecting a background” in 
the “Collecting Data” chapter. 
 
 

Using an aperture You can use a rectangular aperture to define the sampling area for each 
point of a map (unless you are using a visible Raman microscope, or a 
Continuµm XL to perform an imaging experiment with the linear array). 
Rectangular apertures are variable; you can adjust the four sides to define 
the X and Y limits of any size area within the limits of the aperture 
(typically a range of 5 to 150 micrometers). You can also rotate the aperture 
to the desired angle up to 45 degrees in either direction. The same aperture 
size and orientation should be used for the background and the sample 
spectra in a map. 
 
The aperture size should be large enough to provide enough signal through 
the microscope, but small enough to isolate the smallest area of interest in 
the mapping region. Sometimes a compromise between the two must be 
used. 
 

 Note If you have a Continuµm microscope with the automated Reflex™ aperture, 
you can use different aperture settings for the points in a discrete-point 
collection. The aperture is adjusted automatically at each point during the 
collection. See “Specifying discrete sample points” in the “Preparing for 
Data Collection” chapter for more information. S 

 
 Note A second, complementary way to define the smallest area of interest is by 

setting the step size (the distance between sample points). For example, you 
can distinguish changes in the mapped area to within 1 micrometer by using 
1-micrometer steps, even though the aperture size may be 20 by 10 
micrometers. S 

 
See “Drawing an aperture,” “Setting the automated Reflex aperture” 
and “Aperture parameters” in the “Preparing for Data Collection” chapter 
for more information on specifying apertures. 
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 Note If you have a Continuµm XL microscope, use Scope Aperture on the Bench 
tab of the Experiment Setup dialog to specify aperturing. See “Setting the 
beam path for the Continuµm XL” in the “Preparing for Data Collection” 
chapter for details. You may wish to use a pre-aperture with this microscope; 
it works best for diffusely scattering samples. See your microscope 
documentation for more information. S 

 
 

Performing an 
FT-IR or FT-Raman 

mapping experiment 

An FT-IR or FT-Raman mapping experiment typically consists of some or 
all of the following main steps. See “Collecting ATR data with autofocus” 
in the “Collecting Data” chapter for procedures for collecting ATR data. 
See “Performing a visible Raman mapping experiment” if you have a 
Nicolet Almega system. 
 
1. Position the sample on the stage and focus. 

2. Specify the map sequence. 

3. Set the data collection parameters. 

4. Set the profile and display options. (This step is optional.) 

5. Collect the map. 
  
These steps are described later in this section. We refer you to the 
appropriate sections of this manual for complete information on using the 
needed software features. 
 
 

Before you start If you have not calibrated the video image for the microscope objective you 
will be using, calibrate it now. See “Calibrating the video image” in the 
“Configuring the System” chapter or “Selecting a calibration” in the 
“Preparing for Data Collection” chapter for more information. 
 
If the Atlµs window is not displayed, choose Show Atlµs Window from the 
Atlµs menu before starting the following procedure. 
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In the general steps that follow we assume that a background can be 
collected using the sample. If this is not the case for your experiment, you 
can collect a background using an appropriate material before collecting the 
map. See “Using the tool palette” in the “Preparing for Data Collection” 
chapter for details on using the palette tools to specify a background point 
and “Collecting a map background” in the same chapter for information on 
collecting a background. Use Clear Map Sequence in the Edit menu to clear 
the background point before specifying the map sequence. Otherwise, a 
previously defined background point, if one exists, will be used. 
 
 

Step 1:  
Position the sample 

on the stage and focus 

Position the sample on the microscope stage so that it is perfectly level. If 
the sample cannot be made level over the entire mapping region, you will 
need to refocus the stage before each spectrum is collected during the 
experiment. 
 
You can use Auto-Pause Before Each Spectrum (available through the 
Collect button on the Mapping tab of the Experiment Setup dialog box) to 
set the software to pause so that you can adjust the focus. See “Setting 
special mapping options” in the “Preparing for Data Collection” chapter 
for details. 
 
If you have the optional autofocus feature, you can use Autofocus At Each 
Map Point (All Map Types) (available through the Focus button on the 
Mapping tab of the Experiment Setup dialog box) to specify that the 
microscope be focused automatically before collecting each sample 
spectrum. See “Setting the focus parameters” in the “Preparing for Data 
Collection” chapter for details. 
 
 

Step 2:  Specify 
the map sequence 

Use the Atlµs window palette tools and the Mapping tab of the Experiment 
Setup dialog box to specify the map sequence. The map sequence defines 
the mapping region for the sample and includes information about the 
sample points, the background point, any aperture that is used and various 
option settings. See “Specifying a map sequence” and “Setting the data 
collection parameters for FT-IR and FT-Raman experiments” in the 
“Preparing for Data Collection” chapter for complete information. 
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You can also open a stored sequence if you previously created and saved 
one. To do this, open the experiment that contains the sequence by using 
the Experiment drop-down list box in the OMNIC window or the Open 
button in the Experiment Setup dialog box. (You can also open a sequence 
file using Open in the File menu.) If you open a sequence, skip to the next 
step unless you want to make changes to the sequence before collecting the 
map. See “Opening a map sequence” in the “Preparing for Data 
Collection” chapter for more information. 
 
If you are performing an imaging experiment using the linear array detector 
of a Continuµm XL microscope, you can collect only an area map (not a 
line map or discrete point map) with the detector. 
 
 

Step 3:  Set the data 
collection parameters 

Use Experiment Setup in the Collect menu to set the data collection 
parameters for data collection. 
 
If you are using an infrared microscope, set Sample Compartment to Right 
µScope %T, Right µScope %R, Left µScope %T or Left µScope %R, 
depending on whether the microscope is installed to the left or right of the 
optical bench and whether you are performing a transmission or reflection 
experiment. Your setting positions the mirrors in the microscope and 
spectrometer for data collection. 
 
If you are using an FT-Raman View Stage, the setting of Sample 
Compartment depends on the hardware you have. If you have the  
FT-Raman 960 spectrometer or the Magna-IR™ FT-Raman module, use 
the Main setting. If you have another model FT-Raman module, use the 
Raman setting. 
 
Use the Collect tab in the Experiment Setup dialog box to set Final Format 
to the format that is appropriate for the kind of data you will be collecting. 
Set the other Collect parameters as appropriate for your experiment. See 
“Setting up data collection” in the “Preparing for Data Collection” chapter 
for details. 
 
If you are performing an imaging experiment using the linear array detector 
of a Continuµm XL microscope, set Detector on the Bench tab to XL 
Array. This automatically sets Scope Aperture to Imaging. 
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Step 4:  Set the profile and 
display options (optional) 

If you are collecting a line map or area map, you can use the Mapping tab 
of the Experiment Setup dialog box to specify the type of profile to use for 
the map and the needed profile information. The default profile type 
setting is Chemigram™. See “Setting the profile parameters” in the 
“Preparing for Data Collection” chapter for more information. 
 
You can specify how to display the collected line map or area map by using 
Options in the Edit menu. See “Setting the display options” in the 
“Preparing for Data Collection” chapter for more information. 
 

 Note This step is entirely optional. After you collect the map, you will be able to 
use Profile Setup in the Atlµs menu and Display Setup in the View menu to 
create profiles and change the display parameters. See “Creating a profile” in 
the “Processing and Analyzing Map Data” chapter and “Setting the display 
parameters” in the “Displaying Map Data” chapter for details. S 
 
 

Step 5:  Collect the map To collect the map, choose Collect Map from the Collect menu and follow 
any instructions that appear on the screen. The collected map appears in a 
map window and you can begin working with it. 
 
See “Collecting an FT-IR or FT-Raman map” in the “Collecting Data” 
chapter for more information on collecting a map. See the “Displaying 
Map Data” chapter for complete information on manipulating data within 
a map window. See the “Processing and Analyzing Map Data” for 
instructions for processing the data. 
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Performing 
a visible Raman 

mapping experiment 

A visible Raman mapping experiment typically consists of some or all of the 
following main steps. See “Performing an FT-IR or FT-Raman mapping 
experiment” if you have an FT-IR or FT-Raman system. 
 
1. Position the sample on the stage and focus. 

2. Specify the map sequence. 

3. Set the data collection parameters. 

4. Set the profile and display options. (This step is optional.) 

5. Collect the map. 
  
These steps are described later in this section. We refer you to the 
appropriate sections of this manual for complete information on using the 
needed software features. 
 
 

Before you start If you have not calibrated the video image for the microscope objective you 
will be using, calibrate it now. See “Calibrating the video image” in the 
“Configuring the System” chapter or “Selecting a calibration” in the 
“Preparing for Data Collection” chapter for more information. 
 
If the Atlµs window is not displayed, choose Show Atlµs Window from the 
Atlµs menu before starting the following procedure. 
 
 

Step 1:  
Position the sample 

on the stage and focus 

Position the sample on the microscope stage so that it is perfectly level. If 
the sample cannot be made level over the entire mapping region, you will 
need to refocus the stage before each spectrum is collected during the 
experiment. 
 
You can use Auto-Pause Before Each Spectrum (available through the 
Collect button on the Mapping tab of the Experiment Setup dialog box) to 
set the software to pause so that you can adjust the focus. See “Setting 
special mapping options” in the “Preparing for Data Collection” chapter 
for details. 
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If you have the optional autofocus feature, you can use Autofocus At Each 
Map Point (All Map Types) (available through the Focus button on the 
Mapping tab of the Experiment Setup dialog box) to specify that the 
microscope be focused automatically before collecting each sample 
spectrum. See “Setting the focus parameters” in the “Preparing for Data 
Collection” chapter for details. 
 
 

Step 2:  Specify 
the map sequence 

Use the Atlµs window palette tools and the Mapping tab of the Experiment 
Setup dialog box to specify the map sequence. The map sequence defines 
the mapping region for the sample and includes information about the 
sample points and various option settings. See “Specifying a map sequence” 
and “Setting the data collection parameters for visible Raman experiments” 
in the “Preparing for Data Collection” chapter for complete information. 
 
You can also open a stored sequence if you previously created and saved 
one. To do this, open the experiment that contains the sequence by using 
the Experiment drop-down list box in the OMNIC window or the Open 
button in the Experiment Setup dialog box. (You can also open a sequence 
file using Open in the File menu.) If you open a sequence, skip to the next 
step unless you want to make changes to the sequence before collecting the 
map. See “Opening a map sequence” in the “Preparing for Data 
Collection” chapter for more information. 
 
 

Step 3:  Set the data 
collection parameters 

Use Experiment Setup in the Collect menu to set the data collection 
parameters for data collection. 
 
Use the Collect tab in the Experiment Setup dialog box to set Final Format 
to the format that is appropriate for the kind of data you will be collecting. 
Set the other Collect parameters as appropriate for your experiment. See 
“Setting up data collection” in the “Preparing for Data Collection” chapter 
for details. 
 
 

Step 4:  Set the profile and 
display options (optional) 

If you are collecting an area map or area depth profile, you can use the 
Mapping tab of the Experiment Setup dialog box to specify the needed 
profile information. The default profile type setting is Chemigram™. See 
“Setting the profile parameters” in the “Preparing for Data Collection” 
chapter for more information. 
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You can specify how to display the collected line map, area map or depth 
profile by using Options in the Edit menu. See “Setting the display 
options” in the “Preparing for Data Collection” chapter for more 
information. 
 

 Note This step is entirely optional. After you collect the map, you will be able to 
use Profile Setup in the Atlµs menu and Display Setup in the View menu to 
create profiles and change the display parameters. See “Creating a profile” in 
the “Processing and Analyzing Map Data” chapter and “Setting the display 
parameters” in the “Displaying Map Data” chapter for details. S 

 
 

Step 5:  Collect the map To collect the map, choose Collect Map from the Collect menu and follow 
any instructions that appear on the screen. The collected map appears in a 
map window and you can begin working with it. 
 
See “Collecting a visible Raman map” in the “Collecting Data” chapter for 
more information on collecting a map. See the “Displaying Map Data” 
chapter for complete information on manipulating data within a map 
window. See the “Processing and Analyzing Map Data” for instructions for 
processing the data. 
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 Configuring the System 
 
 
Before you collect map data for the first time, use System Configuration in 
the Atlµs menu to perform the following tasks: 
 
• Specify how the video driver will display the video image. 
• Calibrate the video image. 
• Align the video cross hairs. 
• Specify the type of camera hardware you are using. 
• Specify the type of video input you are using. 
• Specify your microscope configuration. 
• Initialize the stage. 
• Initialize the automated Reflex aperture, if present. 
• Limit the stage travel. 
• Configure the microscope. 
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Follow the general steps below to use the System Configuration command. 
The next sections provide detailed instructions for performing the 
operations listed above. 
 
1. Choose System Configuration from the Atlµs menu. 
 
 The System Configuration dialog box appears. Here is an example: 
 

  
 
 
2. Use the provided features as desired. 
 
 If you change any parameter settings in this dialog box, you can click 

the Apply button to see the effects of your changes without closing the 
dialog box. 

 
 See the next sections for detailed instructions for using the provided 

features. 
 
 
3. Choose OK. 
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Configuring the video Use the features in the Video box in the System Configuration dialog box 
to do the following: 
 
• Specify how the video driver will display the video image. 
• Calibrate the video image. 
• Align the video cross hairs. 
• Specify the camera hardware you are using (except on Nicolet Almega 

systems). 
• Specify the type of video input you are using. 
• Specify the type of video connector you are using. 
 
The next sections explain how to perform these tasks. 
 
 

Setting the video 
source parameters 

 

Use the Video Source button to specify how you want the video driver to 
display the video image. Follow these steps: 
 
1. Click the Video Source button in the System Configuration dialog 

box. 
 
 The Video Source dialog box appears. Here is an example: 
 

  
 
 The features in this dialog box may vary depending on your frame 

grabber. See the documentation that came with the frame grabber for a 
description of the provided parameters. 
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 Note You can also use many of the tools, such as the arrow tool, in the Atlµs 
window to display this dialog box. Simply click anywhere in the navigation 
pane or video pane, and then choose Video Source from the pop-up menu. S 

 
 
2. Set the parameters as desired. 
 
 To set a parameter, type a value in the text box or drag the indicator 

along the bar to the right of the text box. You can see the effects of your 
settings in the video image. 

 
 To return all the parameters to their default settings, choose Set 

Default. 
 
 
3. Choose OK. 
 
 

Video calibration 

 

Use the Video Calibration button to select a saved calibration to use for the 
video pane or to create a new calibration. You can also delete a saved 
calibration. 
 
Whenever the size of the video field of view changes (because you have 
changed the microscope objective), you need to select an appropriate 
calibration, or calibrate the video image, to coordinate what is displayed in 
the video pane with the actual field of view. That is, the number of 
micrometers displayed in the video pane must match the number of 
micrometers in the field of view. The calibration is very important. If the 
video image is not calibrated, any maps you define are invalid because the 
software is unable to map the correct region of interest. 
 
See “What is calibration?” in the “Overview” chapter for more discussion of 
video image calibration. 
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When you choose Video Calibration, the Select Calibration dialog box 
appears showing the currently selected calibration and information about it: 

 

 
 
The next sections explain how to create a new calibration and work with 
existing calibrations. 
 

 Note If you have a Nicolet Almega system, several default calibrations are 
provided and installed during calibration. You can delete those that do not 
apply to your system. See “Opening a saved calibration” for instructions for 
opening a calibration. See “Deleting a saved calibration” for instructions for 
deleting a calibration. S 

 
 

Calibrating the video image 

 

Follow these steps to calibrate the video image: 
 
1. Place a micrometer slide on the stage, and focus on the scale near 

the center of the slide. 
 
 You can use the provided pinhole if you don’t have a micrometer slide. 

Focus on the edge of the pinhole. 
 
 Use transmission illumination for this step. 
 
 If you prefer, you can place the micrometer slide (or pinhole) on the 

stage and focus after step 2. 
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2. Click the Create New button in the Select Calibration dialog box. 
 
 The Create Calibration window appears, displaying a video image and 

features for calibrating it. Here is an example showing the image from 
an analog camera: 

 

  
 

Create Calibration window for analog camera 
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 Here is an example showing the image from a digital camera: 
 

  
 

Create Calibration window for digital camera 
 
 Notice that the digital camera image contains a lighter rectangular area 

in the center. Only this area will appear in the video pane of the Atlµs 
window and be used for capturing video images. By adjusting the size, 
shape and location of the area, you can eliminate distortions and 
uneven illumination that can occur around the perimeter of a video 
image. To adjust the size and shape of the area, drag its red border. To 
move the area, drag its center to the desired location. 

 
 To make it easier to see details in the analog or digital video image, you 

can enlarge the window by dragging its sides or corners. 
 
 
3. Drag the markers labeled “1” and “2” to division lines on the scale. 
 

 Important If you are using a digital camera, the markers must be within the lighter 
rectangular area. S 
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 If you are using the pinhole, drag the markers to opposite sides of the 
hole so that the distance between them is the diameter of the hole. 

 
 For best accuracy use division lines that are far apart. 
 
 You can use the buttons in the Refine Marker Position box to more 

finely adjust the position of the currently active (red) marker. 
 
 The illustration below shows the distances between major division 

lines. The distance between the minor division lines is 10 micrometers. 
 

  
 
 Here is an example showing the markers placed on major division lines 

that are 450 micrometers apart: 
 

  
 
 
4. Type the distance between the markers in micrometers in the 

Distance Between Points (µm) text box. 
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5. Select the magnification of the objective you are using from the 
Objective Magnification drop-down list box. 

 
 If you have an FT-Raman View Stage, select Fixed Objective. 
 
 
6. Type a brief description of the calibration in the Brief Description 

text box. 
 
 This description will be listed in the Brief Description drop-down list 

box in the Select Calibration dialog box after you save the calibration. 
 
 
7. Type a more detailed description of the calibration in the Full 

Description text box. 
 
 The full description is a good way to record what the calibration was 

created for. It’s helpful to include a description of the objective that was 
used for the calibration. 

 
 After you save the calibration, the full description will appear in the 

Select Calibration dialog box when you select the calibration from the 
Brief Description drop-down list box. 
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 Here is an example showing all of the information entered in the text 
boxes: 

 

  
 
 
8. Click the Save button. 
 
 
9. Click the Close button. 
 
 The saved calibration is now available for use. For more information see 

“Opening a saved calibration” in this chapter or “Selecting a 
calibration” in the “Preparing for Data Collection” chapter. 

 
 You can edit the saved calibration by using the Edit button in the Select 

Calibration dialog box. See “Editing a calibration” for details. 
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  Calibrating the video image 
 

 To verify that the video image has been calibrated correctly, first select 
the calibration from the Brief Description drop-down list box in the 
Select Calibration dialog box, choose Set Current, choose Close to close 
the dialog box, and choose OK to close the System Configuration 
dialog box. Then use the stage movement tool to click a location in the 
video image in the Atlµs window. If that location moves to the center 
of the video pane, the video image has been calibrated correctly. 

 
 You can also use the ruler tool and stage micrometer to verify the 

calibration:  Use the ruler tool to measure the distance between two 
sample features. Position one of the features at the cross hairs and then 
use the stage micrometer to measure the distance traveled when you 
move the other feature to the cross hairs. The two measurements 
should be the same. 

 
 

Opening a saved calibration 

 

Follow these steps to open a saved calibration: 
 
1. Select the calibration to open from the Brief Description drop-

down list box in the Select Calibration dialog box. 
 
 Information about the selected calibration appears below the drop-

down list box. This information was entered when the calibration was 
created (see “Calibrating the video image”). 

 
 
2. Click the Set Current button. 
 
 The calibration will be in effect when you next use the Atlµs window. 
 

 Note You can also use the Show Calibration Bar button in the Atlµs window to 
select a saved calibration. See “Selecting a calibration” in the “Preparing for 
Data Collection” chapter for details. S 

 
 

Editing a saved calibration 

 

Follow these steps to edit a saved calibration: 
 
1. Select the calibration to edit from the Brief Description drop-down 

list box in the Select Calibration dialog box. 
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2. Click the Edit button. 

The Create Calibration window appears. 

. Adjust the calibration as desired. 

 
 and 

 video 
image” for information about using the provided features. 

. Click the Save button. 

. Click the Close button. 

Copying a saved calibration 

 
 
 
 
3
 

You can move the markers and change the information in the dialog 
box. If you are using a digital camera, you can adjust the size, shape
location of the lighter rectangular area. See “Calibrating the

 
 
4
 
 
5
 
 

 

If you want to create a calibration that is very similar to a saved calibratio
you can copy the saved calibration and th

n, 
en make any needed changes. 

ollow these steps to copy a calibration: 

1. tion drop-
down list box in the Select Calibration dialog box. 

. Click the Copy button. 

 rop-down list box, 
with the word “Copy” appended to the description. 

Deleting a saved calibration 

F
 

Select the calibration to copy from the Brief Descrip

 
 
2
 

A new calibration is added in the Brief Description d

 
 

 

Follow these steps to delete a saved calibration: 

1. escription 
drop-down list box in the Select Calibration dialog box. 

 
 when the calibration was 

created (see “Calibrating the video image”). 

 
Select the calibration you want to delete from the Brief D

 
Information about the selected calibration appears below the drop-
down list box. This information was entered
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2. Click the Delete button. 
 
 A confirmation message appears. 
 
 

Choose Yes. 3. 
 
 

ATR calibration Use the ATR Calibration button to select a saved calibration to use for 
TR images or to create a new ATR calibration. You can also delete a saved 
TR calibration. 

n ATR calibration compensates for any difference between the apparent 

loca
 

hen you choose ATR Calibration, the Select ATR Calibration dialog box 
pears showing the currently selected calibration and information about it: 

A
 A

 
A
location of a point in an ATR image displayed in the video pane and the 

tion of the point as seen through the microscope eyepieces. 

W
ap

 

 
 
The next sections explain how to create a new ATR calibration and work 
with existing ATR calibrations. 
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Performing an ATR calibration Follow these steps to perform an ATR calibration: 
 

 1 Prepare the system for ATR operation. . 

model. An ATR objective should be installed, and the software should 

 in the “Preparing for Data Collection” chapter). 

2.  glass slide. 

An easy way to do this is to light a match or candle, hold the slide at 

 

3. ge with the soot-coated side facing up. 

4. With the ATR crystal out of the beam path, focus on the soot. 
 
 

 
 The required preparations may vary depending on your microscope 

be set for ATR data collection. For example, select Auto ATR Contact 
in the Focus dialog box if it is available (see “Setting the focus 
parameters”

 
 

Apply a thin coating of carbon soot to a
 
 

one end, and briefly allow the flame to touch one side of the slide near 
the center.

 
 

Place the slide on the sta
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5. Click the Create New button in the Select Calibration dialog box. 
 

The ATR Calibration window appears:  
 

  
 

 Note e  a 
igh
info

o make it easier to see details in the video image, you can enlarge the 
window by dragging its sides or corners. 

 
 
6. With the ATR crystal in the beam path, carefully make contact with 

the soot. 
 
 If you have the internal Contact Alert System, use the ATR Contact 

button to make contact. 
 
 

D pending on whether you have a digital camera, the image may contain
l ter rectangular area. See “Calibrating the video image” for more 

rmation. S 

 
 T
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7. Raise the objective and then, with the ATR crystal out of the beam 
path, refocus on the soot. 

hat the 
 centered on the field of view, indicating that calibration is 

needed: 

 
 In the video image you will see a round, lightened area where the 

crystal made contact with the soot. Here is an example showing t
crystal is not

 

  
 
 
8. ter of the round area. 
 
 You can use the buttons in the Refine Marker Position box to more 

 

 

Drag the marker labeled “1” to the cen

finely adjust the position of the marker. Here is our example with the 
marker centered in the round area: 
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9. 
text

 
 his description will be listed in the Brief Description drop-down list 

10. Type a more detailed description of the calibration in the Full 

 
 as 

as 
used for the calibration. 

 
 

he calibration from 
the Brief Description drop-down list box. 

 
 
11. Click the Save button. 
 
  calibration is now available for use. For more information 

see “Opening a saved ATR calibration.” 
 
 
12. If you want to use the new calibration immediately, select it from 

et 

he System Configuration dialog box by clicking the OK 
button. 

 
 

 
a. With the ATR crystal out of the beam path, move the stage so that 

fills the field of view and focus on the soot. 
 

eam path, carefully make contact 
with the soot. 

 

Type a brief description of the calibration in the Brief Description 
 box. 

T
box in the Select ATR Calibration dialog box after you save the 
calibration. 

 
 

Description text box. 

The full description is a good way to record what the calibration w
created for. It’s helpful to include a description of the objective that w

After you save the calibration, the full description will appear in the 
Select ATR Calibration dialog box when you select t

The saved

the Brief Description drop-down list box and then click the S
Current button. When you are finished, click the Close button. 
Then close t

With the new calibration in effect, you can verify that it is working 
properly in the Atlµs window: 

an unused area of soot 

b. With the ATR crystal in the b
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c. Raise the objective and then, with the ATR crystal out of the beam
path, refocus on the soot. The round, lightened area should be 
centered on the cross hairs in the video pane. 

 
Before using the crystal for data collec

 

 Note tion, be sure to clean it by following 
e cleaning practices explained in the documentation that came with the 

Opening a saved ATR calibration 

 
th
objective or microscope. S 

 
 
Follow these steps to open a saved ATR calibration: 

 
 

. Select the ATR calibration to open from the Brief Description 

 
 e 

drop-down list box. This information was entered when the calibration 
was created (see “Performing an ATR calibration”). 

.  button. 

window. 

Deleting a saved ATR calibration 

1
drop-down list box in the Select ATR Configuration dialog box. 

Information about the selected ATR calibration appears below th

 
 
2 Click the Set Current
 
 The ATR calibration will be in effect when you next use the Atlµs 

 
 
Follow these steps to delete a saved ATR calibration: 

. 
onfiguration 

dialog box. 

libration appears below the 
drop-down list box. This information was entered when the calibration 
was created (see “Performing an ATR calibration”). 

 
 
2. Click the Delete button. 
 
 A confirmation message appears. 
 
 
3. Choose Yes. 

 
 1 Select the ATR calibration you want to delete from the Brief 

Description drop-down list box in the Select ATR C

 
 Information about the selected ATR ca
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Aligning the 
ideo cross hairs 

It is possible for the video image cross hairs to become no longer aligned 
with the center of the microscope field of view (as defined by the eyepiece 
cross hairs). If this happens, you may notice that the position of a sample 
feature displayed in the video image does not e

v

 
xactly match its position as 

en through the microscope viewer. 

o cross 

epiece cross hairs. 
 

If the video cross hairs need alignment, the sample feature will not be 

A dialog box appears: 
 

 

se
 
Follow these to use the Align Cross Hairs button to realign the vide
hairs: 
 
1. Place a sample on the stage and position a small sample feature at 

the center of the ey

 
centered on the cross hairs in the video pane of the Atlµs window. If 
the feature is centered, you do not need to align the cross hairs. 

 
 

. Click the Align Cross Hairs button. 2
 
 

 
 
 
3. Click the arrow buttons as needed to position the sample feature at 

the center of the video image cross hairs. 
 
 The arrows indicate the direction of movement. The X and Y values 

show how far the sample has moved, in micrometers. 
 
 
4. When you are finished, choose OK. 
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Specifying the 
video input type 

Right after your system has been installed, select the type of frame grabber 
or digital camera you are 

 

using from the Input Type drop-down list box in 

 r ction. 

Specifying the 
video connector type 
or camera resolution

the System Configuration dialog box. If you select a digital camera, specify 
its esolution as explained in the next se
 
 
Ri ht after your system has

 

 

 

g  been installed, use Connector Type or 
s uration dialog box to select the type of 

g of Input Type (see 

 , 

r 
urpose. S 

Re olution in the System Config
video connector you are using or the camera resolution. The available 
parameter and its allowed settings depend on the settin
the preceding section). 

 
If you are using a digital camera and notice slow operation of the software
try using a lower Resolution setting. If you later need to capture high-
resolution images, you can temporarily use a higher Resolution setting fo
that p

Note 

 
 

Thermo Fisher Scientific OMNIC Atlµs User’s Guide 43 



Configuring the System 

Micro
configuration 

 dialog 

ge travel. 

 
hese tasks. 

 

Selecting a 
microscope configuration 

scope Use the features in the Microscope box in the System Configuration
box to do the following: 

• Select a microscope configuration. 
• Initialize the stage. 
• Initialize the automated Reflex aperture, if present. 
• Limit the sta
• Configure the microscope.  

The next sections explain how to perform t

 
If your system has more than one microscope mapping product—for 
example, a Continuµm microscope and an FT-Raman View Stage—you 
need to specify the one to use for your next data collection. Simply select 
the appropriate option from the Current Configuration drop-down list 
box. 

 

 
If you have a Nicolet Almega system, specify the microscope configuration 
by selecting Almega. 
 
 
The following sections explain how to initialize the stage on FT-IR, FT-
Raman and visible Raman systems. 
 

Initializing the stage

Initializing the stage on an 
FT-IR or FT-Raman system 

 

 
Use the X-Y Stage and Z-Axis buttons in the System Configuration
box to initialize the microscope stage w

 dialog 
ithin the horizontal plane (in the X 

and Y dimensions) and vertically (along the Z-axis), respectively. 

inuµm microscope, perform a Z-axis initialization every 

 
Perform an X-Y initialization once right after the system is installed and 
any time you have moved the stage by hand when the stage power is off. 
You can also perform an X-Y initialization whenever you want to reset the 
origin (0,0) to the physical center of travel. 
 
If you have a Cont

 

 

time you turn on the microscope power. 
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 Important , 
ized 

 grinding sound 
uring initialization, turn off the controller, wait for the software to display 
n error message, turn on the stage power, center the stage and then restart 

 Note 
equire initialization, or the  

-axis has already been initialized an does not need to be reinitialized. If 
µm microscope and need to initialize the Z-axis but the 

utton is not available, turn the microscope power off and then on and 

 
 

Initializing the stage on 
a visible Raman system 

Before initializing the stage, make sure it will not hit the objective
condenser, microscope body or anything else. If you have the XL motor
stage, make sure it is somewhere near the physical center of travel rather 
than close to its limit of travel. If the XL stage produces a
d
a
initialization. S 

 
To perform an initialization, click the appropriate button and then follow 
the instructions that appear on the screen. 
 
The Z-axis button is not available if the microscope does not have a 
motorized Z-axis, the Z-axis does not r
Z
you have a Continu
b
restart OMNIC Atlµs to make the button available. S 

U

 

se the X-Y Stage button in the System Configuration dialog box to 
it  

imensions). Perform an initialization once right after the system is 

power is off. You can also perform an initialization whenever you want to 
set the origin (0,0) to the physical center of travel. 

To perform an initialization, click the button and then follow the 
instructions that appear on the screen. 

 
 

Initializing 
the automated 

Reflex aperture 

in ialize the microscope stage within the horizontal plane (in the X and Y
d
installed and any time you have moved the stage by hand when the stage 

re
 

 

If your microscope has an automated Reflex aperture, you should adjust its 
size and shape by using any of these software features:  the box that 
represents the Reflex aperture in the video pane of the Atlµs window, Set 
Aperture To Default in the Atlµs menu, Aperture Dimensions in the Atlµs 
menu, and the Aperture button on the Mapping tab of the Experiment 
Setup dialog box. 
 
You should not also use a knob on the Continuµm microscope to adjust the 
aperture, because doing so can cause aperture misalignment. If this 
happens, click the Aperture button to initialize the aperture, returning it to 
correct alignment. 
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For information about adjusting the aperture, see “Adjusting the 
automated Reflex aperture graphically,” “Setting the automated Reflex 

erture numerically” and “Setting the automated Reflex aperture to the 
efa hapter. 

Limiting the stage travel 

ap
d ult” in the “Preparing for Data Collection” c
 
 
Use the Limit Stage Travel button to limit the distance in the X and Y 

mall 
and you want to avoid accidentally setting up a map outside the area of the 

mple. By limiting the stage travel, you also define the limits of the 
avigation pane of the Atlµs window:  If you zoom the pane all the way 

l 
ran
 
Follow these steps: 

. If you want to specify the travel limits by typing distance values, 
om which you want to specify the 

maximum distances. 

 
 
 y moving the stage, you can start the 

procedure with the stage in any location. 

directions that the stage may travel. This is useful when the sample is s

 sa
n
out, the zoom will go only as far as the defined limit. Restricting the trave

ge is also useful for ATR mapping. 

 
1

move the stage to the location fr

 
The travel distance limits you specify will be relative to this location. 

If you want to specify the limits b
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2. Click the Limit Stage Travel button in the System Configuration 
dialog box. 

 
 The Limit Stage Travel dialog box appears: 
 

  
 
 The current travel limits, if defined, appear in the Current Travel 

specify the limits by typing values, select Type Values and go to 
step 5. 

rners of the 

l Limits box. Go to step 8. 

. Type the desired maximum X travel distance, in micrometers, in the 
first text box. 

 
 The stage will not be able to move farther than this distance from the 

current stage location in either direction along the X-axis. 

Limits box. 
 
 
3. If you want to specify the travel limits by moving the stage to the 

limits, select Use Wizard and go to the next step. If you want to 

 
 
4. Click the Start Wizard button. 
 
 The wizard guides you through specifying opposite co

desired range of stage travel. Follow the instructions that appear on the 
screen. When you are finished, the new limits appear in the Current 
Trave

 
 
5
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6. Type the desired maximum Y travel distance, in micrometers
second text box. 

, in the 

current stage location in either direction along the Y-axis. 
 
 
7. Click the Update Limits button. 
 
 The new limits appear in the Current Travel Limits box. 
 

. If you want to use the specified limits immediately, select Use Stage 
Travel Limits. 

If Use Stage Travel Limits is not selected, your settings will be saved, 

 later to put the settings into effect. This lets you easily 
limit the stage travel just when you want to. 

ffect, this icon appears near the 
upper-left corner of the Atlµs window: 

 
 The stage will not be able to move farther than this distance from the 

 
8

 
 

but not immediately used, when you choose OK. You will be able to 
select this option

 
 
9. Choose OK. 
 

When your stage travel limits are in e 

 

  
 
 

Configuring
the microscope 

 Right after your system has been installed, follow the general steps below to 
nfigure the microscope hardware with the Configuration button. The 

ext sections explain the individual parameters in detail. 

g 

 

co
n

 
 
1. Click the Configuration button in the System Configuration dialo

box. 
 
 A message appears: 
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2. Choose Yes if you are qualified to configure the microscope 
hardware. Choose No if you are not. 

 
 If you choose Yes, the Microscope Configuration dialog box app
 

ears: 

 
 
 
 
 
 

A COM2 setting designates a USB port. 

 
 
 
3. Set the parameters as desired. 
 
 
4. Choose Save. 
 
 
5. Choose Close. 
 
 The saved settings will be in effect when you close the dialog box and 

when you later start OMNIC Atlµs. 
 
 

Specifying the 
microscope model 

Specify your microscope model by selecting the appropriate setting from 
the first drop-down list box in the Microscope box. If the drop-down list 
box to the right is available, use it to select the COM port you are using for 
the microscope. 

 
 
 

Specifying the stage model 

 

Specify your stage model by selecting the appropriate setting from the first 
drop-down list box in the X-Y stage box. Then select the COM port you 
are using for the stage from the drop-down list box to the right. 
 

Thermo Fisher Scientific OMNIC Atlµs User’s Guide 49 



Configuring the System 

If you select XL Motorized Stage or Prior ProScan Motorized Stage, the 
Stage Calibration button becomes available. See “Calibrating the stage” for
more information. 

 

Specifying the motorized Z-axis 
 
Specify the type of motorized Z-axis you are using by selecting the 

 

appropriate setting from the first drop-down list box in the Motorized Z-
xis box. Then select the COM port you are using for the hardware from 
e ilable. 

 Note inc the motorized Z-axis is an integral component of automated 
ontinuµm microscopes, the Motorized Z-Axis parameters are not used for 
ose microscopes. 

Setting the Auto Apertures, 
Autofocus and Auto ATR options 

A
th drop-down list box to the right, if it is ava
 
S e 
C
th S 

 
 
Select the appropriate options in the Other Options box to specify whether 

 have various hardware options: 

u have an automated Reflex aperture

you
 

 yo , select Auto Apertures to display 
e box representing the aperture in the video pane of the Atlµs window. 

d g for 
at

focus hardware, select Autofocus to display the 
utofocus button in the Atlµs window. On some systems this automatically 
lects the appropriate autofocus option—Digital or Analog—and you 

cannot change the setting. On other systems you must select an option:  If 
your microscope has a digital camera and the necessary electronics, select 
Digital. If you have an analog camera and the necessary electronics, select 
Digital only if you want to use the digital autofocus feature; otherwise, 
select Analog. The Digital option enables the digital autofocus feature, 
which requires calibration before first use; see “Autofocus calibration” in 
the “Preparing for data collection” chapter for instructions. (When you use 
the Autofocus button the first time, a message informs you if calibration is 
required.) See “Using the focus buttons” in the “Preparing for Data 
Collection” chapter for more information about using the Autofocus 
button. 
 
If you have the hardware needed for automated ATR contact, select Auto 
ATR to display the ATR contact button in the Atlµs window. See “Using 
the focus buttons” in the “Preparing for Data Collection” chapter for more 
information. 

 

If
th
The aperture tool is not available when this option is selected. See 
“A justing the automated Reflex aperture graphically” in the “Preparin

a Collection” chapter for instructions for adjusting the aperture. D
 
If you have the auto
A
se
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Calibrating the Reflex aperture 

 

Right after your system has been installed, use the Reflex Aperture button
once to calibrate the motion of the automated Reflex aperture, if presen
Follow these steps: 
 
1. Click the Refle

 
t. 

x Aperture button in the Microscope Configuration 
dialog box. 

The Reflex Aperture dialog box appears: 

 

 
 
 

 
 
 
2. Type the appropriate values in the text boxes. 
 
 You can find the values on a label on the inside surface of the panel just 

below the microscope viewer. Use a screwdriver to remove the two 
screws that fasten the panel to the microscope. Replace the panel when 
you are finished entering the values. 

 
 
3. Specify the objective you are using by selecting the appropriate 

option near the bottom of the dialog box. 
 
 
4. Choose OK. 
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Calibrating the stage 

 

If you set X-Y Stage to XL Motorized Stage or Prior ProScan Motorized 
Stage, the Stage Calibration button becomes available. It lets you enter 
values to compensate for skewed stage movement that may result from 

echanical tolerances. Do this once right after your system is installed. 

. 

 

m
Follow these steps: 
 
1 Click the Stage Calibration button. 
 
 The Stage Calibration Parameters dialog box appears: 
 

 
 
 

Type the appropria2. te values in the text boxes. 

You can find the values on a label on the bottom of the stage. 

. Choose OK. 

 
 
 
 
3
 
 

52 OMNIC Atlµs User’s Guide Thermo Fisher Scientific 



Configuring the System 

Configuring the joystick If you set Microscope to a Raman product that uses a joystick, 
Configuration button becomes available. It lets you assign the a

the Joystick 
ctions that 

e joystick buttons perform. Follow these steps: 

The Joystick Configuration dialog box appears: 

 

 th
 
1. Click the Joystick Configuration button. 
 
 
 

 
 
 
2. Select an action to assign. 
 
 For example, if you want a button on the joystick device to move the 

stage upward for focusing, select Focus Up. The 3-Speed Selection 
option controls the speed of stage movement. The Eject option 
positions the stage for easiest removal of samples. 

 
 

. Press the button on the joystick device that you want to use to 
e selected action. 

The identification number of the button automatically appears to the 

ther actions you want to assign. 

3
perform th

 
 

right of the option. 
 
 
4. Repeat steps 2 and 3 for the o
 
 
5. Choose OK. 
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sequence and perform other operations to set up map data collection. 
 
 

T The Atlµs window provides features you need to set up a mapping 
experiment. The window appears when you choose Show Atlµs Window 
from the Atlµs menu. 
 

Preparing for Data Collection 
 
 
This chapter describes the Atlµs window and explains how to specify a map 

he Atlµs window 

Moveable border

Tool palette Moveable
description bar

Buttons

Video paneNavigation pane

 

dow 

 
 

 dragging the border that 
parates them to the left or right. 

 
At the bottom of the Atlµs window are several tools and buttons you can 
use to draw maps and apertures (if available), adjust the display of 
information in the panes and perform other operations. These are described 
later in this chapter. 

 
tlµs winA

 
The Atlµs window contains two panes:  the navigation pane and the video
pane. These panes let you graphically specify a map sequence and view the
sample. You can change the sizes of the panes by
se
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 Note 
 the window; you use other 

atures to specify the size and orientation of the aperture. See “Setting the 
tomated Reflex aperture” for details. If your microscope does not have 

this feature, the aperture tool is provided. S 

 
The description bar displays information about the operation you are 
performing or tool you are currently using. You can drag the description 
bar from the bottom of one pane to the other according to your 
preferences. 

The navigation pane The navigation pane of the Atlµs window shows graphically the possible 
range of movement of the microscope stage. The X-axis and Y-axis of the 
pane correspond to the side-to-side and front-to-back movements of the 
stage, respectively. You can change the displayed stage area by using the 
palette tools and the buttons near the bottom of the window. These are 
explained later in this chapter. 
 

 
If you display the entire range 

of movement in the navigation pane, 
the video image is too small to be seen. 

he navigation pane includes a video image of the samp  area being 
 image is a copy of the live video image displayed in the video 
gh it may be larger or smaller depending on how you have 

justed the display. The copy is updated whenever the stage moves or the 

If you have a Continuµm microscope with the automated Reflex aperture 
system, the aperture tool does not appear in
fe
au

 
 

T le
viewed. This

ane, althoup
ad
navigation pane is resized or moved. 
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Here is an example showing the navigation pane with an area map drawn 
and a background point (labeled “B”) specified: 

 

 

 
 
 

 
 

A cop
in the p

small to be seen. In this example 
it has been enlarged by zooming in. 

 

The cross hairs indicate the

y of the video image appears 
ane, although it may be too 

 
 

center of the current field of view. 

 
Navigation pane 

 
You can use the Atlµs window tools within the navigation pane to specify
the size an

 
d location of a map and the location of the background point, if 

ppropriate. See “The tool palette” for more information. 

he X and Y proportions (aspect ratio) of the navigation pane always 
atch those of the video pane, except when you use the Full Range View 

n in the Atlµs window to show the entire range of stage movement. 
Because of this, any map you draw in a zoomed-in area of the navigation 

g 
 easy to see the 

 
The video pane 

e coordinates that are visible within 

a
 
T
m
butto

pane will have the same shape in the video pane. Together, the matchin
proportions and the copy of the video image make it
correspondence between the two panes as you change the view of the 
sample. 
 

The video pane at the right side of the Atlµs window displays a live video 
image of the sample surface. The stag
the pane are indicated by the X-axis and Y-axis. 
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Here is an example showing the video pane with an area map drawn and a 

 
 
 
 

 
 
 
 
 

The “target” cross hairs indicate 
 field of view. 

background point (labeled “B”) specified: 

 

the center of the

 
 
Video pane 

 
You can display different areas of the sample in the video pane by using the 

the view with the stage movement 

 
 window tools within the video pane to specify the 

 location of the background point, if 
appropriate. See “The tool palette” for more information. 

ane 
always match those of the video pane (except when you use the Full Range 

o show the entire range of stage 
u draw in the video pane will have the same shape 

in a zoomed-in area of the navigation pane. 

 Clipboard by choosing 
menu. You can then paste the image into 

stage movement tool (see “Moving the stage by clicking a point”) or the 
stage movement buttons (see “Changing 
buttons”). 

You can use the Atlµs
size and location of a map and the

 
Because the X and Y proportions (aspect ratio) of the navigation p

View button in the Atlµs window t
movement), any map yo

 
You can copy the video image to the Windows
Copy Video Image from the Edit 
a document using a word processing program or other program that lets 
you paste items from the Clipboard. 
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If you have a Continuµm microscope with the automated Reflex aperture 

pane by a box whose size, shape and orientation 
perture in the 

microscope. See “Adjusting the automated Reflex aperture graphically” for 

 
The tool palette  tools for graphically specifying and 

 information in the Atlµs window. 

 

T
system. A red line may appear on a tool 

if it cannot be used under the current 
conditions (for example, when a Z-axis 

initialization needs to be performed). 

system (must be installed by Thermo Fisher Scientific), the Reflex aperture 
is represented in the video 
you can manipulate. This manipulation adjusts the a

instructions. 
 

The tool palette provides you with
manipulating map sequence

 
 

he provided tools depend on your 
Arrow Area map

Line map RulerStage
movement

Aperture Text
Background point

Sample
point

Marker
 

 
When you move a tool’s pointer into the navigation pane or video pane, 
the coordinate values of the pointer location appear in the description bar. 

rance of the pointer may change to indicate which tool is 
selected. 

can do with each tool: 
 

Also, the appea

 
The table below shows what you 

 
Tool  Uses 

 
arrow tool flex aperture, if available. (See “Adjusting the 

automated Reflex aperture graphically” for details.) 

Move the stage or a sample point, background point (if available), line 
 ruler, text annotation, marker or box drawn to specify a 

y sample and background point (if available) 
in order (Check Points command). 

Resize a line map, area map, drawn aperture (if available), ruler, or box 

ground point (if available), aperture (if 
vailable), ruler, text annotation or marker. 

Adjust the automated Re

map, area map,
Mosaic. 

Briefly move the stage to ever

drawn to specify a Mosaic. 

Delete a map, sample point, back
a
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Tool  Uses 

Clear a map sequence. 

Edit text annotation. 

  

ove the stage by dragging the cross hairs. 

Set the video source parameters. 

Set home to the current stage location. 

M

Rotate a drawn aperture (if available). 

 
line map tool Draw a line map. 

Move a line map. 

Resize a line map. 

Add a background point (if available). 

Delete a line map. 

Set the video source parameters. 

 
area map tool 

Set the video source parameters. 

Draw an area map. 

Move an area map. 

Resize an area map. 

Add an ordered array of discrete points. 

Add a background point (if available). 

Delete an area map. 

 
samp

nd point (if available) or marker. 

elete a sample point. 

pecify whether to capture the video image for a sample point (Toggle 
Capture Video For Sample Point command). 

Set the video source parameters. 

Set the Z (vertical) position of a sample point to the current Z position. 

le point tool Add a sample point or background point (if available). 

Move a sample point, backgrou

Move the stage to a sample point. 

D

S
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Tool  Uses 

 
background point tool (if 
available) 

dd a background point. 

Mo

De

et the video source parameters. 

A

Move a background point, sample point or marker. 

ve the stage to the background point. 

lete a background point. 

S

Move the stage to a point. 

Set the video source parameters. 
 

stage movement tool 

 
aperture tool (if available) 

Resize a drawn aperture. 

s default size and zero degrees of rotation. 

et the video source parameters. 

Draw an aperture. 

Delete a drawn aperture. 

Set the drawn aperture to it

S

 
ruler tool 

ove a ruler. 

Set the video source parameters. 

Draw a ruler. 

M

Resize a ruler. 

ol Add text annotation. 

Edit text annotation. 

Delete text annotation. 

Set the video source parameters. 

 
text to

marker tool
 

marker, sample point or background point (if available). 

ove the stage to a marker. 

et the video source parameters. 

Add a marker. 

Move a 
 

M

Delete a marker. 

elete all the displayed markers. D

S
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All of these operations, except setting the video source parameters, are 
explained later in this chapter. See “Setting the video source parameters” in 

e “Configuring the System” chapter for information about setting the 

Changing the view 
by moving the stage 

e ur view of a sample by moving the 
age. These are explained in the next sections. 

 
 

Changing the view with 
the stage m

he stage movement buttons let you move the stage in four directions. The 

ch 
 

flect the new stage coordinates represented by the 

th
video source parameters. 
 
 
Th re are several ways to change yo
st

T
distance the stage moves when you click a button depends on the 
dimensions of the video field of view and the direction of movement. Ea
time you click a button, the stage moves one full video frame. The video

ane axes change to rep
pane. 
 

ovement buttons 

Click this button to see a portion of the sample that is to the left of the 
 displayed video frame. The stage X coordinates decrease. 

 
Click this button to see a portion of the sample that is to the right of the 

isplayed video frame. The stage X coordinates increase.  d
 
Click this button to see a portion of the sample that is “above” the 

 displayed video frame. The stage Y coordinates increase. 
 

 
 

Click this button to see a portion of the sample that is “below” the 

 
Moving the stage 

by clicking a point

displayed video frame. The stage Y coordinates decrease. 

 
Follow the steps below to quickly move the stage to position a specified 

n  objective. The point becomes the center of the 
ideo image in the video pane. 

poi t under the microscope
v

 
 
1. Select the stage movement tool. 
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2. Click the point in the navigation pane or video pane that you want
positioned under the microscope

 
 objective. 

t, the stage moves as needed to position the 
point under the objective. The video image is redisplayed with the 
point at the center, and the video pane axes are adjusted accordingly. 

ion 
pane. 

 Note e ideo image is 
alibrated and that the X and Y axes are set correctly. Use the tool to click a 
ca oves to the center of the video 
ane, the calibration and settings are correct. S 

 
Moving the stage by 

dragging the cross hairs 

 
 When you click the poin

The clicked point is also marked with cross hairs in the navigat

 
Th  stage movement tool is useful for verifying that the v
c
lo tion in the video pane. If that location m
p
 

Y

 

ou can use the arrow tool to move the stage. Follow these steps: 

. Select the arrow tool. 

. Drag the cross hairs in the navigation pane or video pane to the 

 
 When you release the mouse button, the stage moves and the panes’ 

axis labels are updated to reflect the new position. 

Moving the stage 
to its home position 

 
1
 
 
2

desired location. 

 
 

Cl k the Move Stage To Home button to move the stage horiz

 

ic ontally to 
e hose coordinates are 0,0). 
u e current stage location by right-clicking the 
v eo pane with the arrow tool and choosing Set Home 

tage 
n 

d” for 

Moving the stage 
to the origin point 

Choose Go To Origin from the Atlµs menu to move the stage to the origin 
point (the “home” location, whose coordinates are 0,0). 
 
 

th location defined as “home” (the location w
Yo  can set home to th
na igation pane or vid
To Current from the pop-up menu. You can set home to the current s
location or to its original location by using the Move Stage command i
the Atlµs menu. See “Moving the stage with the Move Stage comman
details. 
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Moving the stage 
to a sample point 

Follow these steps to

 

 move the stage to a sample point you have specified 
ith the sample point tool (see “Specifying discrete sample points”): 

. Select the sample point tool. 

 
. Right-click the sample point. 

 
 
3. Choose Move To Point from the pop-up menu. 
 
 

Moving the stage 
to a background point 

w
 
1
 

2

 

 

Follow these steps to move the stage to a background point you have 
specified with the background point tool, if available (see “Specifying a 
background point”): 
 
1. Select the background point tool or sample point tool. 
 
 
2. If you selected the background point tool, right-click anywhere in 

the navigation pane or video pane. If you selected the sample point 
tool, right-click the background point. 

 

. Choose Move To Background Point or Move To Point from the 
pop-up menu. 

 
 

Moving the stage to every 
sample and background point 

 
3

Fol  
background point (if available) in order. This lets you review the sequence 
of poin
 
1. Sele
 
 
2. 
 
 
3. Cho
 
 he stage starts to move to the points. You can cancel the operation by 

pressing the Esc key on the keyboard. 
 

low the steps below to briefly move the stage to every sample point and 

ts that will be used in the map collection. 

ct the arrow tool.  

Right-click anywhere in the navigation pane or video pane. 

ose Check Points from the pop-up menu. 

T
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Moving the stage to a marker 

 

Follow these steps to move the stage to a marker you have added with the 
marker tool (see “Adding a marker”): 

1. Selec  t
 
 
2. Right-click anywhe
 
 
3. Choose Mo e To M
 
 The Go To Marker dialog box appears: 
 
 
4. Type the number o
 
 You can typ  the nu
 
 

. Choose OK. 
 
 

pre
 
 

Moving the stage with
the Move Stage command 

Use Move Stage in the Atlµs menu to move the stage in any of these ways: 
 
 In one operation to a point whose coordinates you specify. 

• 
• Alo
 

ou can (the 
loca on
original
information about moving the stage to this position later. 
 

 
t the marker ool. 

re in the navigation pane or video pane. 

v arker from the pop-up menu. 

f the marker. 

e mber with or without the “M” in front of it. 

5

The stage moves to the marker. You can cancel the operation by 
ssing the Esc key on the keyboard. 

 

•
Incrementally along the X-axis or Y-axis. 

ng the Z-axis. 

 also set the current X-Y position as the “home” position Y
ti  whose coordinates are 0,0) or reset the home position to its 

 location. See “Moving the stage to its home position” for 
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Fol  
 
1. hoose Move Stage from the Atlµs menu. 
 
 The Move Stage dialog box appears showing the current X and Y stage 

coordinates in the Move To Position box: 
 

 

low these steps: 

C

 
 
 
2. Move the stage as desired. 

• To move the stage to a numerically specified point, type the desired 
ove To 

Position box, and then click the Move button. The stage moves to 
the specified point. To return the stage to its previous position, 

• To move the stage a specified distance along its X-axis or  
Y-axis, first type the desired distance in micrometers in the Step 

desired direction of movement. 
 

 

X and Y coordinates in the X and Y text boxes in the M

click the Back button. 
 

Size (µm) text box in the Move By Steps (X,Y) box or use the scroll 
bar to change the value. Then click the button labeled with the 
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 The table below explains how the buttons move the stage. 
 

 
This button… Does this… 

 

Moves the stage to the right to display a portion 
of the sample that is to the left of the current 
video frame. The stage X coordinate decreases. 

 the sample that is to the right of the current video
frame. The stage X coordinate increases. 

Moves the stage to the left to display a portion of 
 

 
Moves the stage toward the front to display a 
portion of the sample that is “above” the current 
video frame. The stage Y coordinate increases. 

 
Moves the stage toward the rear to display a 
portion of the sample that is “below” the current 
video frame. The stage Y coordinate decreases. 

 
 

from a sample feature. 
 

 Each time you click a button, the stage moves the specified distance 
in the indicated direction. This lets you move the stage 
incrementally toward or away 

 
 Click this button if you want to move the stage to the location 

defined as “home” (the location whose coordinates are 0,0). 
 

 
 You can set home to the current stage location by clicking the Set 

 Home To Current button. (You can also do this by right-clicking
the navigation pane or video pane in the Atlµs window and 
choosing Set Home To Current from the pop-up menu.) 

 

 
 Click the Reset Home button to reset the home position to the 

location it had immediately after the stage was initialized (the center 
of the stage). 
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• To move the stage up or down along the Z-axis, click the Z Move 
button. The Z Position dialog box appears: 

 

  
 

Be careful not to hit the objective with the sample or stage when moving 
the stage up. S 

 

 Important 

 To move the stage up or down, drag the horizontal bar up or down, 

 mouse button. If your mouse has a 
wheel, you can use it to control the bar and move the stage. You 

oard to 
move the stage vertically. 

 When you are finished, click the Close button (labeled “X”). The 

Zooming in or out ays to zoom in on an area in the navigation pane or 
om out. These are explained in the next sections. 

 
Using the zoom buttons The zoom buttons let you quickly zoom in on the area of the stage you are 

viewing in the navigation pane or zoom out from the stage to see a larger 
area. 
 

respectively, and hold it until the stage is in the desired vertical 
position. Then release the

can also press the up and down arrow keys on the keyb

 
 To increase the speed of the stage movement, select Fast, or hold 

down the Shift key while you drag the bar. 
 

dialog box closes automatically after 5 seconds if you start using 
another feature. 

 
 
3. When you are finished moving the stage, choose Close. 
 

There are several w
 

zo
 

 

Click the Zoom In button to decrease the area of the stage represented in 
the navigation pane. The cross hairs indicate the center of the area. 
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Click the Zoom Out button to increase the area of the stage repre
the navigation pane. The maximum size of the stage area represented 
pane is the maximum travel allowed by your stage controller. 
 
You can limit the range of travel by using th

 

sented in 
by the 

 Note e Limit Stage Travel button in 
e System Configuration dialog box. See “Limiting the stage travel” in the 

Zooming in on a map 

th
“Configuring the System” chapter. S 

 
 
C

 

lick the Zoom To Points button in the Atlµs window to instantly zoom 
 o seful if you have 
omed out from the map to view a larger stage area and the map is now 

isplayed too small to be seen clearly. 

Displaying the full 
range of stage travel 

in n a map displayed in the navigation pane. This is u
zo
d
 
 
C k the Full Range View button to zoom all the way out to disp

 

lic lay the 
ll range of stage travel allowed by your stage controller. 

 Note ou can limit the range of travel by using the Limit Stage Travel button in 
ration dialog box. See “Limiting the stage travel” in the 

ystem” chapter. S 

Using the focus buttons  you have the required hardware, you can use the focus buttons to focus 

fu

 
Y
the System Configu
Configuring the S“

 
 
If
the microscope: 
 
C k the ATR Contact

e upward to make o
lic  button (if available) to automatically move the 
ag ptimal contact with an ATR sample. After contact 
 made, you can click the button to release contact. See “Using auto ATR 

 

 st
is
contact” in the “Collecting Map Data” chapter for complete information. 

Thermo Fisher Scientific OMNIC Atlµs User’s Guide 69 



Preparing for Data Collection 

Cli k the Z Position button to display a dialog box that lets you move 
e up or down: 

c the 
stag 
 

 
 

 Important c ple or stage when moving 
e stage up. S 

o move the stage up or down, drag the horizontal bar up or down, 
respectively, and hold it until the stage is in the desired vertical position. 
Then release the mouse button. If your mouse has a wheel, you can use it 

row keys on the keybo rd to move the stage vertically. 

To increase the speed of the stage movement, select Fast, or hold down the 
Shi
 

hen you are finished, click the Close button (labeled “X”). 

 Be areful not to hit the objective with the sam
th
 
T

to control the bar and move the stage. You can also press the up and down 
r aa

 

ft key while you drag the bar. 

W
 
If you click the Autofocus button (requires the optional autofocus 

ardware), the system focuses on the sample automatically by moving the 

alibrating digital autofocus. 

 h
stage up or down. See “Autofocus calibration” for information about 
c
 
Click the Store Z Position button to save the Z (vertical axis) coordinate of 

e current stage position so that you can return to it later with the Recall Z 

 

 th
Position button. 

Click the Recall Z Position button to move the stage to the Z coordinate 
at was last saved with the Store Z Position button. The Recall Z Position 

button is available only if the Store Z Position button has been used to save 
the Z coordinate. 
 
 

 th
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Au

uto Apertures, Autofocus and Auto ATR options” in the “Configuring 

 Note rompt does not appear, the digital autofocus has already been 
alibrated or the system does not include the digital autofocus feature. Skip 

A prompt appears. 

. Adjust the vertical position of the stage so that the sample is no longer 
in focus, and then choose OK. 

 
 Do not change move the stage horizontally. 
 
 A prompt appears. 
 
 

tofocus calibration If your system has digital autofocus and Digital is selected in the 
Microscope Configuration dialog box, you must calibrate the digital 
autofocus the first time you use the Autofocus button. See “Setting the 
A
the System” chapter for more information. 
 
Follow these steps to perform an autofocus calibration: 
 
1. Place a high-contrast sample on the stage. 
 
 The provided soda can sample works well for this. 
 
 
2. Click the Autofocus button. 
 
 A prompt says that the digital autofocus must be calibrated. 
 
If the p
c
this procedure. S 

 
 
3. Choose OK. 
 
 
 
 
4. Focus on the sample surface and then choose OK. 
 
 A prompt appears. 
 
 
5
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6. Turn off the illumination or adjust the view selector for viewing 
through the eyepieces only, and then choose OK. 

 
 A message says the calibration is complete. 
 

Selecting 
a calibration 

 
7. Choose OK. 
 
 
Use the Show Calibration Bar button to quickly select a saved calibration. 

ollow these steps: 

1.  Bar button. 

F
 

Click the Show Calibration
  

 A dialog box appears. Here is an example: 
 

  
 
 Each calibration you have saved is represented by a button labeled with 

the magnification of the objective used to create the calibration. See 
“Calibrating the video image” in the “Configuring the System” chapter 

flect the selected calibration. 

. 
per-right corner). 

for more information. 
 
 
2. Click the button for the calibration you want to use. 
 
 If you are using an FT-Raman View Stage, click the Fixed button. 
 
 The video pane changes to re
 
 
3 Close the dialog box by clicking its Close button (labeled “X” in 

the up
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Specifying a 
map sequence sequence or create a new sequence, as explained in the next sections. 

 
Opening a map sequence Map sequence settings are saved in experiment files. (See “Saving a map 

sequence” for more information.) To open a map sequence, open the 
experiment that contains it. You can do this by selecting an experiment 
from the Experiment drop-down list box below the menu bar or by using 
the Open button in the Experiment Setup dialog box (available through 
Experiment Setup in the Collect menu). Make sure the Map check box is 
selected in the Open Experiment dialog box. If you are using OMNIC, 
choose OMNIC Help Topics from the Help menu, find “Experiment 
Setup command” in the Index and go to the “Using Experiment Setup” 
topic for more information. If you are using OMNIC For Raman, choose 
Raman Help Topics from the Raman menu, find “Experiment Setup 
command” in the Index and go to the “Setting the experiment parameters” 

 

iles 
e 

n 

in 
window. If you want to save that sequence, be sure to do so 

efore opening a map sequence. 

 

To specify a map sequence for collecting a map, you can open a saved 

 

 
 

topic. 
 

 Note You can also use Open in the File menu to open a sequence file saved using
an earlier version of OMNIC Atlµs. To allow you to locate and select a 
sequence file, set Files Of Type in the Open dialog box to Sequence F
(*.SEQ). Opening a sequence file has the same effect as opening a sequenc
that is part of an experiment. S 

 
When you open a map sequence, the map it defines is displayed in the 
navigation pane. The map may also appear in the video pane depending o
the stage coordinates currently represented by the pane. 
 
The opened map sequence replaces any map sequence already displayed 
the Atlµs 
b
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Drawing maps 
items in 

if 

 
Drawing a line map 

and other 
the Atlµs window 

You can use the palette tools to draw a map, sample points, an aperture (
available), a ruler and other items in the navigation and video panes. The 
next sections explain how. 

 

Follow the steps below to draw

 

 a line map. The new map replaces any 
urrently displayed map or sample points. 

 

. e 

 Note cases the starting and ending points of a line map are determined 
t with the lower X value is 

esignated the starting point; the endpoint with the greater X value is the 
nding point. Therefore, depending on how you draw the line, the point 

finished. If the X value is the same for all points, the starting point is the 
oint with the lowest Y value. S 

 
. Press and hold down the mouse button. 

. Move the pointer to the location where you want the line to end. 

 s in length and direction as you move the mouse. 

5. 
 
  

 
When you draw a map in the navigation pane or video pane, the map 
appears in both panes, although you may need to zoom in to see the 
map in the navigation pane. See “Using the zoom buttons” for more 
information. 

 

c
 
1. Select the line map tool. 

 
2 Point to the location in the navigation pane or video pane wher

you want the line to start. 
 
In most 
by the X values of both endpoints. The endpoin
d
e
where you start drawing may be the starting or ending point when you are 

p
 

3
 
 
4
 

The line change
 
  

Release the mouse button. 

If there was a map displayed in the pane, it is replaced by the new line
map. 
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 The following illustration shows a drawn line map in the navigation 
and video panes: 

 
 
 
 
 
 

 
 

The tick marks on the line 
indicate the locations of sample points.

  

 

 
 When you release the mouse button, the length of the map may vary from 

the line you drew by dragging. This is because the size of the map must be 
adjusted for the default step size specified on the Mapping tab in the 
Options dialog box (or to the aperture size default). “Specifying a default 
step size” for more information. 

  or example, if you used the mouse to specify a line map with a length of 

d 
e for 

at tab. 

ear Map Sequence from the 
Edit menu. See “Clearing a map sequence” for complete information. 

 

Note 

 
F
100 micrometers and the step size is set to 22 micrometers, the length is 
automatically adjusted to 110 micrometers so that the step size is divide
evenly into the map length. Map lengths always expand to compensat
step intervals; they are never less than the length you specified with the 
mouse. S 

 
 The next time you use Experiment Setup in the Collect menu, the 

information for the map will appear on the Mapping tab. You can 
specify a line map numerically by entering X and Y values on th
See “Setting the mapping parameters” for details. 

 
 To clear the map and start over, choose Cl
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Drawing an 
area map (or Mosaic) 

F low the steps below to draw an area map or specify a sample area for

ideo images for a sample area” for more information.) The new map 
aces any currently displayed map. 

ol  
capturing a Mosaic of video images of that area. (See “Capturing a Mosaic 
of v
repl

. 
 
 

. Point to the position in the navigation pane where you want a 
corner of the map (or Mosaic) to be located. 

 the video pane if desired. 

. Move the pointer to where you want the opposite corner of the map 
(or Mosaic) located. 

 
The map (or box for specifying the Mosaic) changes size and shape as 

. Release the mouse button. 

If there was a map displayed in the pane, it is replaced by the new area 
map (or box).  

 
 When you draw a map in the navigation pane or video pane, the map 

appears in both panes, although you may need to zoom in to see the 
map in the navigation pane. (See “Using the zoom buttons” for more 
information.) In the video pane each sample point within the map is 
indicated by a dot. If the map is larger than the video pane, only the 
sample points within the limits of the pane will be visible. 

 

  
1 Select the area map tool. 

2

 
 If you are drawing an area map rather than an area for capturing a 

Mosaic, you can draw the map in
 
  
3. Press and hold down the mouse button. 
 
 
4

 
you move the mouse. 

 
 
5
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 If you have set Detector on the Bench tab of the Experiment Setup 
dialog box to XL Array (see “Specifying the detector for the 
Continuµm XL”), the Y dimension of the drawn area map (or box) 
“snaps” to the Y dimension of the linear array, or to a multiple of that 
dimension. This ensures that the full linear array is used when data is 
collected. 

ration shows a drawn area map in the navigation 
and video panes: 

 
 
 
 
 
 
 

In the video pane the dots 
indicate the locations of sample points. 

 
 The following illust

 

  
 
When you release the mouse button, the map may vary from the area you 
specified using the mouse. This is because the size of the map must be 
adjusted for the default step size specified on the Mapping tab in the 
Options dialog box (or to the aperture size defau

 Note 

lt). “Specifying a default 
ep size” for more information. 

  or example, if you used the mouse to specify a map area of 100 by 100 
 X and Y 

imensions, the map area is automatically adjusted to 115 by 115 
icrometers so that the step size is divided evenly into the map area. Map 

 
an the area you specified with the mouse. S 

st
 
F
micrometers and the step size is set to 23 micrometers in both the
d
m
areas always expand to compensate for step intervals; they are never less
th
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 The next time you use Experiment Setup in the Collect menu, the 
information for the map will appear on the Mapping tab. You can 
specify an area map numerically by entering X and Y values on that tab. 

 
To clear the map (or box) and start over, choose Clear Map Sequence 
from the Edit menu. See “Clearing a map sequence” for complete 

Specifying 
discrete sample points 

See “Setting the mapping parameters” for details. 

 

information. 
 
 
You can use the sample point tool to specify individual locations, or 

iscrete points,” on the sample for collecting sample spectra. They replace 
y map that is currently displayed. 

o add a sample point, click a location in the navigation pane or video 

exam

“d
an

 
 
T
pane. A consecutively numbered cross hairs marker appears. Here is an 

ple: 

 

 
 
The following illustration shows three discrete sample points specified in 

video pane: the 
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 Note roscope 
efore specifying each point. Each focus position (Z value) is stored and 
ill ete Points Only) 
ption in the Focus dialog box (available through Focus on the Mapping 
b of the Experiment Setup dialog box). S 

 a line map or area map is currently displayed, it is removed when you 
ecify the first point. 

When you specify points in the navigation pane or video pane, the points 
ppear in both panes, although you may need to zoom in to see the points 
 the navigation pane. See “Using the zoom buttons” for more 

ou oving 
 discrete sample point or background point.” 

o clear all the points and start over, choose Clear Map Sequence from the 

re, 
ecify a different aperture size, shape and orientation for each 

oint in a discrete-point collection. This is useful when the sample surface 

the desired area would improve the collected data. If you specify different 
aperture settings for the sample points, a new background is collected using 
the appropriate aperture setting for each point. 
 
Follow these steps: 
 
1. Center the first sample area of interest in the video pane. 
 
 
2. Adjust the Reflex aperture as desired for the first sample point. 
 
 

If you have the optional autofocus feature, you can focus the mic
b
w  be used by the Use Stored Focus Locations (Discr
o
ta
 
If
sp
 

a
in
information. 
 
Y  can move any point by using the arrow tool, as explained in “M
a
 
T
Edit menu. See “Clearing a map sequence” for complete information. 
 
 
Using different aperture settings for discrete points 
 
If you have a Continuµm microscope with the automated Reflex apertu
you can sp
p
around the points of interest varies, and using a different aperture to isolate 
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3. Use the sample point tool to click the center of the cross hairs in the
video pane. 

 
 This specifies the first sample point and stores the aperture settings in 

memory. 
 
 

 

. Repeat the above steps for the next sample points. 

Each time you specify a sample point, the aperture settings for that 
point are stored in memory. 

. Specify the background location for the collection. 

 Whenever the aperture is adjusted for a sample point during collection, 
the system will automatically collect a new background at the background 

. Choose Collect Map from the Collect menu to collect the spectra. 

Before each spectrum is collected, the system automatically adjusts the 

Specifying an ordered 
array of discrete points 

4
 
 

 
 
5
 

location using the new aperture setting. 
 
 
6
 
 

aperture to the stored settings. 
 
 

If your samples are regularly spaced on a microscope slide or other suitable 
rface, you can use the area map tool to specify an “ordered array” of 

map

 
. Select the area map tool. 

 
. Draw a rectangle in the navigation pane or video pane to specify 

 
3. Right-click anywhere in the navigation pane or video pane. 
 
 

su
discrete points that matches the sample locations. The points replace any 

 that is currently displayed. Follow these steps: 
 

1
 

2
the area in which you want the ordered array located. 
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4 Choose Ordered Discrete Points from the pop-up menu. 

The Ordered Discrete Points dialog box appears. 

. 
 
 
 
 

. Type the desired step sizes and number of points in the text boxes. 
 
 
6. If you want to see the results of your settings in the Atlµs window 

before closing the dialog box, click the Apply button. 
 

. When you are finished, choose OK. 

 
 

5

 
7
 

Here is an example of an ordered array in the navigation pane: 

  
 

 can use the right mouse button to click a location in Note You  the navigation 
ane or video pane for the background point (if available) for the map. A 

spe
the Collect menu, the information for the specified background point will 
ppear on the Mapping tab. See “Setting the mapping parameters” for 
etails. S 

 
 for complete 

information. 
 

p
cross hairs marker with the letter “B” appears, replacing any previously 

cified background point. The next time you use Experiment Setup in 

a
d
 
 To clear all the points and start over, choose Clear Map Sequence from

the Edit menu. See “Clearing a map sequence”
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Setting
position for a discrete 

point to the current Z position  

 the Z Follow the steps below to set the Z (vertical) position for a discrete sample 
point to the current Z position with the sample point tool. If Use Stored
Focus Locations (Discrete Points Only) is selected in the Focus dialog box
(available th

 

 
 

rough the Focus button on the Mapping tab of the Experiment 
etup dialog box), the stage will automatically move to the set Z position 

Setting the focus parameters” for 
ore information. 

1. 

. Right-click the sample point in the navigation pane or video pane. 

. Choose Set Z Position To Current from the pop-up menu. 
 
 

Specifying a background point 

S
before collecting data at that point. See “
m
 

Select the sample point tool. 
 
 
2
 
 
3

Follow the steps below to specify where on the sample to collect a 
background spectrum for an FT-IR map. The point replaces any 
background that is currently displayed. 

. Select the background point tool. 

ap 

. Click the location in the navigation pane or video pane where you 
 

 
 If you are using the sample point tool, line map tool or area map tool, 

 

ecified background point. 

 

 

 

 

 
1
 
 You can also select the sample point tool, line map tool or area m

tool. 

2
want to collect a background.

right-click the location and then choose Add Background Point from
the pop-up menu that appears. 

 
 A cross hairs marker with the letter “B” appears at the clicked location, 

replacing any previously sp
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 If you have a Continuµm XL microscope and have selected Use Linear 
Array Detector For Map Setup in the Collect dialog box (available 
through the Collect button on the Mapping tab of the Experiment 
Setup dialog box), a rectangular cursor is overlaid on the cross hairs in 
the navigation pane. Here is an example: 

 

  
 
 This cursor shows the size and shape of the linear array, allowing you to 

not overlap the area where you will collect sample data. See “Setting 
llection” 

chapter for more information. 

When you specify a background point in the navigation pane or video 
ed to use 

the Zoom In button to see the point in the navigation pane. See “Using 
the arrow tool to zoom in” or “Using the zoom buttons” for more 

g the arrow tool, sample 
point tool, background point tool or marker tool, as explained in 
“Moving a discrete sample point or background point.” 

 
 The next time you use Experiment Setup, the location of the 

background point will appear on the Mapping tab.  
 
 To clear the background point and all the sample points, choose Clear 

Map Sequence from the Edit menu. See “Clearing a map sequence” for 
complete information. 

 
 

Drawing an aperture 

position the background point so that the area of the linear array does 

special mapping options” in the “Preparing for Data Co

 
 

pane, the point appears in both panes, although you may ne

information. 
 

You can move the background point by usin 

 

Use the aperture tool (if available) to draw a rectangular aperture in the 
video pane. The drawn aperture is always centered about the cross hairs in 
the pane, which reflect the current stage position. 
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s not needed and therefore not available. See 

Setting the automated Reflex aperture” for information on adjusting the 
perture. S 

ollow these steps to draw an aperture: 

croscope and focus so that 
the aperture is clearly visible in the video pane. 

If the aperture is adjustable, adjust its size and shape as desired. 

2. 

 Here is an 
example: 

Note If you have a Continuµm microscope with the automated Reflex aperture 
system, the aperture tool i
“
a
 
F
 
1. Install a rectangular aperture in the mi

 
 
 
 

Select the aperture tool. 
 
 A box representing an aperture appears in the video pane.

 

  
 
 
3. Drag a side or corner of the box to change its size, shape and 

orientation to match that of the aperture image. 
 
 Here is an example: 
 

  
 
 

Displaying a ruler 

 

You can use the ruler tool to display a ruler for measuring items in the 
navigation pane or video pane. For example, if you want to measure the 
length of an item, you can draw a ruler alongside the item and the same 
length as the item. The length of the ruler displayed in the description bar 
is then the length of the item. 
 
Follow these steps: 
 
1. Select the ruler tool. 
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2. Point to the location in the video pane where you want the ruler to 
start. 

. 

the ruler to end. 

e. 

utton. 

If there was a ruler displayed in the pane, it is replaced by the new ruler. 

 ler drawn in the video pane: 

 
 
3 Press and hold down the mouse button. 
 
 
4. Move the pointer to the location where you want 
 
 The ruler changes in length and direction as you move the mous
 
 
5. Release the mouse b
 
 
 

Here is an example of a ru
 

  
 
 The length of the new ruler appears in the description bar: 
 

  
 
 You can move or resize the ruler with the arrow tool as explained in 

“Moving the ruler” or “Resizing the ruler.” 
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Adding text annotation Follow the appropriate procedure below to add text annotation to the video 
ane or navigation pane. 

 
Adding text annotation that is not connected with a line 

. Select the text tool. 

. Turn off Connect Text Annotation With Lines on the Mapping tab 

otation with a line” for details. 

u 
want the text to begin.  

A box appears: 

 

p
  

 
Follow these steps to use the text tool to add text annotation that is not 
connected to the displayed item with a line: 
 
1
 
 
2

of the Options dialog box. 
 
 See “Connecting text ann
 
 
3. Click the location in the navigation pane or video pane where yo

 
 
 

 
 
 

on the keyboard begins a new line of text. 
 

4. Type the desired text. 
 
 Pressing Enter 
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5. Click outside the box. 

 Here is an example: 
 
 The text annotation appears in the pane.
 

  
 
 
Adding text annotation that is connected with a line 

connected to the displayed item with a line: 

. 

2. Select Connect Text Annotation With Lines on the Mapping tab of 
the Options dialog box. 

 
 See “Connecting text annotation with a line” for details. 
 
 
3. Move the pointer over the location in the video pane where you 

want the line to begin. 
 
 
4. Press and hold down the mouse button, move the pointer to the 

location where you want the line to end, and then release the mouse 
button. 

 
 A box appears: 

 
 

 
Follow these steps to use the text tool to add text annotation that is 

 
1 Select the text tool. 
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5. Type the desired text. 
 
 Pressing Enter on the keyboard begins a new line of text. 
 
 
6. Click outside the box. 
 

 an  The text annotation and connecting line appear in the pane. Here is
example: 

 

  
 
 

Adding a marker Use the marker tool to add markers to the nav
dentify locations of interest. This will help yo

igation pane or video pane to 
u find these locations later. i

 Each marker appears as a consecutively numbered letter “M.” Here is an 
example: 

 
 

 
Follow these steps to add a marker: 
 

vigation pane or video pane. 

A new marker appears. 

 ker 
moves in both panes when you drag it. 

 
 

1. Select the marker tool. 
 
 
2. Click the desired location in the na
 
 
 

You can drag the marker to a different location if desired. The mar
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Moving maps and other 
items in the Atlµs window

e t flexibility in moving items 
you have drawn in the window. The next sections explain how to move 
each type of item. 

Moving a line map

Th  Atlµs window tool palette gives you grea
 

 
 

 Follow the steps below to move a line map without changing the length or 
ap” for information about drawing 

ne maps. 

 
 

directional arrows shown below appear. 

slope of the map. See “Drawing a line m
li
 

 

 
1. Select the line map tool or arrow tool. 

Move the pointer over the midpoint of the map so that the 2. 

 

  
 
 
3. Drag the map to the desired location. 

 eriment Setup in the Collect menu, the 
information for the moved map will appear on the Mapping tab. See 
“Setting the mapping parameters” for details. 

 
 

Moving an area map or box 
drawn to specify a Mosaic 

 
The next time you use Exp

F low the steps below to move an area map without chanol ging the size or 
ape of the map. You can also move a box drawn to specify a sample area 
r c pturing a Mosaic. See “Drawing an area map (or Mosaic)” for 
formation about drawing area maps. 

 

 

. 

 

 

sh
fo a

 

 

in

1. Select the area map tool or arrow tool. 

 
2 Move the pointer over the center of the map (or box) so that the 

hand shown below appears. 
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3. Drag the map (or box) to the desired location. 
 
 The next time you use Experiment Setup in the Collect menu, the 

meters” for details. 
 

Moving a discrete sample
point or background point 

information for the moved map will appear on the Mapping tab. See 
“Setting the mapping para

 
 Follow the steps below to move a discrete sample point or background 

point (if available). See “Specifying discrete sample points” or “Specifying a 
ackground point” for information about specifying points. 

. Select the sample point tool, background point tool, arrow tool or 
marker tool. 

2. Move the pointer over the point you want to move so that 

 

b

 

 

 
1

 
 

 
directional arrows shown below appear. 

  

 
 

tage coordinates appear in the 

 
 

Moving the ruler 

 
3. Drag the point to the desired location. 
 
 As you move the point, its new X and Y s

description bar. 
 
 If the point is a background point, its new location will appear on the 

Mapping tab the next time you use Experiment Setup in the Collect 
menu. See “Setting the mapping parameters” for details. 

Follow these steps to move a ruler displayed within the video pane (see 

 
. Select the ruler tool or arrow tool. 

2. 
wn below appear. 

 

“Displaying a ruler”): 

 

 

1
 
 

Move the pointer over the center of the ruler, between the 
endpoints, so that the directional arrows sho
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3. Drag the ruler to the desired location. 
 
 

Moving text annotation Follow these steps to move text annotation created with the text tool (s
“Adding text annotation”): 
 
1. Select the text tool or arrow too

ee 

l. 
 

 
 
 
2. If the text is not connected with a line, move the pointer over the 

beginning of the text so that the directional arrows shown below 
appear. If the text is connected with a line, move the pointer over 
the small box at the end of the line so that the arrows appear. 

 

  
 

As you move the text, any line that was drawn with the text is adjusted 

 
 owing you to edit the text if desired: 

 
3. Drag the text to the desired location. 
 
 

for the new text location. 
 
 
4. Release the mouse button. 

A box appears all
 

  
 
 
5. To keep the current text, click outside the box. To edit the text, 

type the desired changes and then click outside the box. 

line 
 

 

 

 
 While editing, you can press Enter on the keyboard to begin a new 

of text. If you want to delete the text annotation completely, delete the
text in the text box and then click outside the box.
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Moving a marker Follow these steps to move a marker you have added with the marker too
(see “Adding a marker”): 
 
1. Select the marker tool, arrow tool, sample point tool or backgro

point tool (if available). 
 
 

l 

und 

. Move the pointer over the marker you want to move so that the 

 

 

 

 

2
directional arrows shown below appear. 

 

  
 
 
3. Drag the marker to the desired location. 

 

Res
items in the Atlµs window

t 

 

Resizing a line map 

 
izing maps and other 

 
After you have drawn an item in the Atlµs window, you can use differen
palette tools to resize the item. The next sections explain how. 

 
Follow these steps to change the length or slope of a line map you have 
drawn with the line map tool (see “Drawing a line map”): 
  
1. Select the line map tool or arrow tool. 

 
 
 
2. Move the pointer over the map endpoint you want to move so that 

directional arrows shown below appear. 
 

  
 
 
3. Drag the endpoint to change the length and slope of the line as 

desired. 
 
 The next time you use Experiment Setup in the Collect menu, the 

information for the changed map will appear on the Mapping tab. See 
“Setting the mapping parameters” for details. 
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gth of 

e map must be adjusted for the step size specified on the Mapping tab of 
 e aperture size default). See 

Setting the data collection parameters for FT-IR and FT-Raman 
xperiments” or “Setting the data collection parameters for visible Raman 

 
  or example, if you used the mouse to specify a line map with a length of 

utomat ally adjusted to 110 micrometers so that the step size is divided 
venly into the map length. Map lengths always expand to compensate for 

mo

 
Resizing an area map or 

box drawn to specify a Mosaic 

Note When you release the mouse button, the changed map may vary from the 
line you specified by dragging the endpoint. This is because the len
th
the Experiment Setup dialog box (or to th
“
e
experiments” for more information. 

F
100 micrometers and the step size is set to 22 micrometers, the length is 

ica
e
step intervals; they are never less than the length you specified with the 

use. S 

 

Follow the steps below to resize an area map. You can also resize a box 
rawn to specify a sample area for capturing a Mosaic (see “Capturing a 
osaic of video images for a sample area”). 

want to move so that one of the directional arrow pointers shown 

d
M
 
1. Select the area map tool or arrow tool. 
 
 
2. Move the pointer over the side or corner of the map (or box) you 

 

 

below appears. 
 

  
 
 
3. Drag the side or corner until the map (or box) is the desired size 

The next time you use Experiment Setup in the Collect menu, the 

See “Setting the mapping parameters” for details. 
 

and shape. 
 
 

information for the resized area map will appear on the Mapping tab. 
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he size of the map must be 

justed for the step size specified on the Mapping tab of the Experiment 
u lt). See “Setting the data 

llection parameters for FT-IR and FT-Raman experiments” or “Setting 
e data collection parameters for visible Raman experiments” for more 

  or example, if you used the mouse to specify a new map area of 100 by 

and Y dimensions, the map area is automatically adjusted to 115 by 115 
micrometers so that the step size is divided evenly into the map area. Map 

 
Resizing a drawn aperture

Note When you release the mouse button, the resized map may vary from the 
area you specified by dragging. This is because t
ad
Set p dialog box (or to the aperture size defau
co
th
information. 
 
F
100 micrometers and the step size is set to 23 micrometers in both the X 

areas always expand to compensate for step intervals; they are never less 
than the area you specified with the mouse. S 

 

 Follow the steps below to resize an aperture you have drawn within the 
ideo pane. The drawn aperture remains symmetrical about the center 

i

information about adjusting that aperture. 

w appears. 

v

 

 

point. See “Drawing an aperture” for more information. 
 
Th s section does not apply to Continuµm microscopes with the automated 
Reflex aperture. See “Setting the automated Reflex aperture” for 

 
1. Select the aperture tool or arrow tool. 
 
 
2. Move the pointer over a side or corner of the drawn aperture so that 

one of the pairs of directional arrows shown belo
 

  
 

 
 Note Adjust the aperture installed in the microscope to match the size, shape and 

orientation of the drawn aperture before collecting data. S 

 
 

 
3. Drag the side or corner until the drawn aperture is the desired size 

and shape. 
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Resizing the ruler Follow the steps below to resize a ruler you have drawn with the ruler tool.
See “Displaying a ruler” for information about

 
 displaying a ruler. 

directional arrows appear to the right of the pointer. 

 

 
1. Select the ruler tool or arrow tool. 
 

 

 
 

. Move the pointer over the ruler endpoint you want to move so that 2

 

 
 
 
3. Drag the endpoint to change the length and slope of the ruler as 

If you are using the ruler tool, the new length of the ruler in 

Deleting maps and other 
items in the Atlµs window 

e s 
ou have drawn in the window. The next sections explain how to delete 
ach type of item. For information about deleting an entire map sequence, 

Deleting a line map 

desired. 
 
 

micrometers appears in the description bar. 
 
 
Th  Atlµs window tool palette gives you great flexibility in deleting item
y
e
see “Clearing a map sequence.” 

 
 

 

 

Follow these steps to delete a line map you have drawn with the line map 
ool (see “Drawing a line map”): 

.  the line map in the navigation pane or video pane. 

ap from the pop-up menu. 
 
 

t
 
1. Select the line map tool or arrow tool. 
 
 
2 Right-click
 
 
3. Choose Delete Object or Delete Line M
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Deleting an area map 

 

 

Follow these steps to delete an area map you have drawn with the area map
tool (see “Drawing an area

 
 map (or Mosaic)”): 

. 

. 

. 
 
 

Deleting

 
1. Select the area map tool or arrow tool
 
 
2. Right-click the area map in the navigation pane or video pane
 
 
3. Choose Delete Object or Delete Area Map from the pop-up menu

 a sample point 

 

 

Follow these steps to delete a sample point you have specified with the 
sample point tool (see “Specifying discrete sample points”): 

tool or arrow tool. 

 pane. 

he pop-up 
menu. 

Deleting a background point 

 
1. Select the sample point 
 
 
2. Right-click the sample point in the navigation pane or video
 
 
3. Choose Delete Object or Delete Sample Point from t

 
 

 

 

Follow these steps to delete a background point you have specified with the 
ackground point tool, if available (see “Specifying a background point”): 

. Select the background point tool or arrow tool. 

. Right-click the background point in the navigation pane or video 

. Choose Delete Object or Delete Background Point from the pop-
up menu. 

 
 

b
 
1
 
 
2

pane. 
 
 
3
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Deleting a drawn aperture Follow these steps to delete an aperture you have drawn with the aperture 
ool, if available (see “Drawing an aperture”): 

1. 
 
 

. Right-click the drawn aperture in the video pane. 

t

 

 

 
Select the aperture tool or arrow tool. 

2
 
 
3. Choose Delete Aperture or Delete Object from the pop-up menu. 

 
 

Deleting a ruler 

 

 

Follow these steps to delete a ruler you have drawn with the ruler tool (see
Displaying a ruler”): 

 

. Right-click the ruler in the navigation pane or video pane. 

. Choose Delete Object or Delete Ruler from the pop-up menu. 

 
Deleting text annotation 

“
 
1. Select the ruler tool or arrow tool. 
 
 
2
 
 
3
 

Follow these steps to delete text annotation you added with the text tool 
ee “Adding xt annotation”): 

. Select the text tool or arrow tool. 

 
te. 

 

 

(s  te

 

 

 
1
 

k the text annotation you want to dele2. Clic
 
 The text becomes highlighted in a box. Here is an example: 

 
 

. 

The text is deleted from the box. 

 

 
3 Press the Delete key on the keyboard. 
 
 
 
 
4. Click outside the box. 
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Deleting a marker F

 

 

ollow these steps to delete a marker you have added with the marker tool 
(see “Adding a marker”): 

ane or video pane. 

 
Deleting all the 

displayed markers 

 
1. Select the marker tool or arrow tool. 
 
 
2. Right-click the marker in the navigation p
 
 
3. Choose Delete Marker or Delete Object from the pop-up menu. 
 

Follow these steps to delete all the markers you

 

 have added with the marker 

 

avigation pane or video pane. 

. Choose Delete All Markers from the pop-up menu. 
 
 

Editing text annotation 

tool (see “Adding a marker”): 

1. Select the marker tool. 
 
 
2. Right-click anywhere in the n
 
 
3

Follow the steps below to edit text annotation created with the text tool or 
arrow tool (see “Adding text annotation”). 
 
1. Select the text tool or arrow tool. 
 
 
2. Click the text. 
 
 A box appears allowing you to edit the text: 
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3. Type the desired changes. 
 
 While editing, you can press Enter on the keyboard to begin a new line 

of text. You can change the size of the box by dragging its sides or 
corners. If you want to delete the text annotation completely, delete all 
the text in the text box. 

 
 
4. Click outside the box. 

Rota

 
 

ting a drawn aperture F
p

ollow the steps below to rotate an aperture you have drawn in the video 
ane (see “Drawing an aperture”). 

  

 

 
This section does not apply to Continuµm microscopes with the automated
Reflex aperture. See “Setting the automated Reflex aperture” for 
information about adjusting that aperture. 
 
1. Select the aperture tool or arrow tool. 
 
 
2. Move the pointer over a corner of the drawn aperture so that one of 

the pairs of directional arrows shown below appears. 
 

  
 
 
3. Drag the corner clockwise or counterclockwise until the drawn 

le. 
 

 to a maximum of 45 degrees of 
rotation. With this range of rotation plus the ability you have to resize a 
drawn aperture with the aperture tool or arrow tool (see “Resizing a 

bination of orientation and rectangular 
shape is possible. 

 
 Here is an example showing a drawn aperture that has been rotated: 
 

 

aperture is displayed at the desired ang
 
 You can drag in either direction up

drawn aperture”), any com
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 Note nd 
orientation of the drawn aperture before collecting data. S 

 
Setting the 

Mapping options 
Use
coll
 
• 
 
 ne. 

•  a border around text annotation in the Atlµs window. 
 Whether to focus the microscope automatically after each stage 

movement. 

 olor scheme to use for your contour map (or discrete point 
ca

• 
• The type of smoothing to use for the contour map. 
• ow to print map windows. 
 
The options used to specify these items are on the Mapping tab... 

Adjust the aperture installed in the microscope to match the size, shape a

 

 Options in the Edit menu to set several options that affect map data 
ection and the initial display of collected data in new map windows: 

Colors used to display annotation in the Atlµs window. 
A default step size for new map sequences. •

• Whether to connect text annotation in the Atlµs window with a li
Whether to show

•

• The items to display in the map window. 
The c•
lo tion map). 
The resolution for the contour map and 3-D image. 

H
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...and the Mapping - Display tab in the Options dialog box: 

 

 

 

 

 

 

 

The display options affect only new 
map windows created after future data 

collections. To change the way a map is 
displayed in an existing map window, 
use Display Setup in the View menu. 

 
Follow the steps below to set the options. The individual options on the 

apping tab and the Map Printing options on the Mapping - Display tab 
are explained in the next sections. The rest of the options on the Mapping - 
Display tab work the same as options in the Display Setup dialog box. 
Resolution applies to the 3-D image and the contour map. Smoothing 
applies to the contour map; it also selects the Smoothing check box on the 
3-D View tab of the Display Setup dialog box. 
 

ou can change the settings after data collection by using Display Setup in 
isplaying 

ap Data” chapter for complete information about these options. In 
MNIC Help Topics find “options” in the Index and go to “Customizing 

OMNIC by setting options” for information about the options on the 
other tabs. 
 
1. C oose Option
 
 tions di
 
 
2. Select the Map

M

Y
the View menu. See “Setting the display parameters” in the “D
M
O

h s from the Edit menu. 

The Op alog box appears. 

ping tab. 
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3 rs otation types shown in the Annotation 
Colors box. 

 
 To change a color for an annotation type, click the color to the right of 

e. The C  allowing 
you to select a color. If you need help using the features in this dialog 

the “ hen 
 are finished

 
To select the default colors for all the annotation types, click the 
Default button. 

• If you select Use Dimension Of __ Micrometers, type the desired 
default map step size in the text box. 

 

. Specify colo for the ann

the typ olor dialog box (a Windows feature) appears

box, click ?” button and then click the feature of interest. W
you
appears to the right of the annotation type. 

 selecting a color, choose OK. The selected color 

 

 
 

. Select the desired default step size option in the Default Step Size 4
box. 

 
• If you select Use Dimension (In Micrometers) Of Aperture Drawn, 

the default map step size will match the length of the shorter side of 
the current drawn aperture (if present). 

 

 
 
5. If you want text annotation you create with the text tool to be 

connected to the annotated item with a line, select Connect Text 
Annotation With Lines in the Display Options box. 

 
 
6. If you want text annotation you create with the text tool to have a

border, select Show Text With Border in the Display Options box. 
 
 
7. If you want the microscope focused automatically whenever you 

move the stage along the X-axis or Y-axis, select Focus After Each 
Stage Movement in the Focus During Stage Movement box. 
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8. Select the Mapping - Display tab and set the options as desired. 
 
 The Resolution parameter affects the contour map and the 3-D image. 

The Smoothing parameter affects the contour map. See “Setting the 
display parameters” in the “Displaying Map Data” chapter if you need 
help. This step is optional; you will be able to use Display Setup in the 

Any annotation that is displayed or that you create is displayed in the 

Specifying annotation colors  

View menu to set the map display parameters after data collection. 
 
 
9. Choose OK. 
 
 

selected colors. 
 
 
 The features in the Annotation Colors box let you specify colors for

displaying different types of annotation in the Atlµs window. Changing the 
color of annotation can make it easier to see against a similarly colored 
sample. 
 
Initially the currently selected colors appear to the right of the listed 
annotation types. Here is an example: 

 

 
 
The following table describes the available annotation types: 
 
 

Annotation Type Description 

Map
 

Line maps, area maps and discrete sample points 
(including those in an ordered array) in the navigation 
and video panes. 

Aperture The box representing the automated Reflex aperture 
and a drawn aperture in the video pane. This feature 
does not apply to Nicolet Almega systems. 
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Annotation Type Description 

Background Background points in the navigation and video panes. 
This feature does not apply to Nicolet Almega systems.

Markers Markers in the navigation and video panes. 

Cross Hairs Cross hairs in the navigation and video panes. 

Ruler A ruler drawn in the navigation and video panes. 

Text Text annotation in the navigation and video panes. 

 
 
See the procedure in the preceding section for instructions for changing
colors of these annotation types. 

 the 

 

 
You can click the Default button to return all the selected colors to the 

Your annotation color settings take effect when you choose OK to close the 
Options dialog box and are retained when you exit and restart OMNIC 

tlµs. 

 
Specifying a default step size 

default colors. 
 

A
 

 

The options in the Default Step Size box let you specify the default step size
(dis
Mapping tab of the Experiment Setup dialog box or the palette tools. Select 

se Dimension (In Micrometers) Of Aperture Drawn to specify a default 
ep size that matches the length of the shorter side of the current drawn 

Connecting text 
annotation with a line 

tance between adjacent sample points) for maps you define using the 

U
st
aperture (if you have created one). Select Use Dimension Of __ 
Micrometers if you want to enter a value in micrometers in the text box. 
Use this option if you have a Nicolet Almega system. 
 
 
If you want text annotation you create in the navigation pane or video p
with the text tool to be

ane 
 connected to the annotated item with a line, select 

onnect Text Annotation With Lines in the Display Options box. 

 

C
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Displa
a

ying a border 
round text annotation 

If you want a border displayed around text annotation, select Show Text 
With Border. Here is an example: 

  
 

 
 

Focusing after 
each stage movement 

If you want the microscope focused automatically whenever you move the 
stage along the X-axis or Y-axis, select Focus After Each Stage Movement in
the Focus During Stage Movement box. You will be able to use autofocus 
when capturing a Mosaic with Capture Mosaic in the Atlµs menu.  

 

S

 
 

pecifying how to 
print map windows 

Use the options in the Map Printing box to specify how to print m
windows: 
 
Select Preserve Proportion if you want panes printed with the same 
proportion of height and width as is displayed in the window. If this optio
is not selected, the panes’ proportions may be adjusted to fit the paper 
better. 
 
Use Print Each Pane On A Separate Page to specify whether to print pane
on separate pages or on the same page. If you select Print Each Pane On A
Separate Page, use Print Page Numbers to specify whether to print page 

umbers on the pages. 

 

ap 

n 

s 
 

 

n
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Clearing a 
map sequence  from the Atlµs 

indow. All map sequence settings are also cleared from the Mapping tab 
collection 

arameters for FT-IR and FT-Raman experiments” or “Setting the data 
oll ents” for more 
formation). 

 
 Note If you have a Continuµm microscope with the automated Reflex aperture 

system, the box representing the Reflex aperture is not cleared. S 

 
 You can also use the arrow tool to clear a map sequence. Simply right-click 

ywhere in the navigation pane or video pane, and then choose Clear 
equence from the pop-menu. S 

 

Choose Clear Map Sequence from the Edit menu to remove the current 
map sequence and any drawn aperture or text annotation
w
of the Experiment Setup dialog box (see “Setting the data 
p
c ection parameters for visible Raman experim
in

 

Note 
an
S

 
 Clearing a map sequence 

 
clear operation with Restore Map Sequence in the Edit menu. See 

ared map sequence” for details. 

 If you have collected a background spectrum using a material other 
und point and then move the 

 
 

Restoring a 
cleared map sequence 

If you have used Clear Map Sequence in the Edit menu to remove a map 

you can choose Restore Map Sequence from the menu to restore the 
sequence and its annotation. The settings on the Mapping tab of the 
Experiment Setup dialog box are also restored when you use Restore Map 
Sequence. See “Clearing a map sequence” for information about using 
Clear Map Sequence. 
 
 

 

If you have not yet defined a new map sequence, you can undo the 

“Restoring a cle
 

than your sample, clear the backgro
sample into position and define the map. As long as you do not define 
a new background point for the map, the last background collected will 
be used to ratio the map spectra. 

sequence from the Atlµs window and have not yet defined a new sequence, 
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Saving a 
map sequence 

a t 
map
Sav
Exp
sele
cho
Setu
topic for more information. If you are using OMNIC For Raman, choose 
Ram
command” in the Index and go to the “Setting the experiment parameters” 
top
 
 

Setting the 
data collection 
parameters for 

FT-IR and FT-Raman 
experiments 

Use Experiment Setup in the Collect menu to set parameters that 
etermine how a map is collected. This section covers only those 

info
cho
Setup command” in the Index and go to the “Using Experiment Setup” 
opic. If you are using OMNIC For Raman, choose Raman Help Topics 

and go to the “Setting the experiment parameters” topic. See “Setting the 
data
Nic
 

our settings determine the current map sequence. To save your settings in 
an experiment file that you can open later, use the Save As button in the 

ore 

M p sequence settings are saved in experiment files. To save the curren
 sequence and the other current experiment parameter settings, use the 

e As button in the Experiment Setup dialog box (available through 
eriment Setup in the Collect menu). Make sure the Map check box is 
cted in the Save Experiment As dialog box. If you are using OMNIC, 
ose OMNIC Help Topics from the Help menu, find “Experiment 
p command” in the Index and go to the “Using Experiment Setup” 

an Help Topics from the Raman menu, find “Experiment Setup 

ic. 

d
parameters with special importance to map data collection. Complete 

rmation about the rest is available on-line. If you are using OMNIC, 
ose OMNIC Help Topics from the Help menu, find “Experiment 

t
from the Raman menu, find “Experiment Setup command” in the Index 

 collection parameters for visible Raman experiments” if you have a 
olet Almega system. 

Y

Experiment Setup dialog box. See “Saving a map sequence” for m
information. 
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Follow the general steps below to set the data collection parameters. The 
next sections explain the individual parameters in detail. 
 
1. Choose Experiment Setup from the Collect menu. 

 
 
 
 
 
 
 

This dialog box has a slightly different 
appearance if you are collecting Raman data. 

 
 The Experiment Setup dialog box appears: 
 

 
 
 
2. Set the parameters as desired. 
 
 To display a set of parameters, click the appropriate tab. 

K. 

 

 
 
3. Choose O

 
 Setting the data collection parameters 

 
  When you set up map data collection, keep in mind that using a lower 

resolution (setting Resolution on the Collect tab to a higher number) 
 

er 
increases the signal-to-noise ratio (SNR) of the data and may reduce the
collection time. This can be an advantage over increasing the numb
of scans to improve the SNR. 
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  When using the linear array detector, you should normally set the 
resolution to approximately 4 cm-1 (with Aperture set to 150). This will 
allow full illumination of the array detector and provide more uniform
images. To avoid und

 
erfilling the linear array detector, do not set the 

resolution to a numerical value less than 1 cm-1 (with Aperture set to 
34). To obtain images with the full detector array (28 elements), use a 

than 

olutions greater than 4 cm-1 it is therefore 
necessary to limit the number of elements in the array that are used to 
collect the image. You can adjust this by using the Linear Array Setup 

n, available th ollect button on the Mapping tab of the 

 

  When using the linear array detector within the spectral range 0 to 
 sa an 2.5 

cm/second. Within  a sample 
spacing of 1, set Velocity no higher than 1.2. 

 

 ure tting 
them is a good way to keep a record of the aperture used for the 
experiment even if you are not using the aperture size to specify the step 

. Yo hen you 
ata. 

 
 

Saving 
interferograms 

with the map 

I nt interferogra
Interferograms on the Collect tab. The interferograms will be saved in one 
file whose name matches the file name of the map, except _IFG is added 
before the extension. For example, the interferograms for a map whose file 
n  POLY.MAP w
 
Saving interferograms is necessary if you want to be able to reprocess the 

ap later. See “Reprocessing a map” in the “Processing and Analyzing Map 
ata” chapter for more information. 

Background handling 
when to collect a background or select a stored background to be 

sed for ratioing map sample spectra. You can also specify the number of 
ackground scans to collect. 

resolution in the range 16 to 4 cm-1. To achieve resolutions better 
4 cm-1, it is necessary to use an aperture size that may underfill the 
linear array detector. At res

butto rough the C
Experiment Setup dialog box. See “Setting special mapping options” 
for details. 

7899 cm-1 with a mple spacing of 2, set Velocity no higher th
 the range 15798 to 7900 cm-1 and with

 Since the Apert parameters are saved with the map sequence, se

size for the map
view the map d

u will be able to refer to the settings later w

f you wa ms to be saved with the map, select Save 

ame is ould be saved in a file named POLY_IFG.MAP. 

m
D
 
 
The options in the Background Handling box on the Collect tab let you 
specify 
u
b
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hese 

elect Collect Background Before Every Sample if you want to collect a 

he Collect Background After __ Minutes option prompts you to collect a 
desired 

ollect a background 

o use a stored background, select Use Specified Background File. Type 

o 
ackground while this option is selected.   

 Note 
Collect menu and then save the background spectrum using Save in the 
File menu. S 

 
If the selected background is not adequate for the map you are collecting 
( e of a 
prompted to 
 
Typically the same number of scans are collected for both background and 
sample spectra. To improve the signal-to-noise ratio, you can collect a 
larger number of background scans by selecting Collect __ Scans For The 
Background and typing the desired number in the text box. When this 

llection. 

 

Note If you are collecting Raman data, the Reference Handling features appear 
instead of the Background Handling features. For information about t
features, skip this section, find “reference” in the Index of Raman Help 
Topics and go to the “Reference handling” topic. S 

 
S
background before collecting each map spectrum. 
 
Select Collect Background After Every Sample if you want to collect a 
background after collecting each map spectrum. 
 
T
background after the specified number of minutes. Type the 
number of minutes in the box to the left of Minutes. You can use the 
Collect options (available through Options in the Edit menu) to specify 
how you will be prompted. (You will be prompted to c
the very first time you collect a map.) This option is useful when you use 
the same material (such as a gold mirror) for all of your background 
collections and don’t need to collect a new background for each map. 
 
T
the name of the background file you want to use in the box next to Browse, 
or use the Browse button to select a background. This background will be 
used when collected map sample spectra are ratioed. You will not be able t
ollect a new bc

 
To store a background on a disk manually, use Collect Background in the 

becaus difference in resolution or data spacing), you will be 
collect a new background. 

option is selected, the Number Of Scans parameter affects only sample data 
co
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Setti

” if you 

Specifying the 
sample location 

and collection mode 
scribed in the following table (only the settings that are appropriate for 
ur system will be available). 

ng the gain Set Gain on the Bench tab to control the amplification of the detector 
signal. Autogain is often a good choice. In OMNIC Help Topics or Raman 
Help Topics find “gain” in the Index and go to “Setting the gain
need more information. 
 
 
Set Sample Compartment on the Bench tab to an appropriate setting 

ed
yo
 
 

Setting Description 

Right µScope; %T
 

Transmission experiment perf
microscope installed to the right of the 

ormed with the 

spectrometer. 

Right µScope; %R Reflection experiment performed with the 
microscope installed to the right of the 
spectrometer. 

Left µScope; %T Transmission experiment performed with the 
microscope installed to the left of the 
spectrometer. 

Left µScope; %R Reflection experiment performed with the 
microscope installed to the left of the 
spectrometer. 

Raman Raman experiment performed with an FT-Raman 
View Stage in a Nicolet Nexus FT-Raman 
module. 

Main Raman experiment performed with an FT-Raman 
View Stage in either a Raman 960 spectrometer or 
Magna-IR™ FT-Raman module. 

 
 
In OMNIC Help Topics find “beam path” in the Index and go to 
“Specifying the sample location” if you need more information. In Raman 
Help Topics find “beam path” in the Index and go to “Specifying the beam 
path.” 
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Specifying the 
frequency range sett

OMNIC Help Topics or Raman Help Topics find “spectral range” in the 
dex and go to “Specifying the spectral range” if you need more 

 

Specifying the detector 
for the Continuµm XL 

yo  an 
a

Ben
Ben

 Note o 

See

e IR 
and FT-Raman experiments” for information about setting the resolution 
for the linear array detector. 
 
 

Setting the beam path 
for the Continuµm XL 

If you have a Continuµm XL microscope, use Scope Aperture on the Bench 
tab 
are 
 
 

Specify the frequency range (X-axis limits) of the data you want to save by 
ing Max Range Limit and Min Range Limit on the Bench tab. In 

In
information. 

 
If u have a Continuµm XL microscope and are preparing to perform
im ging experiment using the linear array detector, set Detector on the 

ch tab to XL Array. This automatically sets Scope Aperture on the 
ch tab to Imaging (see the next section). 

 
D not use the linear array detector for ATR experiments. S 

 
 “Setting special mapping options” for information about specifying the 

elements of the linear array to use for data collection. 
 
Se  the Tips at the end of “Setting the data collection parameters for FT-

to specify the beam path for your experiment. The following settings 
available: 

Setting Description 

gle 
 

Uses the aperture before the sample (Target™ aperture) and 
the single-point detector. 

Sin

Du  (Reflex aperture) 
and the single-point detector. 

al Uses apertures before and after the sample

Im
s 

r imaging. This setting is selected 
automatically when you set Detector on the Bench tab to 

aging Uses the imaging beam path. The “Aperture mode” lights 
on the microscope front panel are off, because the aperture
are not applicable fo

XL Array (see the preceding section). 
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Setting the 
Mapping parameters 

Afte
“Specifying a map sequence” for details), you can use the parameters on the 
Ma
specifications and specify a profile type. Here is an example showing the 
par

 

r you have specified a map using the Atlµs window palette tools (see 

pping tab of the Experiment Setup dialog box to refine your 

ameters set for collecting a map: 

 
 
If you change a setting, the change is reflected in the map drawn in the
Atlµs window when you choose Apply (if available) or choose

 
 OK to close 

e Experiment Setup dialog box. 

Setting the
Dimensions parameters 

th
 
The next sections explain how to set the parameters. 
 
 

 The Dimensions parameters determine where and how map spectra will be
collected. 
 
The Collection Type readout shows the type of map you have specified 

ith the Atlµs window palette tools (a line map

 

, an area map or discrete 

 

w
points). The special parameters for each map type are discussed below. 
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• If you specified a line map, the Step Size (µm) text box in the X column 
(the Y column is not available) shows the distance in micrometers 
between consecutive sample points. 

• If you specified an area map, the Step Size (µm) text box in the X 
column shows the distance in micrometers between the columns of 
sample points in the map. The Step Size (µm) text box in the Y column 
shows the distance in micrometers between the rows of sample points. 

 
 The Number Of Points text box in the X column shows the number of 

columns of points in the map. The Number Of Points text box in the Y 
column shows the number of rows of points. 

 
• If you specified discrete points, the Number Of Points box shows the 

number of sample points. 
 

ze 
perture size to 

ensure that spectra are obtained over the entire mapping region. You 
may also want to “over-step” your map to obtain a smoother profile. 

his, use a step size that is smaller than the aperture size. 
 

oints of the map, respectively. The X value of the end position 

 

hat 

 
 The Number Of Points text box shows the number of sample points in 

the map. 
 

When specifying the step size, it is important to keep the aperture si
in mind. You may wish to set the step size equal to the a

To do t

If Advanced Mapping Options (available only for line maps and area 
maps) is selected, the Start Position and End Position text boxes 
appear. They show the X and Y position values of the first and last 
sample p
should be greater than that of the start position (that is, to the right of 
the start position in the navigation or video pane). 
 
If you change a value in one of the text boxes in the Dimensions box
and then choose Apply (if available) or OK, the values in the other text 
boxes are adjusted as needed to reflect the change you made and to 
allow even spacing of points. 
 
Estimates of the total collection time and the amount of disk space t
will be needed to store the spectra appear at the bottom of the 
Dimensions box when you choose Apply. 
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You should generally try to minimize the time needed to collect a map. 

al-to-
 spatial 

 best 

 of 

 Note 

Setting the 
Background parameters 

Decreasing the number of scans, decreasing the spectral resolution (for 
example, changing from 4 wavenumbers to 8 wavenumbers) and 
increasing the step size can all reduce the total collection time. (The 
Resolution parameter is on the Collect tab.) Conversely, the number of 
scans and the aperture size should be large enough to give high sign
noise values, and the step size should not be so large as to sacrifice
resolution. Use the combination of settings that provides the
compromise for your experiment. 
 
Click the Default button if you want to set the step sizes and number
points to zero and set the background point to undefined. 
 

If you specify an ordered array of discrete points, you enter the step size 
and number of points just after drawing the array. See “Specifying an 
ordered array of discrete points” for details. S 

 
 

 

The Background parameters determine where the map background 

the background point tool, the X and Y position values of the point appear 
in the Background Point (µm) text boxes, in that order. You can specify 

e text boxes. 

If you have selected Use Specified Background File on the Collect tab, the 

han
 
 

Setting the Profile parameters 

spectrum will be collected. If you have specified a background point with 

new values by typing in th
 

Background Point (µm) text boxes are not available. See “Background 
dling” for information about using a stored background. 

 

The Profile parameters (available only for area maps) let you specify a 
profile before data collection. The term “profile” is used to refer to any of 
the ways of representing map data described in the table in the “Creating a 
profile” section in the “Processing and Analyzing Map Data” chapter. See 
that section for details on the available profile types, including the 
information you need to enter for each. If you don’t specify a profile type, 
the default profile will be used:  Chemigram. For the profile types that use 
two peaks, “Peak 2” is the ratio denominator. 
 

 Note Specifying the profile type before data collection is entirely optional. After 
you collect the map, you will be able to use Profile Setup in the Atlµs menu 
to create profiles. S 
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 Note onal Group and Correlation Map profile types are not available 

Setting special mapping options 

The Functi
before data collection. S 

 
 
Use the Collect button on the Mapping tab to display and select the specia
mapping options shown below and to set up the linear array. 
 

l 

 

 
 
The following table shows what you can specify with each option. The 
Linear Array Setup button is explained later in this section. 
 
 

Option Description 

Save Video Frames In Map File 
 

elect this option if you want the video frames for maps saved in the map 

adequate 
isk space. 

nts, 
n 

saved. See “Capturing and 
ving the video image for sample points” for details. 

S
file. Since map files are much larger when they include stored video 
information, you should save the video frames only if you have 
d

If you have specified discrete sample points or an ordered array of poi
you can use the sample point tool to specify that the video image for a
individual sample point not be captured and 
sa

Store Map With Relative 
Coordinates 

elect this option if you want relative coordinates used instead of actual 
stage positions as grid references for the spectral data when the contour 
map (or discrete point location map) is displayed. When relative 
coordinates are used, the first point collected (the start point) becomes 
0,0. Relative coordinates are useful when you are running a similar sample 
repeatedly, but its position relative to the stage is changing. This option 
lets you directly compare these samples. 

S
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Option Description 

ct this option if you want the system to pause after each sample Auto-Pause Before Each Spectrum Sele

oint. This is useful when you are collecting ATR data and need to release 

next spectrum is collected. Pausing is also useful when the sample is 
neven, requiring you to refocus at some of the sample points. 

spectrum is collected and again after the stage is moved to the next sample 
p
contact after a spectrum is collected and reestablish contact before the 

u

Prompt Before Collecting Data elect this option if you want the software to display a prompt 
pectrum. This option is 

seful if you want to save the video frames without an aperture in place 
ut n. This option is also 
seful if you need to change the focus before starting sample collection 
hen background collection is finished. In addition, if your microscope 

 save the video frames, you must select this option so that you can flip 

Fol

1. 

2. 

. Initiate map data collection with Collect Map. 

S
immediately before collecting the first map s
u
b  need to use an aperture during data collectio
u
w
does not have automated mirrors controlled by the software and you want 
to
the mirrors manually before the first spectrum is collected. 

low these steps to use this option: 

Set up the mapping experiment with the aperture in place. Select the 
Save Video Frames In Map File option. 

Remove the aperture. 

3

4. When the prompt appears, install the aperture (and manually flip the 
microscope mirrors if they are not automated) and then choose OK. 
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Option Description 

anges the map collection ranges to match the linear array configuration
cified with the Linear Array Setup button (explained below). 

Use Linear Array Detector For 
Map Setup 

Ch  
spe

This option also displays in the navigation pane a background cursor that 
ows the size and shape of the linear array configuration, with the 

ackground area inside the box. Here is an example: 
sh
b

 

 
 

This lets you position the background point so that the area of the linear 
arra

his option is available only if your system can perform linear array 

y does not overlap the area where you will collect sample data. 

T
collections. 

Colle
At One Location e linear array 

ositions shown with the background cursor (displayed by Use Linear 
Array Detector For Map Setup). The additional stage movement increases 
the collection time. This option is available only if your system can 
perform linear array collections. 

ct Linear Array Background When the background is collected, the background point (shown in the 
center of the box) is moved under each detector element in th
instead of collecting the background at all of the detector element 
p

Sound Tone At End Of Collection Emits a tone when map data collection is finished. 

 
 
If your system can perform linear array collections, use the Linear Array 
Setup button to specify the elements to use for data collection. 

ou can also specify that oversampling be used to improve spatial 
resolution. Oversampling has several advantages over using hardware 
enhancements to achieve this improvement: 
 
• There is no need for multiple optics or detectors. 
 

 

 
Y
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• Each detector element views a sample area that is independent of 
resolution. Therefore, unlike with hardware enhancements, the signal-
to-noise ratio remains high. 

 
• Since it is controlled through software rather than hardware, the degree 

am stable. 
 
Follow these steps to set up the linear array: 
 
1  the 
 
 ea
 
 
2. Specify the range of linear array elements to use for data collection. 
 
 The array has two parallel columns of 14 elements each. The elements 

in each col
performed
columns that you specify in the next step. Also, if you select Use Linear 
Array Detector For Map Setup in the Collect dialog box (explained 
earlier in this section), the size and shape of the rectangular background 

list 

 
ults in improved 

spatial resolution. 

of overs pling is adju

. Click Linear Array Setup button. 

The Lin r Array Setup dialog box appears. 

umn are numbered 1 through 14. Data collection will be 
 using the specified range of elements in the column or 

cursor is determined by the elements you have specified. 
 
 Select the first element to use from the first drop-down list box and the 

last element to use from the second drop down list box. To use just one 
element per column, select the same number from both drop-down 
boxes. 

 
 
3. Specify the amount of oversampling to use by setting 

Oversampling. 
 
 Normally (with Oversampling set to None) the system moves the 

sample the full width of an array element before collecting data at the 
next position for a map. This results in no overlap of measured sample 
areas. When you collect data with oversampling, the system uses
partially overlapped sample areas. This overlap res
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 For example, if you set Oversampling to 4X, the system will 
“subdivide” the element area into a grid of four equal parts and move 
the sample to center it on each of these parts before collecting data in
that position. As a result, any point on the mapped sample area is 
sampled four times. 

 

te 

 Note ou may need to use only one column if your sample alignment does not 
niformly illuminate both columns. This may more likely occur in 

reflection mode and result in vertical stripes in the image. S 

 
 
5. Choose OK. 

 
When you are finished using the Collect dialog box, choose OK. 

 
 

Specifying the 
automated Reflex aperture 

 
 
4. Specify the column or columns to use by selecting the appropria

option button. 
 
Y
u

 
 

Use the Aperture button on the Mapping tab to specify the size, shape and 
orientation of the automated Reflex aperture on a Continuµm microscope. 

hen you click the button, the Aperture dialog box appears: 

 

 

The rectangular aperture 
settings in this dialog box are linked 
to those in the dialog box displayed 

by Aperture Dimensions from the Atlµs 
menu. See “Setting the automated Reflex 

aperture numerically” for more information. 

W
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To specify the aperture, select Rectangular. The aperture parameters 
ecome available. The following table describes the parameters. If you are 
ot using a Reflex aperture, select None if it is not already selected. 

b
n
 
 

Parameter Description 

X (µm)
 

The X dimension of the aperture in micrometers, before 
any rotation. 

Y (µm) The Y dimension of the aperture in micrometers, before 
any rotation. 

Angle (°) The angle by which the aperture is rotated about the map 
center point within the plane of the sample. An angle of 0 

rientation and rectangular 

positions the aperture with its X dimension parallel to the 
X-axis. You can rotate the aperture from 45 to -45 degrees 
(a negative angle rotates the aperture clockwise). With this 
range of rotation plus the ability to specify the size of the 
aperture, any combination of o
shape is possible. 

 
 
When you are finished setting the aperture parameters, choose OK. 
 

 Important perture 
 

y using the Aperture button in the System Configuration 

Configuring the System” chapter for details. Follow these precautions:  If 
ption, remove the 
ning on the power. 

fter the microscope has initialized, reinstall the nosepiece. S 

 Note The minimum size of the automated Reflex aperture is nominally 10 by 10 
micrometers. If you attempt to set the aperture to this or a smaller size, the 
system will automatically adjust the aperture to the minimum size possible 
on your microscope (typically 8 by 8 micrometers). The minimum 
available size varies slightly from system to system. S 

 
For more information about the Reflex aperture, see the documentation 
that came with your microscope. 
 

Use only the software to adjust the aperture; do not use the Reflex a
control knobs on the microscope. If you do adjust the knobs, you can reset
the aperture b
dialog box. See “Initializing the automated Reflex aperture” in the 
“
the microscope has a motorized stage or the autofocus o
nosepiece and lower the condenser all the way before tur
A
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 plained 
 use Set 

t 
x 

Setting the focus parameters 

Note You can also adjust the aperture graphically in the video pane as ex
in “Adjusting the automated Reflex aperture graphically.” You can
Aperture To Default in the Atlµs menu to set the aperture to its defaul
size, shape and orientation as explained in “Setting the automated Refle
aperture to the default.” S 

 
 
Use the Focus button on the Mapping tab to display and set the focus 
ptions shown below. They control whether and how the microscope is o

 focused automatically during data collection. 

 

 
 

 Note he Focus button is available only if your microscope has the required 
d appropriate for your hardware 

nf

T
har ware. Only the options that are 
co iguration are available. S 
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The following table shows the effect of each option. 
 
 

Selecting this option… Has this effect… 

he microscope is nDo Not Focus During Map 
Collection 

ot focused during map collection. T

Use Stored Focus Locations 
(Discrete Points Only) 

The microscope is focused at the discrete point locations you specified 
(including those in an ordered array). Select this option only if you are 
collecting data at discrete points rather than a line map or area map. 

You can specify the focus location (Z position) for a discrete sample point. 
See “Setting the Z position for a discrete point to the current Z position” 
for more information. 

If you have a Centaurµs microscope with an XL stage with motorized Z-
axis movement, use only the stage controller or focus buttons in the Atlµs 
window to adjust the focus when using this option. The stage coarse and 
fine focus knobs do not update the Z value. 

Autofocus At Each Map Point (All 
Map Types) 

The microscope is focused at each location where data is collected. You 
can use this option for any type of data collection. 

Auto ATR Contact The microscope automatically makes and releases contact with the sample 
at each sample point. 

Contact is not made automatically for the background collection. 

See “Using auto ATR contact” in the “Collecting Data” chapter for more 
information. 

 
 
When you are finished setting the options, choose OK. 
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S

parameters for visible 
Raman experiments 

plete 

xperiment Setup command” in the 
dex and go to the “Using Experiment Setup” topic. See “Setting the data 

FT-Raman experiments” if you have 
 FT-IR or FT-Raman system. 

 in 

Saving a map sequence” for more 
formation. 

ollow the general steps below to set the data collection parameters. The 
ext sections explain the individual parameters in detail. 

e Experiment Setup from the Collect menu. 

 

etting the 
data collection 

Use Experiment Setup in the Collect menu to set parameters that 
determine how a map is collected. This section covers only those 
parameters with special importance to map data collection. Com
information about the rest is available on-line. Choose OMNIC Help 
Topics from the Help menu, find “E
In
collection parameters for FT-IR and 
na

 
Your settings determine the current map sequence. To save your settings
an experiment file that you can open later, use the Save As button in the 
Experiment Setup dialog box. See “
in
 
F
n
 
1. Choos
 
 The Experiment Setup dialog box appears: 
 

 
 
 
2. Set the parameters as desired. 
 
 To display a set of parameters, click the appropriate tab. 
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3. Choose OK. 

 
  Se ing the data collection parameters 

 
When you set up map data collection, keep in mind that using a low
resolution increases the signal-to-noise ratio (SNR) of the data and may 
reduce the collection time. This can be an advantage over increasing the

tt

 er 

 
number of scans to improve the SNR. 

 
 

Specifying the 
sample location 

Specify the sample location by selecting Microscope in the Beam 
ath/Sample Position box on the Bench tab. 

 
Specifying the 
spectral range 

Specify the spectral range (X-axis limits) of the data to save by setting 
Spe
ran
mo
 
 

P

 

ctral Range on the Bench tab. In OMNIC Help Topics find “spectral 
ge” in the Index and go to “Specifying the spectral range” if you need 
re information. 
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Setting the 
Mapping parameters 

Afte
“Sp eters on the 
Mapping tab of the Experiment Setup dialog box to refine your 

r you have specified a map using the Atlµs window palette tools (see 
ecifying a map sequence” for details), you can use the param

specifications and specify a profile type. Here is an example showing the 
parameters set for collecting a map: 

 

 
 
If you change a setting, the change is reflected in the map drawn in the 
Atlµs window when you choose Apply (if available) or choose OK to close 

e Experiment Setup dialog box. 

 
Setting the 

Dimensions parameters 

th
 
The next sections explain how to set the parameters. 
 

 

The Dimensions parameters determine where and how map spectra will be 
collected. 
 
The Collection Type readout shows the type of map that will be collected. 
The special parameters for each of these types are discussed below; the 
parameters for specifying a depth profile are discussed under “Specifying a 
depth profile.” 
 
• If you specified a line map, the Step Size (µm) text box in the X column 

(the Y column is not available) shows the distance in micrometers 
between consecutive sample points. 
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 The Number Of Points text box shows the number of sample points
the map. 

If you specified an area map, the Step Siz

 in 

 
• e (µm) text box in the X 

column shows the distance in micrometers between the columns of 

ts text box in the Y 
column shows the number of rows of points. 

• ts, the Number Of Points box shows the 
number of sample points. 

s 

 in the 

nge a value in one of the text boxes in the Dimensions box 
and then choose Apply (if available) or OK, the values in the other text 
boxes are adjusted as needed to reflect the change you made and to 
allow even spacing of points. 
 
Estimates of the total collection time and the amount of disk space that 
will be needed to store the spectra appear at the bottom of the 
Dimensions box when you choose Apply. 
 
You should generally try to minimize the time needed to collect a map. 
Decreasing the number of exposures, decreasing the spectral resolution 
(for example, changing from 4 wavenumbers to 8 wavenumbers) and 
increasing the step size can all reduce the total collection time. (The 
Resolution parameter is on the Collect tab.) Conversely, the number of 
exposures should be large enough to give high signal-to-noise values, and 
the step size should not be so large as to sacrifice spatial resolution. Use 
the combination of settings that provides the best compromise for your 
experiment. 

sample points in the map. The Step Size (µm) text box in the Y column 
shows the distance in micrometers between the rows of sample points. 

 
 The Number Of Points text box in the X column shows the number of 

columns of points in the map. The Number Of Poin

 
If you specified discrete poin

 
If Advanced Mapping Options (available only for line maps, area map
and depth profiles) is selected, the Start Position and End Position text 
boxes appear. For a line map or area map they show the X and Y 
position values of the first and last sample points of the map, 
respectively. The X value of the end position should be greater than 
that of the start position (that is, to the right of the start position
navigation or video pane). 
 
If you cha
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Click the Default button if you want to set the step sizes and number o
points to zero and set the background point to undefined. 
 
ou specify an ordered array of discrete points, you enter the step size 

f 

 Note If y
and number of points just after drawing the array. See “Specifying an 

dered array of discrete points” for details. S 

 
 
Specifying a depth profile 
 
There are two kinds of depth profile: 
 
A line depth profile contains spectra collected at evenly spaced points 

ranged in a vertical column within the sample. This is simila o a line 
ap that has been rotated to a vertical orientation. 

n  
series of evenly spaced vertical columns within the sample. This is similar to 
an area map that has been rotated to lie within a vertical plane. 

offset, both of these profile types may include spectra collected above the 
sam

xp

 Note 
S 

or

ar r t
m
 
A area depth profile contains spectra collected at evenly spaced points in a

 
Depending on the current stage position and whether you specify a Z 

ple or at its surface. 
 
Specify the number and location of sample points for a depth profile as 

lained below. e
 
The Depth Profile check box is not available if more than one discrete 
sample point has been specified in the Atlµs window. 
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• To specify a line depth profile, use the sample point tool to click th
desired l

 e 
ocation in the navigation pane or video pane before choosing 

Experiment Setup. When you display the Mapping tab and select 
Depth Profile, these parameters appear: 

 

  
 
 Type the desired step size in the Step Size (µm) in the Z column. This 

that the first sample spectrum will be collected. This is useful when you 

determines the distance between the sample points. 
 
 Type the desired number of sample points in the Number Of Points 

text box in the Z column. 
 
 If you have selected Use Z Offset in the Focus dialog box (see “Setting 

the focus parameters”), type the desired Z offset in the Z Offset text 
box. This determines the vertical distance from the current Z position 

want to collect some of the data above the sample surface. Enter a 
positive value to collect the first spectrum above the current position. 
Enter a negative value to collect the spectrum below the current 
position. Enter 0 to collect the spectrum at the current Z position. The 
current Z position is displayed in the description bar in the Atlµs 
window. 
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• To specify an area depth profile, use the line map tool to draw a line in 
the desired location in the navigation pane or video pane and then 
choose Experiment Setup. (If you prefer not to draw a line, you can just 
enter endpoint coordinates on the Mapping tab.) When you display the 
Mapping tab and select Depth Profile, these parameters appear: 

 

  
 
 Type the desired horizontal step size in micrometers in the Step Size 

Type the desired vertical step size in micrometers in the Step Size (µm) 
 in the Z column. This determines the distance between the 

 
ts text box in the X column. 

 

(µm) text box in the X column. This determines the distance between 
the vertical columns of points. 

 
 

text box
horizontal rows of points. 

 
 Type the desired number of vertical columns of points in the Number

Of Poin

 Type the desired number of horizontal rows of points in the Number 
Of Points text box in the X column. 
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 If you select Advanced Mapping Options, additional parameters 
appear: 

 

  
 
 Type the desired X and Y values of the first point in the Start Position 

 point in the End Position 
(µm) text boxes in the X and Y columns. 

 
 Type the desired Z offset in the Z Offset text box. See the discussion of 

Z Offset above for more information. 
 
 

Setting the Profile parameters 

(µm) text boxes in the X and Y columns. 
 
 Type the desired X and Y values of the last

 

The Profile parameters (available only for area maps) let you specify a 
profile before data collection. The term “profile” is used to refer to any of 
the ways of representing map data described in the table in the “Creating a 
profile” section in the “Processing and Analyzing Map Data” chapter. See 
that section for details on the available profile types, including the 

formation you need to enter for each. If you don’t spe y a profile type, 
e default profile will be used:  Chemigram. For the profile types that use 

 Note ore data collection is entirely optional. After 
ou collect the map, you will be able to use Profile Setup in the Atlµs menu 

to create profiles. S 

 
 Note The Functional Group and Correlation Map profile types are not available 

before data collection. S 

 

in
th

cif

two peaks, “Peak 2” is the ratio denominator. 
 
Specifying the profile type bef
y
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Setting special mapping options Use the Collect button on the Mapping tab to display and select the special 
apping options shown below. m

  

 

The following table shows what you can specify with each available option 
(the linea

 

r array options are not available for visible Raman experiments). 
 
 

Option Description 

e 

nd 

Save Video Frames In Map File Select this option if you want the video frames for maps saved in the map 
file. Since map files are much larger when they include stored video 
information, you should save the video frames only if you have adequat
disk space. 

If you have specified discrete sample points or an ordered array of points, 
you can use the sample point tool to specify that the video image for an 
individual sample point not be captured and saved. See “Capturing a
saving the video image for sample points” for details. 

Store Map With Relative 
Coordinates 

elect this option if you want relative coordinates used instead of actual 
en the contour 
 relative 

oordinates are used, the first point collected (the start point) becomes 
,0. Relative coordinates are useful when you are running a similar sample 

repeatedly, but its position relative to the stage is changing. This option 
lets you directly compare these samples. 

S
stage positions as grid references for the spectral data wh
map (or discrete point location map) is displayed. When
c
0
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Option Description 

Select this option if you want the system to pause after each sample 
spectrum is collected and again after the stage is moved to the next sample

oint. Pa

A
 

using is useful when the sample is uneven, requiring you to 
fo

uto-Pause Before Each Spectrum 

p
re cus at some of the sample points. 

Prompt Before Collecting Data Select this option if you want the software to display a prompt 
m ap spectrum. im ediately before collecting the first m

Sound Tone At End Of Collection Emits a tone when map data collection is finished. 

 
 
W en you are finished selecting opth ions, choose OK. 

Setting the

 
 

 focus parameters 

 

Use the Focus button on the Mapping tab to display and set the focus 
options shown below. They control whether and how the microscope is 
focused automatically during data collection. 

 

 
 

dware. On
 Note The Focus button is available only if your microscope has the required 

ar ly the options that are appropriate for your hardware 
onfiguration are available. S 

h
c
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The following table shows the effect of each available option. 
 
 

Selecting this option… Has

Do Not Focus During Map 
Collection 

 this effect… 

The microscope is not focused during map collection. 

Use Stored Focus Locations 
(Discrete Points Only) 

The microscope is focused at the discrete point locations you specified 
(inc
collecting data at discrete points rather than a line map or area map. 

You can specify the focus location (Z position) for a discrete sample point. 

ate the 

luding those in an ordered array). Select this option only if you are 

See “Setting the Z position for a discrete point to the current Z position” 
for more information. 

If your microscope has motorized Z-axis movement, use only the stage 
controller or focus buttons in the Atlµs window to adjust the focus when 
using this option. The stage coarse and fine focus knobs do not upd
Z value. 

Autofocus At Each Map Point (All 
Map Types) 

he microscope is focused at each location where data is collected. You T
can use this option for any type of data collection. 

Use Z Offset  you selected Save Video Frames In Map File in the Collect dialog box 
se video and sample 

cus locations that are a fixed distance apart, select Use Z Offset. This is 
se cus location for collecting data is 
me known distance below the sample surface. Specify this distance, or 

offset,” by typing a value in micrometers in the Z Offset text box on the 
ill focus on the sample 

rface and capture a video image, move the focus location into the 
mple the specified distance, and then collect the data. 

If
(see “Setting special mapping options”) and want to u
fo
u ful for samples whose optimum fo
so
“
Mapping tab. At each sample point the software w
su
sa

 
 
When you are finished setting the options, choose OK. 
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Workin
images and Mosaics ns 

ple point be captured and saved 
with the spectrum for that point. 

• Save a video image as a bitmap file. 

 Copy a Mosaic to the Windows Clipboard. 

Capturing and 
saving the video 

image for sample points 

g with video OMNIC Atlµs provides features for working with video images of sample 
surfaces and Mosaics made up of multiple video images. The next sectio
explain how to perform the following tasks with these images in the Atlµs 
window: 
 
• Specify that the video image at a sam

• Capture and display a Mosaic of video images. 
• Clear a Mosaic from the Atlµs window. 
•
• Save a Mosaic as a bitmap file. 
 
 
If you are collecting data at discrete sample points, you can use the sam
point tool to specify whether the video image at the specified s

ple 
ample points 

 captured and saved with the spectra for those points when you collect 
 

. Select the sample point tool. 

om the pop-up 
menu. 

 

is
data. You will be able to view the saved images when you view the collected
map in a map window. Follow these steps: 
  
1
 
 
2. Right-click a sample point in the navigation pane or video pane. 
 
 
3. Choose Toggle Capture Video For Sample Point fr

 
 An asterisk (*) appears next to the point’s number to indicate that a

video image will be captured and saved for that point. Here is an 
example: 

 

  
 
 You can remove the asterisk, and cancel the capture of the video image

by repeating steps 2 and 3. 
, 
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  Saving the video image for sample points 

  sample 
points for any type of map, select Save Video Frames In Map File, 
available through the Collect button on the Mapping tab of the 

 mapping options” 
for details. 

 
 

Saving the video image se Save Video Image in the File menu to save the video image displayed 

current size, as a 24-bit, true-color, bitmap (.BMP) file. Any displayed 

 using an application that opens bitmap files. 

Fol
 
1. 
 
 
2. 
 

4. Locate and open the directory where you want the image saved. 

 
 

 
 The video image is captured using the same pixel resolution as the 

displayed image. 
 

To specify whether to capture and save video images for all

Experiment Setup dialog box. See “Setting special

U
in the video pane of the Atlµs window or the active map window, at its 

annotation, cross hairs and axes are included when you save the image. You 
can open the file later
 

low these steps to save the video image: 

Adjust the display of the video image as desired. 

Choose Save Video Image from the File menu. 

 The Save As dialog box appears. 
 
 
3. Type a file name in the File Name text box. 
 
 

 
 
5. Choose OK. 

 Saving the video image 
 

 The video image is saved using the same pixel resolution as the 
displayed image. 
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U

Capturing a Mosaic of
video images f

Use Capture Mosaic in the Atlµs menu to capture a Mosaic of video images 

e can 
tored for later assembly. If you selected Focus After Each 

tage Movement on the Mapping tab of the Options dialog box, the 
me before it is captured. 

h t exactly match the size 
nd shape of the specified area, the entire specified area is always included 

nce the Mosaic is captured and displayed, you can zoom in on any part of 
n e the Mosaic in a file 

at can be opened later using a program that opens bitmap files, copy it to 
e Windows Clipboard for pasting into a document, or print it on paper. 

a 
osaic” in the “Printing” chapter for more information. 

 Note t indicate the current stage location fall within the area 
f a Mosaic, the copy of the live video image in the navigation pane is 
placed by the captured image of that sample area. If you move the stage 

so that the cross hairs are outside the Mosaic, the copy of the live video 
image once again appears in the navigation pane. S 

 
You can clear, copy, save or print the Mosaic by using commands in the 
Atlµs menu and File menu. See the next sections and “Printing a Mosaic” 
in the “Printing” chapter for complete information. 
 

sing Mosaics You can capture a Mosaic of video images of a sample area and display it in 
the navigation pane. This is useful when you are defining a map that is 
larger than one video frame or want a video record of a large sample area. 
The Mosaic will also appear in the video pane of the map window when 
you later display the collected map. The next sections explain how to 
capture, clear, copy and save a Mosaic. 
 

 
 

or a sample area within a specified area of the sample and display it in the navigation pane as 
one image of the entire area. 
 
When you capture a Mosaic, the software moves the stage to position each 
portion of the specified area under the objective so that a video fram
be captured and s
S
system automatically focuses each fra
 
Alt ough the size and shape of the Mosaic may no
a
in the captured images. 
 
O
it a d draw a map anywhere on it. You can also sav
th
th
See “Saving a Mosaic” “Copying a Mosaic” in this chapter and “Printing 
M
 
If the cross hairs tha
o
re
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Follow these steps to capture a Mosaic: 
 
1. Use the area map tool to draw a box in the navigation pane around

the area of the sample for which you want a video record. 
 

tion pane. 

To stop the capture process before completion, click the Stop button. 

 

 
 See “Drawing an area map (or Mosaic)” if you need help. 
 
 
2. Choose Capture Mosaic from the Atlµs menu. 
 
 The system captures video images of the specified area and displays 

them as a Mosaic in the naviga
 
 

 
 Capturing a Mosaic 

 
 Before you capture a Mosaic, make sure the current calibration is the 

correct calibration for the objective you are using. This ensures that the 
video images that make up the Mosaic appear well aligned, with their 
edges neatly connected. See “Opening a saved calibration” in the 

 

 
Clearing a Mosaic 

from the navigation pane 

“Configuring the System” chapter or “Selecting a calibration” in this
chapter for more information. 

 

After you have used Capture Mosaic in the Atlµs menu to display 
ou can choose Clear Mosaic from the Atlµs menu to clear from t

a Mosaic, 
he 

 
 

y
navigation pane all of the images except the image that matches the video 
pane. See “Capturing a Mosaic of video images for a sample area” for more 
information on displaying a Mosaic in the navigation pane. 

 Clearing a Mosaic 
 

 Be sure you want to clear the Mosaic before using this command. If 
you change your mind after clearing the images, you will have to 
capture all of them again to restore the Mosaic. 
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Copying a Mosaic After you have used Capture Mosaic in the Atlµs menu to display a Mos
you can choose Copy Mosaic from the Atlµs menu to copy the Mosa
along with the nav

aic, 
ic, 

igation pane axes, to the Windows Clipboard. You can 
then paste the Mosaic into a document using a word processing program or 
other program that lets you paste items from the Clipboard. See “Capturing 

 
 

Saving a Mosaic 

a Mosaic of video images for a sample area” for more information on 
displaying a Mosaic in the navigation pane. 

After you have used Capture Mosaic in the Atlµs menu to display a Mosaic, 
 with 
using 

r ideo images for 
in the 

avi

oll  these steps to save a Mosaic: 
 
1. Choose Save Mosaic from the Atlµs menu. 
 
 The Save As dialog box appears. 
 

. Type a file name in the File Name text box. 

 
. Locate and open the directory where you want the Mosaic saved. 

4. 

you can use Save Mosaic in the Atlµs menu to save the Mosaic, along
the navigation pane axes, in a bitmap file. You can then open the file 
a p ogram that opens bitmaps. See “Capturing a Mosaic of v
a sample area” for more information on displaying a Mosaic 
n gation pane. 
 
F ow

 
2
 

3
 
 

Choose Save. 
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Setting 
the automated 

Reflex aperture 
system on a Continuµm microscope. You can also set the aperture by using 

e Aperture button on the Mapping tab of the Experiment Setup dialog 

 
 Important Use

control knobs on the microscope. If you do adjust the knobs, you will need 
to initialize the aperture. See “Initializing the automated Reflex aperture” in 
the “Configuring the System” chapter for instructions. S 

or more information about the Reflex aperture, see the documentation 
icroscope. 

Adjusting the 
automated Reflex 

aperture graphically 

If you have a Continuµm microscope with the automated Reflex aperture, 
e aperture is represented in the video pane of the Atlµs window by a box 

ou can manipulate. Here is an example: 

 

The next sections explain three ways to set the automated Reflex aperture 

th
box. See “Specifying the automated Reflex aperture” for details. 

 only the software to adjust the aperture; do not use the Reflex aperture 

 
F
that came with your m
 
 

th
y

 
 

 Simply select the tool and then drag a side or corner of the box. The Re
aperture is adjusted automatically to match the box. 

Use the arrow tool to change the size, shape and orientation of the box. 
flex 

ince the box is always present, the aperture tool is not available. 

 Note The minimum size of the automated Reflex aperture is nominally 5 by 5 
micrometers. If you attempt to set the aperture to this or a smaller size, the 
system will automatically adjust the aperture to the minimum size possible 
on your microscope (typically 8 by 8 micrometers). The minimum 
available size varies slightly from system to system. S 

 
Your graphical adjustment of the aperture changes in the settings in the 
dialog boxes displayed by Aperture Dimensions in the Atlµs menu (see the 
next section) and the Aperture button on the Mapping tab of the 
Experiment Setup dialog box. See “Specifying the automated Reflex 
aperture” for details. 
 

 
S
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Setting the 
automated Reflex 

aperture numerically 
 

 Note

re Dimensions from the Atlµs menu.  

 

 

The settings in this dialog box are linked to 
those in the dialog box displayed by the 

Aperture button on the Mapping tab of the 
Experiment Setup dialog box. See “Specifying 

an aperture” for more information. 

You can use Aperture Dimensions in the Atlµs menu to adjust the size, 
shape and orientation of the automated Reflex aperture by entering 
numerical values. 

The minimum size of the automated Reflex aperture is nominally 5 by 5  
micrometers. If you attempt to set the aperture to this or a smaller size, the 
system will automatically adjust the aperture to the minimum size possible 
on your microscope (typically 8 by 8 micrometers). The minimum 
available size varies slightly from system to system. S 

 
Follow these steps to set the automated Reflex aperture numerically: 
 
1. Choose Apertu
 
 The Aperture Dimensions dialog box appears: 
 

 
 
 
2. Type the X dimension of the aperture in micrometers, before any 

rotation, in the X (µm) text box. 
 
 
3. Type the Y dimension of the aperture in micrometers, before any 

rotation, in the Y (µm) text box. 
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4. Specify the angle by which to rotate the aperture about the center of 
the field of view within the plane of the sample. 

To do this, type a number in the Angle (degrees) text box. An angle of 
0 positions the aperture with its X dimension parallel to the X-axis. You 
can rotate the aperture from 45 to -45 degrees (a negative angle rotates 
the aperture clockwise). With this range of rotation plus the ability to 
resize the aperture, any combination of orientation and rectangular 
shape is possible. 

 
 
5. Choose Apply. 
 
 The aperture is adjusted according to your settings. You can view the 

sample and make further adjustments if desired. 
 
 
6. When you are finished, choose Close. 
 
 

Setting the 
automated Reflex 

aperture to the default 

hoose Set Aperture To Default from the Atlµs menu to set the automated 
eflex aperture to the default size and zero degrees of rotation. If you are 
sing an objective with a magnification of 15X or less, the default size is 

 
grea

 Note he bjective 
arameter that was saved in the current calibration. S 

 

 
 

C
R
u
100 by 100 micrometers. If you are using an objective with a magnification

ter than 15X, the default size is 50 by 50 micrometers. 
 
T  software bases the default aperture on the setting of the O
p
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Setting the FT-Raman
View Stage origin 

h an FT-Raman View Stage, use Move 
h the specified center of horizontal stage 

avel as the zero (0,0) point. The zero point will be used as a reference for 
e X and Y values of sample points you specify, maps and annotation you 

 
 Note efore you use the FT-Raman View Stage, it must be initialized so that the 

age coordinate values displayed by the software are repeatable and 

 

. 

 position the sample cup in the field of view. 

u 

 You should see machined concentric circles on the surface. 

 Before you use OMNIC Atlµs wit
Stage in the Atlµs menu to establis
tr
th
draw, and axes displayed in the Atlµs window. 

B
st
accurate with respect to the laser location. First make sure the stage cable is 
connected to the connecter on the rear wall of the sample compartment
and then start OMNIC For Raman. When the OMNIC For Raman 
window appears, the stage has been initialized. S 

 
Follow these steps: 
 
1. Place the sample cup in the hole in the stage
 
 
2. Move the stage to
 
 You can use the stage movement tool or Move Stage in the Stage men

to do this. 
 
 
3. Focus on the inside bottom surface of the cup. 
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4. 
 

The Move Stage dialog box appears: 

 

Choose Move Stage from the Atlµs menu. 

 
 

 
 
 
5. Use the arrow buttons in the Move By Steps (X,Y) box to move the 

stage to center the concentric circles on the cross hairs. 
 
 You may need to drag the dialog box out of the way first. 
 
 See “Moving the stage with the Move Stage command” in the 

“Preparing for Data Collection” chapter if you need help using the 
buttons. 

 

. Choose OK. 

 

 
6
 
 The center of the cup is now at the origin point (0,0). 
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Afte
foll idual spectra. 

Collecting a 
map background 

Col llect a 
background at the specified background point. Often a background is 
coll
to use Collect Map Background. See “Specifying a background point” and 
“Background handling” in the “Preparing for Data Collection” chapter for 

ng an FT-IR or FT-Raman map” in this chapter 

 
 Note You can also collect a background at the current stage location, as explained 

in t

here does not need to be a current map sequence in order to collect the 
background. This lets you collect a background on a sample you are going 
to map or on another sample, before collecting the map. 
 
See “Collecting backgrounds for FT-IR experiments” in the “Overview” 
chapter for information on deciding how to collect a background. 

  y
specify, delete the background point before collecting the map. Otherwise, 
another background will be collected (using the sample) when you collect 
the map. See “Deleting a background point” in the “Preparing for Data 
Col  

 
Follow these steps to collect a background with Collect Map Background: 
 
1. llection.  
 
 rial on the stage and specify a background 

point. Install the aperture if desired (and flip the microscope mirrors if 
are not automated). 

If you are collecting ATR data, you need to collect the data through the 

Collecting Data 

r you have set up data collection as explained in the preceding chapter, 
ow the instructions in this chapter to collect a map or indiv

 
 

lect Map Background, if available in the Collect menu, lets you co

ected as part of the infrared mapping experiment, and there is no need 

information about specifying a background point and when to collect a 
background. See “Collecti
for complete information on collecting map data. 

he next section. S 

 
T

 
Note If ou want the collected background to be used for a map you plan to 

lection” chapter for information on deleting a background point. S

Prepare for background co

Install the appropriate mate

they 
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clean ATR crystal. See the documentation that came with your ATR
crystal for more information. 

 
 
2. Choose Collect Map Background from the Collect menu, and the

follow the instructions that appear on the screen. 
 
 If the following prompt appears,

 

n 

 make sure the system is prepared to 
collect the background and then choose OK. 

 
This prompt appears if Prompt 

To Insert Or Remove Sample 
is selected on the Collect tab of 

the Options dialog box, available 
through Options in the Edit menu. 

 

 

During collection the data appears in the Collect Background win
Here is an examp

 
 dow. 

le: 

 

 

 
 
 The status of the collection appears in the description bar. For more 

information about using this window, choose OMNIC Help Topics 
from the Help menu, find “background spectrum” in the Index and go 
to the “Collecting a background spectrum” topic. 
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 If data collection is finished and the Collect Background window i
displayed, you can move the spectrum to a spectral w

s 
indow by selecting 

the desired option from the window selection box at the top of the 

 close the Collect Background window by clicking 
the Close button (labeled “X”) in the upper-right corner. 

 
 If a message asks whether to add the spectrum to a window, choose OK 

to add the background spectrum to a spectral window, or choose 
Cancel to return to the Collect Background window. To view 
information about collection problems, choose View Collect Status in 
the message. 

 
 

window and then choosing Add. If you don’t want to add the spectrum 
to a spectral window,

 Collecting a background 
 

  Collect the background using an area where there is no sample material 
present. The best location or material to use for collecting a 
background varies depending on the sample type or application. The 
table below provides some suggestions for collecting backgrounds. 

 
 

Sample Type/Application Background 

Air. transmission; sample suspended over 
air 

transmission; sample on a salt plate An area of the salt plate where no sample material is present. 

transmission; sample in a compression
cell 

 A crystal of KBr (or other halide salt) in the same compression cell, 
next to the sample. 

specular reflection A mirror or polished metal. 

diffuse reflection Crushed KBr, silicon carbide paper or other rough, non-infrared-
absorbing material. 

reflection-absorption o A mirror or polished metal, or an area of the sample support where n
sample material is present. 

grazing angle reflection A mirror or polished metal, or an area of the sample support where no 
sample material is present. 

ATR Air. 
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Collecting a 
kground spectrum at bac

the current stage location um will be 
llected at the current X,Y location. The collected background becomes 

d 
 

Compartment on the Bench tab for the location of the microscope and 
more information, 

choose OMNIC Help Topics from the Help menu, find “sample 
compartment” in the Index and go to the “Specifying the sample 

 
Set Final Format on the Collect tab to the format that is appropriate for 

 
Install the aperture if desired (and flip the microscope mirrors if they 
are not automated). 

  data, you need to collect the data through the 
clean ATR crystal. See the documentation that came with your ATR 

 
 

Use Collect Background, if available in the Collect menu, as explained 
below to collect a background at the current stage location. There is no 
need to use a tool to specify a background point; the spectr
co
the current background and will be used to ratio the sample spectra you 
collect until a new background is collected. In OMNIC Help Topics fin
“background spectrum” in the Index and go to “Collecting a background
spectrum” for detailed instructions. 
 
1. Prepare for background collection.  
 
 Use Experiment Setup in the Collect menu to set Sample 

the type of collection you are performing. For 

location” topic. 

 
the kind of data you will be collecting. 

 

 
If you are collecting ATR

crystal for more information. 
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2. Choose Collect Background from the Collect menu, and then 
follow the instructions that appear on the screen. 

. 

 

 
 During collection the data appears in the Collect Background window

Here is an example: 

  
 
 The status of the collection appears in the description bar. For more 

information about using this window, choose OMNIC Help Topics 
trum” in the Index and go 

to the “Collecting a background spectrum” topic. 

 If a message asks whether to add the spectrum to a spectral window, 
choose Yes to add the background spectrum to the indicated window; 
choose No to end the procedure without saving the spectrum; or 
choose More Scans to return to the Collect Background window. To 
view information about collection problems, choose View Collect 
Status in the message. 

 
 If data collection is finished and the Collect Background window is 

displayed, you can move the spectrum to a spectral window by selecting 
the desired option from the window selection box at the top of the 
window and then choosing Add. If you don’t want to add the spectrum 
to a spectral window, close the Collect Background window by clicking 
the Close button (labeled “X”) in the upper-right corner. 

 

from the Help menu, find “background spec
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Collecting an FT-IR
or FT-Raman map 

t 
ce. See “Collecting a 

visible Raman map” if you have a Nicolet Almega system. 

 Note ure the software has been set up to use the same sample for 
the background and sample spectra. Also, the software prompts you to 

apping options” and “Setting the data collection parameters for FT-IR 
ts” in the “Preparing for Data Collection” 

apter, you can alter the order of some steps and make other changes to 

1. Install the sample on the microscope stage. 

 

 
ta 

collection parameters. 
 
 Select the appropriate Background Handling option on the Collect tab 

of the Experiment Setup dialog box. See “Background handling” in the 
“Preparing for Data Collection” chapter for details. 

 
 Set Final Format on the Collect tab to the format that is appropriate for 

the kind of data you will be collecting. 
 
 Set Sample Compartment on the Bench tab for the location of the 

microscope and the type of experiment you are performing. For more 
information, choose OMNIC Help Topics from the Help menu, find 
“sample compartment” in the Index and go to the “Specifying the 
sample location” topic. 

 
 If you have a Continuµm XL microscope and are performing an 

imaging experiment, set Detector on the Bench tab to XL Array. 

 Follow the steps below to use Collect Map in the Collect menu to collec
an FT-IR or FT-Raman map defined by a map sequen

 
For this proced

prepare for data collection. By setting features described in “Setting the 
m
and FT-Raman experimen
ch
better fit your application. For example, you can specify a stored 
background or use a different material for the background. S 

 

 
 
2. Specify the map sequence or open a stored experiment file or 

sequence file. 

 See “Specifying a map sequence” in the “Preparing for Data Collection” 
chapter if you need help. 

 

3. Use Experiment Setup in the Collect menu to check or set the da
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4. If you are collecting a line map or area map, specify the profile type 
if desired. 

 
 You can use the Mapping tab of the Experiment Setup dialog box 

the Collect menu to specify the profile type and associated informa
such as peak locations, spe

in 
tion 

ctral regions or baselines. See “Setting the 
Profile parameters” in the “Preparing for Data Collection” chapter for 

 specified 

 
 File in the Options 

dialog box (available through the Collect button on the Mapping 
 

 Note d. 
Instead, turn off the Reflex aperture illuminator to cause the aperture image 

 
6. ct Map from the Collect menu. 
 
 
 
 

complete information. 
 
 If you don’t specify a profile type, the default profile will be used:  

Chemigram. This shows the integrated spectral intensity of a
spectral region for each sample point. 

 

5. If you selected Save Video Frames In Map

tab of the Experiment Setup dialog box), remove the aperture from
the microscope. 

 
 If you have a Continuµm microscope, the aperture cannot be remove

to disappear. S 

 

hoose ColleC

The Save As dialog box appears. 
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7. 

 
 egins. Here 

 an example: 

 

Specify a file name and location for the map and then choose Save. 
Follow the instructions that appear on the screen. 

The Collect Sample window appears and map data collection b
is

 

 
 
Collect Sample window 
 

ach sample point in the navigation pane as the correspo
 The description bar shows the progress of the collection. Cross hairs move 

 e nding spectrum 
 collected. The collected spectra appear in the spectral display pane. 

 
 

er he microscope if it is not already removed (if you have a 

ma
 
 If a prompt asks you to prepare for map data collection, install the aperture 

(and flip the microscope mirrors if they are not automated) and then 
oo

 
 Note If y

 

to
is

If a prompt asks you to prepare to capture the video images, remove the 
ture from tap

Continuµm microscope, see the Note in step 5). Then choose OK. The 
i ges are captured and saved. 

se OK. ch

ou have a Continuµm microscope, adjust the aperture as desired. S 
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  tab of the Experiment 
etup dialog box, preliminary data collection begins and the data are 
isp ow. If you are satisfied with the data, 
art the actual sample data collection by clicking the Start Collection 
utton. If you don’t want to collect a sample spectrum, click the Stop 

 
 Note  you are collecting ATR data, you need to make contact with the sample. 

information. If you have the required hardware, you can use ATR mode or 
uto ATR contact to make and release contact with the sample 

automatically during data collection. See “Collecting ATR data with 
autofocus” or “Using auto ATR contact” for details. S 

 
 To stop data collection, click the Stop button. 
 
 You can pause data collection by clicking the Pause button. This lets you 

refocus the microscope or make contact with an ATR sample. 
 
 When the collection is finished, the data appears in a map window. 
 
 If any errors occurred during data collection, a window appears listing the 

errors in chronological order. Close the window after you read the error 
descriptions. 
 
 

If Preview Data Collection is selected on the Collect
S
d layed in the Collect Sample wind
st
b
button to end the procedure. 

If
See the documentation that came with your ATR crystal for more 

a
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Collecting a 
visible Raman map 

ol ollect a 
visi
information about collecting a depth profile. See “Collecting an FT-IR or 
FT-
 

 Note By setting features described in “Setting the mapping options” and “Setting 
e data collection parameters for visible Raman experiments” in the 
r ter the order of some 

eps and make other changes to better fit your application. S 

1. croscope stage. 

. Specify the map sequence or open a stored experiment file or 

 
 ap sequence” in the “Preparing for Data Collection” 

chapter if you need help. 

 
3. tup in the Collect menu to check or set the data 

collection parameters. 

 

 

4. re collecting a line map or area map, specify the profile type 
if desired. 

 
n 

 regions or baselines. See “Setting the 
Profile parameters” in the “Preparing for Data Collection” chapter for 
complete information. 

 
d 

le point. 

F low the steps below to use Collect Map in the Collect menu to c
ble Raman map defined by a map sequence. See the next section for 

Raman map” if you have an FT-IR or FT-Raman system. 

th
“P eparing for Data Collection” chapter, you can al
st
 

Install the sample on the mi
 
 
2

sequence file. 

See “Specifying a m

 

Use Experiment Se

 
 Select Microscope in the Beam Path/Sample Position box on the Bench

tab. Set Final Format on the Collect tab to the format that is 
appropriate for the kind of data you will be collecting. 

 
If you a

 
You can use the Mapping tab of the Experiment Setup dialog box in 
the Collect menu to specify the profile type and associated informatio
such as peak locations, spectral

 
If you don’t specify a profile type, the default profile will be used:  
Chemigram. This shows the integrated spectral intensity of a specifie
spectral region for each samp
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5. Choose Collect Map from the Collect menu. 
 

The Save As dialog box appears. 

 
6. e. 

pear on the screen. 

n begins. 
Here is an example: 

 
 

Specify a file name and location for the map and then choose Sav
Follow the instructions that ap

 
 The Collect Sample window appears and map data collectio

 

  
 

Collect Sample window 
 
 The description bar shows the progress of the collection. Cross hairs 

move to each sample point in the navigation pane as the corresponding 
spectrum is collected. The collected spectra appear in the spectral 
display pane. 

 
 If a prompt asks you to prepare to capture the video images, choose 

OK. The images are captured and saved. 
 
 If a prompt asks you to prepare for map data collection, choose OK. 
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 If Preview Data Collection is selected on the Collect tab of the 
Experiment Setup dialog box, preliminary data collection begins and 
the data are displayed in the Collect Sample window. If you are 
satisfied with the data, start the actual sample data collection by 
clicking the Start Collection button. If you don’t want to collect a 
sample spectrum, click the Stop button to end the procedure. 

 lets 

 If any errors occurred during data collection, a window appears listing 
e the window after you read the 

error descriptions. 

 
a” 

 
 

Collecting a depth profile Follow the steps below to collect a line depth profile or area depth profile. 
See “Specifying the Dimensions parameters” in the “Preparing for Data 

ollection” chapter for more information about depth profiles. 
 

1. age and focus at the desired 
depth. 

 the sample surface, on the surface or below the 
surface. If you focus on the sample surface, you will be able to use the 
live display on the Bench tab of the Experiment Setup dialog box to 

 

pane. If 

 
 To stop data collection, click the Stop button. 
 
 You can pause data collection by clicking the Pause button. This

you refocus the microscope. 
 
 When the collection is finished, the data appears in a map window. 
 

the errors in chronological order. Clos

 
To save the collected map, use Save Map or Save Map As in the File 
menu. See “Saving a map” in the “Saving and Exporting Map Dat
chapter for details. 

C

Place the sample on the microscope st

 
You can focus above 

maximize the signal in step 3. 

 
2. If you are collecting a line depth profile, use the sample point tool 

to click the desired location in the navigation pane or video 
you are collecting an area depth profile, use the line map tool to 
draw a line in either pane. 
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3 Use Experiment Setup in the Collect menu to set the data collectio
parameters. 

. n 

Profile and then set the parameters, including the Z offset, if used. See 

 
 
 
 

. Choose Collect Map from the Collect menu. 

 
 
 
5. 

 
The Collect Sample window appears and map data collection begins. 

 
 

 for details. 

 
 On the Mapping tab of the Experiment Setup dialog box, select Depth 

“Specifying the Dimensions parameters” in the “Preparing for Data 
Collection” chapter for details. 

Choose OK to close the dialog box when you are finished. 

4
 

The Save As dialog box appears. 

Specify a file name and location for the map and then choose Save. 
Follow the instructions that appear on the screen. 

 
See the preceding section for a discussion of the window and the 
prompts that may appear. 

To save the collected depth profile, use Save Map or Save Map As in 
the File menu. See “Saving a map” in the “Saving and Exporting Map 
Data” chapter
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Col

cur

Collecting an FT-IR or
FT-Raman spectrum at the 

current stage location 

Use Collect Sample (or Collect Raman if you are using Raman hardware) 
 collect a sample spectrum at the 

rrent stage location. There is no need to use a tool to specify a sample 

OMNIC Help Topics find “sample spectrum” in the Index and go to 
ollecting a sample spectrum” for detailed instructions. (In Raman Help 

Ram
 

. Set the data collection parameters. 

 u to set Sample 
Compartment on the Bench tab for the location of the microscope and 

d “sample 
compartment” in the Index and go to the “Specifying the sample 

ath” in 

 
  

 
 
2. enu, 

and then follow the instructions that appear on the screen. 

 Note If you are collecting ATR data, you need to make contact with the sample. 
See the documentation that came with your ATR crystal for more 
information. If you have the required hardware, you can use ATR mode or 
auto ATR contact to make and release contact with the sample 
automatically during data collection. See “Collecting ATR data with 
autofocus” or “Using auto ATR contact” for details. S 

lecting a sample 
spectrum at the 

rent stage location 

The following sections explain how to collect a sample spectrum at the 
current stage location on FT-IR, FT-Raman and visible Raman systems. 

 
 

 
in the Collect menu as explained below to
cu
point; the spectrum will be collected at the current X,Y location. In 

“C
Topics, find “Raman spectrum” in the Index and go to the “Collecting a 

an spectrum” topic.) 

1
 

Use Experiment Setup in the Collect men

the type of collection you are performing. For more information, 
choose OMNIC Help Topics from the Help menu, fin

location” topic. (If you are collecting Raman data, find “beam p
the Index of Raman Help Topics and go to the “Specifying the beam 
path” topic.) 

Set Final Format on the Collect tab to the format that is appropriate for
the kind of data you will be collecting. 

 
 Install the aperture if desired (and flip the microscope mirrors if they 

are not automated). 

Choose Collect Sample (or Collect Raman) from the Collect m
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 During collection the data appears in the Collect Sample (or Collect 
Raman) window. Here is an example: 

 

  
 
 The status of the collection appears in the description bar. For more 

information about using this window, choose OMNIC Help Topics 
from the Help menu, find “sample spectrum” in the Index and go to 
the “Collecting a sample spectrum” topic. (If you are collecting Raman 
data, find “Raman spectrum” in the Index of Raman Help Topics and 
go to the “Collecting a Raman spectrum” topic.) 

 
window is displayed, you can move the spectrum to a spectral window 
by selecting the desired option from the window selection box at the 

d 
close the Collect Sample (or Collect 

Raman) window by clicking the Close button (labeled “X”) in the 

 the spectrum to the indicated window; choose No to 
end the procedure without saving the spectrum; or choose More Scans 
to return to the Collect Sample (or Collect Raman) window. To view 

ction problems, choose View Collect Status in 
the message. 

 
 

 
If data collection is finished and the Collect Sample (or Collect Raman) 

top of the window and then choosing Add. If you don’t want to ad
the spectrum to a spectral window, 

upper-right corner. 
 
 If a message asks whether to add the spectrum to a spectral window, 

choose Yes to add

information about colle
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Collecting a visible 
Raman spectrum at the 
current stage location 

s explained below to collect a 
mple spectrum at the current stage location. There is no need to use a 

t 
X,Y location. In OMNIC Help Topics find “Collect Sample command” in 

e Index and go to “Collecting a sample spectrum” for detailed 
structions. 

 
1. 
 
 e 

Beam Path/Sample Position box on the Bench tab. 

  on the Collect tab to the format that is appropriate for 
the kind of data you will be collecting. 

ollect menu, and then follow the 
instructions that appear on the screen. 

 
During collection the data appears in the Collect Sample window. The 

 is finished and the Collect Sample window is 
displayed, you can move the spectrum to a spectral window by selecting 

to a spectral window, close the Collect Sample window by clicking the 
Close button (labeled “X”) in the upper-right corner. 

 
 If a message asks whether to add the spectrum to a spectral window, 

choose Yes to add the spectrum to the indicated window; choose No to 
end the procedure without saving the spectrum; or choose More Scans 
to return to the Collect Sample window. To view information about 
collection problems, choose View Collect Status in the message. 

 
 

Use Collect Sample in the Collect menu a
sa
tool to specify a sample point; the spectrum will be collected at the curren

th
in

Set the data collection parameters. 

Use Experiment Setup in the Collect menu to select Microscope in th

 
Set Final Format

 
 

Choose Collect Sample from the C2. 

 
status of the collection appears in the description bar. 

 
If data collection 

the desired option from the window selection box at the top of the 
window and then choosing Add. If you don’t want to add the spectrum 
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Coll
data wi lly 

Impo
ections. Use the Z Position button to 

lower the stage. S 

 Note If y
dete

o u  ATR mode with a ZnSe or diamond crystal: 

. 

 

. , 
carefully raise the stage with the Z Position button (shown below) 
to make contact with the sample.  

 

ecting ATR 
th autofocus 

If you have an FT-IR system with the optional autofocus feature, you can 
use ATR mode to break and restore contact with the sample automatica
during an experiment. 
 

 rtant Always lower the stage to break contact with the ATR crystal before 
moving the stage in the X or Y dir

 
ou have a Continuµm XL microscope, do not use the linear array 
ctor for ATR experiments. S 

 
 
T se
 
1 Specify the X and Y coordinates of the sample points just as you 

would for any mapping experiment. 

 
2 With the microscope in View mode and ATR objective in position

  
 

There will be a wetting effect or slight darkening of the field. See the  
documentation that came with your ATR crystal for more informat

 

Click the Store Z Position button (shown below) to save the Z 
coordinate of the stage position. 

ion. 

 
3. 

 

  

This coordinate will be used to make contact at every sample point in 
the experiment. 

 
 

 
 
4. Start data collection. 
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To use ATR mode with any type of crystal: 
 
1. Specify the X and Y coordinates of the sample points just as you 

ould for any mapping experiment. 

. 

 
 You should be able to see the sample absorption bands in the single-

 
. Click the Store Z Position button (shown below) to save the Z 

w
 
 

With the microscope in infrared mode, the ATR objective in 2
position, and the single-beam spectrum displayed in the 
Experiment Setup dialog box, carefully raise the stage using the 
autofocus hardware controller to make contact with the sample. 

beam spectrum. 
 

3
coordinate of the stage position.  

 

  
 

This coordina te will be used to make contact at every sample point in 
the experiment. 

4. 
 
 

 
 

Start data collection. 
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Usin
ATR contact 

ct 
u can collect ATR spectra with the optimal contact pressure 

automatically applied by the system. 

 Note If you have a Continuµm XL microscope, do not use the linear array 

 

g auto If you have a Continuµm microscope with the optional auto ATR conta
feature, yo

 
 

detector for ATR experiments. S 

• If you are collecting an individual spectrum at the current stage 
location, use the ATR Contact button (shown below) to establish 
optimal contact with the sample. 

 

  
 
 The button uses the microscope’s internal Contact Alert System to 

determine the optimal contact. See the procedure later in this section 
for details. 

After contact is made, the ATR Contact button changes appearance: 
 
 

 

  
 
  Use the button to release contact. 
 

Auto ATR Contact in the Focus 
dialog box (available through the Focus button on the Mapping tab of 

ting the collection. With 
this option selected, the system automatically makes and releases 

tact button 
ut not at the background point. Because this feature uses 

the internal Contact Alert System instead of a single stored Z value to 
make sample contact, you can automatically collect a map of a sample 

 

• If you are collecting a map, select 

the Experiment Setup dialog box) before star

contact with the sample at each sample point (the ATR Con
is not used), b

of varying thickness without damaging the crystal or objective. See the 
procedure later in this section for details. 
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 Note ecks to see if the Z-axis of the microscope 
as been initialized. If the axis has not been initialized, you are asked 

 If you cancel the initialization, the autofocus and auto ATR contact 

 
 If you initialize the Z-axis, the stage moves to its upper and lower limits 

 
 Important 

mic
 

 
To collect an ATR spectrum automatically: 
 
1. Set up the internal Contact Alert System. 
 
 See the documentation that came with your microscope for 

instructions. 
 
 
2. Install the sample and position the area of interest under the ATR 

objective or slide-on ATR attachment. 
 
 
3. Click the ATR Contact button (shown below). 
 

 

When OMNIC Atlµs starts, it ch
h
whether to initialize it. 

 
•

features are disabled until the next time you start OMNIC Atlµs. 

•
and then back to the origin. After initialization, the stage returns to its 
former position. S 

Lower the condenser all the way and remove the nosepiece from the 
roscope before initialization. S 

 
 
 The stage automatically moves upward to make optimal contact with 

the sample. While the stage is moving upward, the button is labeled 
“Abort.” If for any reason you need to stop the stage, click the button. 

 
 After contact is made, the ATR Contact button changes appearance 

and is used to release contact: 
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 Important  

 

 You can use the Z Position button (shown below) to adjust the contact
pressure. 

 
 

  owever, be careful when moving the stage up, since applying too much 
 

n 

 Note 

ample or crystal. S 

 

 
t an ATR map automatically: 

sition the area of interest under the ATR 
nt. 

H
pressure can damage the ATR objective or crystal! Choose Experiment
Setup from the Collect menu, and watch the live single-beam spectrum on 
the Bench tab for the appearance of sample absorptions to determine whe
optimal pressure has been achieved. S 

 
If you use the Z Position button to change the contact pressure, the ATR 
Contact button’s appearance and use (described above) will depend on the 
current pressure. If you use the Z Position button to move the stage 
upward, the computer will beep and the software will warn you about the 
risk of damage to the objective, s
 

4. Choose Collect Sample from the Collect menu. 
 
 
5. When data collection is finished, click the ATR Contact button to 

release contact. 
 
 The stage moves downward to release contact with the sample. 

 

o collecT
 
1. Set up the internal Contact Alert System. 
 
 See the documentation that came with your microscope for 

instructions. 
 
 

. Install the sample and po2
objective or slide-on ATR attachme

 
 

Thermo Fisher Scientific OMNIC Atlµs User’s Guide 165 



Collecting Data 

3. Specify the map sequence. 
 
 Use the Atlµs window tool palette or the Mapping tab of the 

 
Be sure to select Auto ATR Contact in the Focus dialog box (available 
through the Focus button on the Mapping tab). 

. 
 

The system automatically makes and releases contact with the sample at 

 

Experiment Setup dialog box to do this. 

 

 
 
4 Choose Collect Map from the Collect menu. 

 
each sample point while collecting the map. 
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 Opening and Importing Map Data 
 
 
Th s chapter explains how to open and impi ort map data stored on a disk. 

Opening a map or 
files from a split map 

se Open in the File menu to open a collected map, a depth profile, 
rincipal component analysis (PCA) results, Multivariate Curve Resolution 

t were previously saved 
ith Save Map or Save Map As in the File menu. (See “Saving a map” or 

Saving a map with a new file name or in a different location” in the 

also
you split a map and display them in a spectral window. (See “Splitting a 

ap into separate data files” in the “Processing and Analyzing Map Data” 

 
fter you open a map, you can view and manipulate the map data. See 
Performing a principal component analysis” in the “Processing and 

 chapter for information about principal component 
nal
fo r 

for 

 Note 

ct

CR 
u

 

o t  instructions apply 

Choose Open from the File menu. 
 
 The Open dialog box appears. 

 
 
U
p
(MCR) results or quantitative analysis results tha
w
“
“Saving and Exporting Map Data” chapter for more information.) You can 

 open multiple .CSV or .JDX (JCAMP-DX) files that were saved when 

m
chapter for more information.) 

A
“
Analyzing Map Data”
a yses. See “Using Multivariate Curve Resolution” in that chapter for 
in rmation about MCR analyses. See “Quantifying a map” in that chapte

information about performing a quantitative analysis. 
 
You can also display a map by importing an ENVI®, JCAMP-DX or 
spectral group file with Import in the File menu as explained in the next 

ion. S se
 
Follow the steps below to open a map, a depth profile, PCA results, M
res lts or quant results. 
 
For information about opening multiple .CSV or .JDX files, choose OMNIC
Help Topics from the Help menu, find “CSV file format” in the Index and 

o the “Opening a CSV text file” topic. The providedg
to both .CSV and .JDX files. 
 
1. 
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2. Set Files Of Type to Mapping Files (*.MAP). 
 
 
3. Type the name of the file you want to open in the File Name text 

box, or locate and select a file. 
 
 
4. Choose Open. 
 
 The map appears in a new map window. See “Using map windows” in 

the “Displaying Map Data” chapter for more information. 
 
 A special window is used to display opened PCA results or MCR 

results. See “Performing a principal component analysis” or “Using 
Multivariate Curve Resolution” in the “Processing and Analyzing Map 
Data” chapter for details. 

 
 Note Some commands in the Process menu let you save both the original and 

processed spectra in the map file. If both are present in the file you are 
opening, a prompt asks you which spectra to open. Respond appropriately. S 
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Importing map data I file, a spectral group file or 
y the opened file or files as a 

ap in a map window. Follow these steps: 

 appears. 

 

e files. 

You can change directories or drives to locate the file or files you want 

” 

rs 

. Make any desired changes to the parameter settings and then 
choose OK or OK To All. 

 
 The parameter settings apply to all the files you are opening. You can 

click the More button to set additional parameters. 
 
 The imported data appears in a new map window. 
 

 

 Use Import in the File menu to open an ENV
multiple JCAMP-DX or CSV files and displa
m
 
1. Choose Import from the File menu. 
 
 The Open dialog box
 
 
2. Set Files Of Type to the desired file type. 
 
 
3. If you are importing a single file, type the name of the file or locate

and select a file. If you are importing multiple JCAMP-DX or CSV 
files, locate and select th

 
 

to open. 
 
 
4. Choose Open. 
 
 If you are importing a single file, the imported data appears in a new 

map window and the procedure is finished. See “Using map windows
in the “Displaying Map Data” chapter for more information. 

 
 If you are opening multiple JCAMP-DX or CSV files, the Paramete

dialog box appears showing information about the first file. 
 
 
5
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 Displaying Map Data 
 
 
OMNIC Atlµs uses map windows to display collected maps along with 
associated software features such as a video image of the sample and a 3-D 
display of the map data. 
 
A separate map window is used for each map you display. After you collect 
a map or open a stored map, it is displayed in a new map window. 
 
An important feature of a map window is the “interlinking” of the video 
image, the contour map (or discrete point location map), 3-D display and 
other parts of the window. This lets you see the relationship between data 
displayed in different ways. 
 
 

Using map windows You can display a line map, area map, discrete point map or depth profile 
in a map window. The features provided in the window for viewing and 
manipulating map data depend on the options selected on the Mapping - 
General tab of the Display Setup dialog box. (See “Specifying the items to 
display” for more information.) The displayed features can include some or 
all of the items shown in the following illustrations. The features used to 
display a depth profile are the same as those for displaying a line map or 
rea map. The window features work the same for any data type. 

 Note rofile windows (created when you use Profile Setup or Show Current 

 this section applies to both window types. S 

a
 
P
Profile in the Atlµs menu) are similar to map windows. In general the 
information in
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Contour map
Spectral

display pane Video pane 3-D display

View finder Color bar Profile pane Sky view control  
 
Line map in a map window 
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Contour map
Spectral

display pane Video pane 3-D display

View finder Color bar Profile panes Sky view control  
 
Area map in a map window 
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Video pane
Discrete point
location map

View finder Color bar Spectral display pane Sky view control  
 

iscrete point map in a map window D

 
You can adjust the size and shape of the panes in the window by dragging 

The view finder lets you adjust the displayed frequency range of the data. It 
works the same as the view finder in a spectral window, with the addition 
of the feature explained below. For more information choose OMNIC 
Help Topics from the Help menu, find “view finder” in the Index and go 
to the “View finder” topic. 
 

their borders. 
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The middle vertical line in the view finder lets you specify a frequency to
use for displaying data in some of the panes. If you are displaying a line 
map, the specified frequency is used for the profile. If you are displaying
area map, the frequency is used for the 3-D image, the contour map (o
discrete point location map) and the profiles. To change the frequency, 
drag the line to the right or left. (You can also use the Page Up and Page 
Down keys on

 

 an 
r 

 the keyboard when the view finder is active.) As you move 
e line, the frequency range and the current frequency are displayed. The 

n 

play parameters” for details.) You can animate this process for an 
rea map by using Animation in the Atlµs menu. See “Animating your view 

t 

left 
ing Minimum and 

aximum in the Color Limits box on the Mapping - General tab of the 

ange by horizontally dragging the vertical bars. This in turn 
hanges the distribution of the colors. You can also change the range by 

g 

esholds” for more information. 

f 
ft 

 

ou can copy the color bar to the Windows Clipboard by right-clicking the 
olor bar and choosing Copy from the pop-up menu. You can then paste 

the image into a document using a program that pastes items from the 
Clipboard. 
 

th
data in the affected panes changes to reflect the new frequency. (You ca
specify whether this change occurs as you move the line. See “Setting the 
spectral dis
a
of the map data” for instructions. 
 
The color bar shows the colors used in the contour map (or discrete poin
location map) and 3-D image. The scale below the color bar indicates the 
values of the colors. The unit and range of available values appear to the 
of the color bar. You can change the range by sett
M
Display Setup dialog box. See “Setting the color limits” for more 
information. 
 
The vertical bars on the color bar indicate the limits of the value range 
currently used for the colors in the contour map and 3-D image. You can 
change this r
c
setting Background Threshold and Foreground Threshold on the Mappin
- General tab of the Display Setup dialog box. See “Specifying the 
background and foreground thr
 
If one or both of the vertical bars have been moved away from the ends o
the color bar, you can drag the portion between the vertical bars to the le
or right. To specify a different color scheme for the data, use the Color 
Scheme options on the Mapping - General tab of the Display Setup dialog
box. See “Selecting a color scheme” for details. 
 
Y
c
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You can print the color bar by right-clicking it and choosing Print from the
pop-up menu. 

 

 of the items in the map window 
by using Display Limits in the View menu. See “Setting the display limits” 
for details. 
 
The next sections explain how different kinds of map data are displayed in 
the panes of a map window. 
 
To close the map window, click the Close button (labeled “X”) in the 
upper-right corner. 
 
 

Contour maps If Contour Map is selected on the Mapping - General tab of the Display 
Setup dialog box, a contour map (or discrete point location map) appears in 
the map window or profile window. Contour maps (or discrete point 

cation maps) use colors or lines o indicate ranges of value or the locations 
measured values can be spectral intensity or other types 

 value. 

 

 Note  
p 

 2-D View tab of the Display Setup dialog box to change how the 
 

 
You can adjust the display limits for many

lo t
of equal value. The 
of
 
The spectrum most recently displayed in the spectral display pane (if 
present) corresponds to the cross hairs (or other cursor type) in the contour 
map (or discrete point location map). You can move the cross hairs by 
clicking a location in the map, dragging the cross hairs, or using the arrow 
keys on the keyboard when the map is active. The spectrum associated with
the new location appears in the spectral display pane. 
 
If a line icon or “T” appears next to the pointer, do the following before
clicking a location or dragging the cross hairs:  Right-click the contour ma
(or discrete point location map), point to Cursor Mode and choose Select 
And Zoom from the pop-up menu. S 

 
se theU

contour map (or discrete point location map) is displayed. See “2-D View
display parameters” for details. 
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You can measure items in the contour map:  Right-click the map, point to 
Cursor Mode, choose Ruler from the pop-up menu, and then drag across
the map to draw a ruler. (The ruler also appears on the video image.) The 
measured distance appears near the lower-left corner of the map w

 

indow. 
ou can manipulate the ruler just as you would in the Atlµs window. See 

up 

ou can overlay the contour map (or discrete point location map) with the 
 

ead the next sections for more information about contour maps (and 

 Note om the 
ide from the pop-up menu. 

 

Line and line depth 
profile contour maps 

ing illustration shows a line contour map displayed in a map 
indow. A contour map for a line depth profile would be similar. 

Y
“Moving the ruler” and “Resizing the ruler” in the “Preparing for Data 
Collection” chapter if you need help. To remove the ruler, right-click the 
map, point to Cursor Mode and choose Select And Zoom from the pop-
menu. 
 
Y
video image to see spatial relationships between the two. See “Overlaying
the video image and contour map or discrete point location map” for 
details. 
 
R
discrete point location maps). 
 
You can remove the contour map (or discrete point location map) fr
window by right-clicking it and then choosing H
S

 
 

The follow
w

 

    
 
Line contour map 
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A line or depth profile contour map is a graphical representation of the 
ectral intensity of the series of map spectra. Intensities can be indicated 

n the map in different ways. You can specify that “contours,” areas of 

es 

of a contour or a colored line, 
cate the color on the color bar and read the value on the scale below the 

o change how the colors are used to represent values, adjust the color bar 
 

e 

or in the contour map. 

as 
ts the distance from the 

ro point.) 

 If you have a Nicolet Almega system and used a step size of less than 100 
micrometers to collect the map, the Y-axis is in tenths of a micrometer (0.1 
µm) instead of micrometers. S 

 
Together, the contours and axes present a view of the map data in three 

imensions:  spectral intensity (shown by the colors or contour lines, or 
ncies (indicated by the X-axis) at different distances 

 or within the sample from the starting point (indicated by the Y-axis). 

two dimensions:  spectral intensity and frequency.) 
 
 

sp
o
similar intensity displayed using the same color, be displayed with or 
without black outlines around them. You can also specify that colored lin
be used instead to indicate intensities, as explained in “Setting the contour 
parameters.” 
 
To find the approximate intensity value 
lo
color bar. 
 
T
by dragging the vertical white markers along the color bar. If one or both
markers have been moved away from the ends of the color bar, you can 
move the pointer between the markers and then drag that segment of th
color bar to the left or right. The changes you make to the color bar are 
reflected in the use of col
 
The X-axis of a line or line depth profile contour map is in wavenumbers or 
Raman-shifted wavenumbers and represents the frequencies at which 
spectral bands occur. The Y-axis is in micrometers and represents the 
distance from the first sample point at which each spectrum in the map w
collected. (For a line depth profile, the axis represen
ze
 

Note 

d
both) at different freque
on
(If you create a profile from a line map or line depth profile, the result has 
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Area and area depth 
profile contour maps 

The following illustration shows an area contour map displayed in a map 
indow. A contour map for an area depth profile would be similar. w

 

 
 
Area contour map 

 
 a 

pes.) The current 
equency is indicated by the location of the vertical line that is initially in 

ap by blended or banded colors or by 
lines, similar to how spectral intensities are represented in a line contour 
map. To determine the value represented by a color or adjust the color bar, 
follow the instructions given in the preceding section for line contour 
maps. 
 

 Note If you did not specify a profile type before collecting the map, the default 
type, Chemigram, is used for the initial area contour map, and the contour 
colors represent overall spectral intensity at the sample points. S 

 

 
An area contour map is a graphical representation of values at a particular 
frequency at points in the map. Typically an area contour map indicates
chemical composition at different locations on the sample. (See “Creating
profile” for a description of all the available profile ty
fr
the center of the view finder. You can change the frequency, as explained 
later in this section. 
 
The values are indicated on the m
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The X-axis of an area contour map is in micrometers and represents the X 
position (on the microscope stage) of the sample points where each map 
spectrum was collected. Similarly, the Y-axis of an area contour map
micrometers and represents the Y position of the sample points. 
 
The X-axis of an area depth profile contour map is in micrometers and
represents the horizontal distance along the line drawn in the Atlµs window 
where each map spectrum was collected. Similarly, the Y-axis of an area 
depth profile contour map is in micrometers and represents vertical 

 is in 

 

istance from the zero point. 

 

rs) at different X positions (indicated by the X-axis) and 
ifferent Y positions (indicated by the Y-axis). 

Discrete point location maps 
win

 

This type of map appears if you are 
displaying discrete point data and have 

selected Contour Map on the Mapping – 
General tab of the Display Setup dialog box. 

d
 
The scales of the axes are automatically adjusted so that the aspect ratio 
(proportions) of the contour map matches the mapped area in the video 
image. This makes it easy to identify corresponding locations in the 
contour map and video image. 
 
Together, the colors of the contours or lines and the axes present a view of
the map data at a particular frequency in three dimensions:  value (shown 
by the colo
d
 
 
Here is an example of a discrete point location map displayed in a map 

dow: 

 

 
 
Discrete point location map 

 
A discrete point location map shows the locations of the sample points as well 

 
 

section called “Line and line depth profile contour maps.” 
  

as their overall spectral intensities. To find the approximate intensity value of
a point, locate its color on the color bar and read the value on the scale below

e color bar. To adjust the color bar, follow the instructions given in the th

180 OMNIC Atlµs User’s Guide Thermo Fisher Scientific 



Displaying Map Data 

The X-axis of the location map is in micrometers and represents the X 
position (on the microscope stage) of the sample points where each map 
spectrum was collected. Similarly, the Y-axis of the location map is in 
micrometers and represents the Y position of the sample points. 

Video pane 

formation about capturing a Mosaic. 

 

ize 
om the pop-up menu. 

pth profile would be similar 
 that for a line map, except that no line would appear. The video image 

 

For a line map the location of the 
line formed by the sample points is 

indicated in the video image by a 
red line. The cross hairs (or other 
cursor type) show the location of  

the sample point that corresponds  
to the currently displayed spectrum. 

 
 
If Video Image is selected on the Mapping - General tab of the Display 
Setup dialog box, the map window or profile window contains the video 
image or Mosaic of video images of the sample surface that were captured 
during data collection. See “Capturing a Mosaic of video images for a 
sample area” in the “Preparing for Data Collection” chapter for 
in
 

Note You can remove the video pane from the window by right-clicking it and 
then choosing Hide from the pop-up menu. S 
 
The size of the sample area shown in the video image depends on which 
microscope objective was used to view the sample and save video images. If 
you want the area to match the area currently displayed in the contour 
map, right-click the video image and choose Match Chemical Image S
fr
 
Examples of a video image for a line map, area map and discrete point map 
are shown below. The video image for a line de
to
for an area depth profile would be similar to that for an area map, except
that a line would appear instead of sample points. 

 

 
 
Line map video image 
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The locations of the sample
points are indicated in the video

 

 
 
 

image by red dots. The cross hairs (or 
other cursor type) show the location 
of the sample point that corresponds  
to the currently displayed spectrum. 

 
Area map video image 

 
 
 
 

The locations of the sample 
points are indicated in the video 
image by numbered cross hairs. 

 

 
 
Discrete point map video image 

 you move the cross hairs (or other cursor type) in the video image for a 
in 

w 
board when the video pane is active. 

 Note If a line icon or “T” appears next to the pointer, do the following before 
clicking a point or dragging the cross hairs:  Right-click the contour map (or 
discrete point location map), point to Cursor Mode and choose Select And 
Zoom from the pop-up menu. S 

 
If
line map or area map, the spectrum collected at the new location appears 
the spectral display pane (if present). To do this, click a location in the 
video image, drag the cross hairs (or other cursor type), or use the arro
keys on the key
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If you added markers when you set up the map collection, you can display 
them in the video image by right-clicking the image and choosing Sho
Markers from the pop-up menu. A check mark appears next to the 
comm

w 

and name when the markers are displayed. To remove the markers 
om the video image, right-click the image and choose Show Markers 

ing 
” in the “Preparing 

r Data Collection” chapter for information about adding markers. 

to 

ear the bottom of the map window. You 
n manipulate the ruler just as you would in the Atlµs window. See 

oving the ruler” and “Resizing the ruler” in the “Preparing for Data 
Collection” chapter if you need help. To remove the ruler, right-click the 
image, point to Cursor Mode and choose Select And Zoom from the pop-
up menu. 
 
You can add annotation to the video image: 
 
1. Right-click the image, point to Cursor Mode and choose Annotation 

from the pop-up menu. 
 
2. Click the desired location in the video image. 

tion is displayed, use Show Video 
nnotation on the Video tab of the Display Setup dialog box. (See “Setting 

 and then click outside the box. 

o 

fr
again. You can also toggle the display of markers by using Show Map 
Markers on the Video tab of the Display Setup dialog box. See “Display
markers” for more information. See “Adding a marker
fo
 
You can measure items in the video image:  Right-click the image, point 
Cursor Mode, choose Ruler from the pop-up menu, and then drag across 
the image to draw a ruler. (The ruler also appears on the contour map.) 
The measured distance appears n
ca
“M

 
3. Type the desired text in the box that appears. 
 
4. Click outside the box. 
 
To specify whether this annota
A
the video annotation parameters” for details.) To delete the added 
annotation, click it while the cursor is in Annotation mode, delete the text 
using the keyboard,
 
Use the Video tab of the Display Setup dialog box to change how the vide
image is displayed. See “Video display parameters” for details. 
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You can overlay the video image with the contour map (or discrete point 
location map) to see spatial relationships between the two. (This feature 
not available for depth profiles.) See “Overlaying the video image and
contour map or discrete point location map” for details. 
 
You can save the video image as a .bmp, .jpg or .tif file by right-clicking th
image and choosing Save f

is 
 

e 
rom the pop-up menu. Specify a file name and 

cation in the dialog box that appears and then choose Save. You can open 
 

 the File menu. See “Saving 
e video image” in the “Preparing for Data Collection” chapter for details. 

Spectral display pane um is selected on the Mapping - General tab of the Display Setup 
ialog box, a spectral display pane appears in the map window or profile 

oss hairs (or other cursor type) on the video image. (In the case of a depth 
e location indicated on 
to the indicated location 

 the 3-D image and contour map (or discrete point location map). 

rent 
r 

you 
video 

g the cross hairs (or other cursor type) to a 
ifferent location or use the arrow keys on the keyboard. 

e 
iew finder and works in a similar manner. By dragging it, you can specify 

he pane may include axis labels depending on the settings of  
X-Axis Label and Y-Axis Label on the Mapping - General tab. See “Setting 
the spectral display parameters” for more information. 

lo
the file later using a program that opens files of its type. You can also save
the video image by using Save Video Image in
th
 
 
If Spectr
d
window. It shows the spectrum collected at the location indicated by the 
rc

profile, the pane shows the spectrum collected at th
e contour map.) This spectrum also corresponds th

on
 
For a line map, area map or discrete point map, you can display a diffe
spectrum by clicking the desired location in the video image, 3-D image o
contour map (or discrete point location map). 
 
For a depth profile, you can display a different spectrum by clicking the 
desired location in the 3-D image or contour map. 
 
You can display multiple spectra by holding down the Shift key while 
click locations. If the contour map (or discrete point location map) or 
pane is active, you can dra
d
 
The vertical line in the pane corresponds to the middle vertical line in th
v
a frequency to use for displaying data in some of the panes. See the 
description of the view finder in “Using map windows” for more 
information. 
 
T
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In the upper-left corner of the pane are the titles of the displayed spectra. 
Here is an example: 

 
 
 

You can remove the spectral display pane 
from the window by right-clicking it and 

then choosing Hide from the pop-up menu. 

 
 
 

Using the 3-D display  you have selected 3-D Image on the Mapping - General tab of the 
  

e image in the direction you want to rotate 
; the image rotates as you move the mouse. Release the mouse button 
hen you have displayed the desired view of the data. If you release the 

, 
 the 

se the 3-D View tab of the Display Setup dialog box to change how the 

 Note  
-up menu. S 

 
3-D image for line 

maps and line depth profiles 
For a line map, the 3-D display shows an image of the map data in these 
three dimensions:  distance in micrometers from the first sample point 
(Distance axis), frequency (Wavenumbers axis) and spectral intensity 
(vertical axis). 
 

If
Display Setup dialog box, the map window or profile window contains a
3-D image. 
 
You can rotate the 3-D image in any direction to see the data from 
different angles. Simply drag th
it
w
mouse button while the mouse is moving (and the image is still rotating)
the image will continue to rotate. This can help you study the shape of
data from all sides. 
 
U
3-D image is displayed. See “3-D View display parameters” for details. 
 
You can remove the 3-D display from the window by right-clicking it and
then choosing Hide from the pop
 
The next sections describe the 3-D image displayed for line maps, area 
maps and depth profiles. 
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For a line depth profile, the 3-D display shows an image of the map data in 
these three dimensions:  distance in micrometers from the zero point 
(Depth axis), frequency (Wavenumbers axis) and spectral intensity (vertical
axis). 

 

ap windows” for more information). The image shows data from the 
ified by the sky view control. 

he following illustration shows an example of a line map 3-D image in the 

-
 image for a line depth profile would be similar, except that the Distance 

 
The use of color in the 3-D image is specified by the color bar (see “Using 
m
portion of the map spec
 
T
form of a surface plot (a warped, interpolated surface) showing spectral 
intensities at different frequency (wavenumber) and distance locations. A 3
D
axis would be labeled “Depth.” 

 

 
 
Line map 3-D image displayed as a surface plot 

 
See “3-D View display parameters” for more information about displaying 
the 3-D image for line maps. 
 
 

3-D image for area 
maps and area depth profiles 

There are two fundamental ways to display a 3-D image for an area map or 
area depth profile: 
 
For an area map you can display a surface plot (select Show Surface in the 
Display Setup dialog box) with these three dimensions:  X position and Y 
position on the microscope stage (the two Position axes) and value (vertical 
axis). The image is essentially a conversion of the contour map to a three-
dimensional form that makes it easier to see the values across the sample. 
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For an area depth profile you can display a surface plot (select Show Surfac
in the Displa

e 
y Setup dialog box) with these three dimensions:  distance 

long the top edge of the mapped vertical area (the Position axis), Z 
 

y peaks can be located. 

ere is an example of an area map 3-D image in the form of a surface plot 
(a warped, interpolated surface) showing values at different locations on the 
sample: 

 

a
position relative to the zero point (the Depth axes) and value (vertical axis).
The image is essentially a conversion of the contour map to a three-
dimensional form that makes it easier to see the values across the vertical 
area of the depth profile. 
 
In addition to representing values by colors, the 3-D image uses surfaces 
within which intensit
 
H

 
 
Area map 3-D image displayed as a surface plot 

 
This type of 3-D image represents a part (or “slice”) of the volume of the 
area map data, with one dimension (frequency) held constant. In the 
example above, the image shows spectral intensities at a single frequency 
(specified by the vertical line in the spectral display pane and view finder). 
 
By selecting Show Full Volume in the Display Setup dialog box, you can 
also display the full volume of the area map or area depth profile: 
 
For an area map this display has these dimensions:  X position and Y 
position on the microscope stage (the two Position axes) and spectral 
frequency (vertical axis). 
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For an area depth profile this display has these dimensions:  X position and
Z position (the two Position axes) and spectral frequency (v

 
ertical axis). 

lor represent areas of similar intensity. 

example of a 3-D image showing full volume: 

 

 
The surfaces displayed in the same co
The values indicated by the colors are specified by the color bar. Here is an 

 
 
Full volume displayed in 3-D image 

 
In both surface-plot and full-volume 3-D images, the image shows data 
from the portion of the map specified by the sky view control. 
 
See “3-D View display parameters” for more information about displaying 
the 3-D image for area maps. 
 
 

Profile panes If Profile is selected on the Mapping - General tab of the Display Setup 
dialog box, the map window or profile window contains one or more 
profile panes. The next sections describe how these panes are used for line 
maps (and line depth profiles) and area maps (and area depth profiles). 
 
You can copy a profile pane to the Windows Clipboard by right-clicking the 
pane and choosing Copy from the pop-up menu. You can then paste the 
image into a spectral window, or into a document using a program that 
pastes items from the Clipboard. 
 
If you have zoomed in on a spatial area using the contour map, video image 
or sky view control, you can redisplay the entire spatial range by right-
clicking a profile pane and choosing Full Range from the pop-up menu. 
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Profile pane for line 
maps and line depth profiles 

 
y at the 

urrent frequency (specified by the middle vertical line in the view finder) 
ersus distance along the line map or line depth profile. Here is an example:

 

If you are displaying a line map or line depth profile, the single profile pane
of the map window or profile window shows spectral intensit
c
v

 
 
Line map profile pane 

 
The X location of the vertical gray line in the profile pane corresponds to 
the location of the current spectrum on the line map or line depth profile. 
 
For a line map this location is indicated by the cross hairs (or other cursor 
type) in the video image (or on the contour map or 3-D image). When you 
click a different location, the line in the profile pane moves accordingly.

 is indicated by the cursor on 
e contour map (or 3-D image). When you click a different location, the 

drag the line in the profile pane to a new location. The other panes 
re updated accordingly. 

 
 
For a line depth profile the spectrum location
th
line in the profile pane moves accordingly. 
 
You can 
a
 
 

Thermo Fisher Scientific OMNIC Atlµs User’s Guide 189 



Displaying Map Data 

Profile panes for area 
maps and area depth profiles 

or an area map, the X-direction profile shows the spectral intensity at the 
er) 

llected at sample points having the same Y coordinate value 
ersus the X coordinate value. Similarly, the Y-direction profile shows the 
ectral intensity at the current frequency of the spectra collected at sample 

the Y coordinate value. 
ere is an example: 

If you are displaying an area map or area depth profile, two profile panes 
are needed. 
 
F
current frequency (specified by the middle vertical line in the view find
of the spectra co
v
sp
points having the same X coordinate value versus 
H

 

 
 
Area map profile panes 

locations of the current spectrum, whose location is indicated by the cross 
hairs (or other cursor type) in the video image. The locations of the lines 
move when you click a different location in the video image. 
 
 

Adjusting 
the display with 

the sky view control 

The sky view control lets you quickly change the display of map data. It is 
filled with an image of the entire contour map (or discrete point location 
map). Within the control is a box that indicates the portion of the map 
data currently visible in some of the other parts of the window. (When you 
first open a map, this box is the same size as the control itself.) The portion 
of the sky view control outside the box is displayed in reverse video colors. 
 

 
The vertical gray lines in the profile panes correspond to the X and Y 
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H e is an example showing how the box in the sky view control indicates
displayed portion of a line map (or line depth profile): 

er  
the 

 
 
 
 
 
 
 
 
 
 
 

Notice that the box in the sky view control 
(at the end of the arrow) corresponds to 

the data shown in the contour map, spectral 
display pane, 3-D image and view finder. 

 

 
 
Line map zoomed in with sky view control 
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Here is an example showing how the box in the sky view control indicates 
e displayed portion of an area map (or area depth profile): 

 
 
 
 
 
 

Notice that the box in the sky view control (at 
the end of the arrow) corresponds to the data 

shown in the contour map and the portion 
of the sample visible in the video image. 

th
 

 

 
 
Area map zoomed in with sky view control 

 
se the instructions that follow to adjust the display using the sky view 

ontrol. 
 
 
Changing a display limit – Drag any side of the box to change the display 
limit that corresponds to that side. 
 
 
Displaying a different area of the same size – There are two ways to do 
this. You can simply drag the box to the desired location. As you drag the 
box, an outline remains in the original location until you release the mouse 
button. 
 
You can also click a point outside the box. The new display area is centered 
(if possible) at the point you clicked. 

U
c
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Ch i  
the box
 
 
Display
inside t
 
 

Zooming in and 
out on map data 

Foll  
 
1. Use

con
 

 Note If a line icon or “T” appears next to the pointer, first right-click the contour 
map (or discrete point location map), point to Cursor Mode and choose 
Sele A
 
 Her
 

ang ng the size and shape of the displayed area – Drag any corner of
 to change either the box’s size or shape or both. 

ing the entire map – To display the entire map, double-click 
he box. 

ow these steps to zoom in on your map data: 

 the mouse to draw a box around the area of interest in the 
tour map (or discrete point location map). 

ct nd Zoom from the pop-up menu. S 

e is an example: 
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 If you are displaying an area map or discrete point map, you can also 
draw a box in the video image. Here is an example showing a box 
drawn around a different area: 

 

  
 
 
2. If desired, drag the handles on the sides or corners of the box to 

adjust its size and shape. 
 
 
3. Click inside the box. 
 
 The area expands and the 3-D image and spectral display pane change 

to reflect the new display limits. 
 
 To redisplay the full data range, right-click the 3-D image, video image, 

spectral display pane, profile pane or contour map (or discrete point 
location map) and then choose Full Range from the pop-up menu. If 
the video pane contains a Mosaic, the entire Mosaic is displayed when 
you choose Full Range. 

 
 Note You can also use the spectral display pane, sky view control or view finder 

to expand an area of map data. For details see “Zooming in on an area in 
the spectral display pane” or “Adjusting the display with the sky view 
control” in this chapter or “View finder” in the OMNIC Help system (find 
“view finder” in the Help system Index). S 

194 OMNIC Atlµs User’s Guide Thermo Fisher Scientific 



Displaying Map Data 

Zooming in on
the spectra

oint 
 in the pop-up menu and then choose Zoom. You can 

then draw a box in the pane. 

 Here is an example: 
 

 

 an area in 
l display pane 

Follow these steps to zoom in on an area in the spectral display pane: 
 
1. Use the mouse to draw a box around the area of interest in the 

spectral display pane. 
 
 If the cursor is in region mode (two vertical lines with triangular 

handles appear in the pane), first right-click anywhere in the pane, p
to Cursor Mode

 

 
 
 
2. Click inside the box. 
 
 The boxed area expands to fill the pane: 
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• If you are displaying a line map or line depth profile, the contour 
map, 3-D image, view finder and sky view control also change to 
reflect the new frequency limits. The vertical gray line in the 

 

vertical gray line in the spectral display pane moves if necessary to 

 
• If you are displaying a discrete point map, the view finder also 

changes to reflect the new frequency limits. The vertical gray line in 
the spectral display pane moves if necessary to be visible within the 
displayed spectral region. 

 
 To redisplay the full data range, right-click the 3-D image, video image, 

spectral display pane, profile pane or contour map (or discrete point 
location map) and then choose Full Range from the pop-up menu. If 
the video pane contains a Mosaic, the entire Mosaic is displayed when 
you choose Full Range. 

 
 

Animating your 
view of the map data 

Choose Animation from the Atlµs menu to see an animated display of the 
changes that occur in your area map data as the spectral frequency changes. 
The command automatically moves the middle vertical line in the view 
finder to the right, stepping through the displayed frequency range of the 
data. The contour map, 3-D image and profiles (if displayed) change to 
reflect the new frequency. 
 
To change the speed of movement, drag the vertical bar left or right along 
the Animation Speed control below the view finder. 

 

spectral display pane moves if necessary to be visible within the
displayed spectral region. If it moves, the profile pane changes to 
reflect the new frequency location of the line. 

 
• If you are displaying an area map or area depth profile, the  

3-D display also changes to reflect the new frequency limits. The 

be visible within the displayed spectral region. If it moves, the 
contour map, sky view control and profile panes change to reflect 
the new frequency location of the line. 

 
 

196 OMNIC Atlµs User’s Guide Thermo Fisher Scientific 



Displaying Map Data 

To stop the animation, press the Esc key on the keyboard, click anywhere 
within the view finder, or choose Animation again. This removes the check 

ark from in front of the command name. 

 
Copying the 3-D image, 
video image, displayed 
spectra or contour map 

ou can copy to the Windows Clipboard the 3-D image, the video image, 
e spectral display pane or all the 

ectra in the pane, or the contour map (or discrete point location map). 

tral display pane, first 
hoose Select All from the Edit menu. You can then paste the copied item 

m
 

Y
the last spectrum to be displayed in th
sp
Simply right-click the item you want to copy and choose Copy from the 
pop-up menu. To copy all the spectra in the spec
c
into programs that allow pasting from the Clipboard. If you copy spectra, 
you can paste them into a spectral window. 
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Viewing 
information 

about a map 

If a map window is active, you can use Show Map Info in the Atlµs men
to view information about the map, including how it was collected. You 
can also change the title of the m

u 

ap, enter comments about the map or 
py or print the map information. 

The information is displayed in the Collection And Processing Information 
window. Here is an example showing the special mapping information 
scrolled into view: 

 
 
 
 
 
 
 
 
 
 

This is essentially the same window that 
appears when you click the Information 

button (“i”) in a spectral window or double-
click a spectrum title in the title box. 

co
 

 
 
For more information about this window, choose OMNIC Help Topics 
from the Help menu, find “collection and processing information” in the 
Index and go to the “Collection and processing information” topic. 
 
Follow these steps to view information about a map: 
 
1. Choose Show Map Info from the Atlµs menu. 
 
 The Collection And Processing Information window appears. 
 
 
2. To change the map title, edit the title directly in the Title text box. 
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3. To see information about the map, use the scroll bars to scroll the 
desired information into view. 

 
 You can copy all the information in the window to the Windows 

g 

 
rint. 

lose 
hanges you made, or choose Cancel to 

close the window without saving your changes. 

Clipboard by choosing Copy. You can then paste the information usin
another Windows application that uses the Clipboard. 

 
 You can print all the information on the default system printer by

choosing P
 
 
4. When you are finished viewing the information, choose OK to c

the window and save any c
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Viewing 
information 

about a profile 

ut 
the active profile window. Here is an example: 

Choose Show Profile Info from the Atlµs menu to view information abo
the profile in 

 

 
 
To close the dialog box, choose OK. 
 
For information about creating a profile, see “Creating a profile” in the 
“Processing and Analyzing Map Data” chapter. 
 
For information about displaying the current profile for an area map, see 
“Displaying the current profile or a saved profile” in the “Displaying Map 
Data” chapter. 
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Viewing information 
about quantitative 

analysis results 

If the active window displays the results of quantifying a map, you can 
choose Show Quant Info from the Atlµs menu to view information about 
the results. Here is an example: 

 

 
 
To close the dialog box, choose OK. 
 
For information about quantifying a map, see “Quantifying a map” in the 
“Processing and Analyzing Map Data” chapter. 
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Setting the 
display parameters 

Use Display Setup in the View menu to specify how to display data in the 
active map window, profile window or PCA result window. Other windows 
o  n
 

 Note If you choose Display Setup when a spectral window is active, the dialog 
box contains only parameters that are appropriate for a spectral window. In 
OMNIC Help Topics find “display parameters” in the Index and go to 
“Setting the display parameters” for information about setting those 
p  

 
You can set some o
“Setting the mapp
chapter for more i
 
Follow the steps below to set the display parameters for the active map 
window or profile window. The next sections describe the parameters in 
detail. 
 
1. Choose Display Setup from the View menu. 
 
 The Display Setup dialog box appears. See the next section for an 

illustration. 
 
 
2. Set the display parameters. 
 

. Choose OK. 
 
 

n the screen are ot affected. 

arameters. S

f the display parameters before map collection. See 
ing options” in the “Preparing for Data Collection” 
nformation. 

 
3
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Mapping – General 
display parameters 

This section explains the display parameters available on the Mapping - 
General tab: 
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Specifying the items to display Select the items in the Map Window Layout box that you want display
in the active map window or profile window. The table below describes th
available items and shows examples. Each item is displayed in its own pane, 
whose size and shape you can adjust (see “Using map windows”). 
 

ed 
e 

 
Select this… To display this… 

Spectrum Spectral display pane containing the map spectrum tha
corresponds to the specified location in the video image 

 

 
t 

or contour map (or discrete point location map). 

 

 
 

Video Image Video image or Mosaic of the sample. This item is 
available only if a video image or Mosaic was captured 
and saved with the map. 

 

 

 

204 OMNIC Atlµs User’s Guide Thermo Fisher Scientific 



Displaying Map Data 

Select this… To display this… 

Contour Map Line contour map, area contour map, depth profile 
contour map, or discrete point location map. 

 

 
 

3-D Image 3-D image of map data. This item is not available 
discrete point maps, since they are collected at 
individually specified sample points that may not be 
uniformly spaced. 

 

for 
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Select this… To display this… 

Profile Profile or profiles of the map data. This item in not 
available for discrete point maps. 
 

 
 

 
 

Selecting a color scheme Specify a color scheme for your contour map (or discrete point location 
map) and 3-D image by selecting an option in the Color Scheme box. The 
table below describes how each option represents values. 
 
 

Color Scheme Description 

Gray Scale Uses shades of gray along a gradient to represent values. 
This option is useful for printing contour maps (or 
discrete point location maps) and 3-D images on a black-
and-white or gray-scale printer. Since the values change as 
the gray shades become darker, it is easy to identify areas 
of relative low and high value on the printed map or 
image. If you print a colored contour map (or discrete 
point location map) or 3-D image on the same printer, 
however, the darkness of the resulting printed gray shades 
will not necessarily correlate with the values. A color that 
represents a high value, for example, may appear as a light 
gray on paper. This option is also useful for seeing 
contrast in the display of data. 

Rainbow Uses a gradient of blended rainbow colors to represent 
values. 

Banded Uses bands of colors, rather than a gradient of blended 
colors, to represent values. 

Blue To Red Uses blended colors from blue to red to represent values. 

Green Uses blended shades of green to represent values. 
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Sp
an

ecifying the background 
d foreground thresholds 

 

Background Threshold and Foreground Threshold let you specify the
limits of the value range used for the colors in the contour map and 3-D 
image. Type the desired limits in the text boxes. The limits must be within 
the range specified in the Color Limits box. See “Setting the color limits” 
for details. 

 

or a line map, line depth profile or discrete point map the Background 
Threshold value represents the minimum spectral intensity, and the 
Foreground Threshold value represents the maximum spectral intensity. 
 
For an area map or area depth profile the Background Threshold value 
represents the minimum value of the specified type, and the Foreground 
Threshold value represents the maximum value of the specified type. 
 
You can also set the range by dragging the vertical bars on the color bar. 
See “Using map windows” for more information. 
 
ee the next section for setting the thresholds automatically. 

Setting the 
thresh

 
F

S
 
 
S

olds automatically 

 

elect Auto Threshold if you want the background and foreground 

Process a map using a command in the Process menu. 
 
• Truncate the spectral range of a map using Truncate Data Set in the 

Atlµs menu. 
 
• Create an area map profile using Profile Setup in the Atlµs menu. 
 

 Note You can also select this option by right-clicking the contour map and then 
choosing Auto Threshold from the pop-up menu. S 

 
 

thresholds automatically adjusted to provide the most variation whenever 
you perform any of the following operations: 
 
• 
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Setting the spectral 
display parameters 

 

Select X-Axis Label and Y-Axis Label if you want the X-axis and Y-axis of 
the spectral display pane to be labeled with their units. 
 
Select Continuous Update if you want the data in the affected panes to be
updated while you move the middle vertical line in the view finder or the
vertical line in the spectral disp

 
 

lay pane. (See the description of the view 
nder in “Using map windows” for more information.) If this option is not 
lected, the affected panes are updated when you release the mouse button 

The color in the box to the right of Change Spectrum Color To shows the 
color used for displaying the selected spectrum in the spectral display pane. 

o change the color, click the box. The Color dialog box (a Windows 
ature) appears allowing you to select a color. If you need help using the 

of 

Setting the color limits 

fi
se
after dragging the line. 
 

T
fe
features in this dialog box, click the “?” button and then click the feature 
interest. When you are finished selecting a color, choose OK. 
 
 
Use Minimum and Maximum in the Color Limits box to specify the rang
f available values for the color bar. Typ

 

e 
e the desired minimum and 

aximum values in the appropriate text boxes. See “Using map windows” 
r information about how the color bar uses this range. See “Specifying the 

background and foreground thresholds” for information about setting the 
l  value 
image. 
 
 

Inverting the color scheme 

o
m
fo

imits of the range used for the colors in the contour map and 3-D 

You can reverse the order of the colors in a color scheme by selecting Invert 
Color Scheme. 
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2-D View 
display parameters 

This section explains the display parameters available on the 2-D View tab:

 

 
 
 

Selecting the 
resolution for the contour map 

If you are using linear or spline smoothing (see the next section), specify the 
resolution for the contour map by setting Resolution. Increasing the 
resolution increases the degree of detail and smoothness of the map, but the 
software may respond more slowly when you change the display of data. (If 
you are displaying a discrete point location map, this parameter has no 
effect.) 
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Selecting the smoothing 
type for the contour map 

Specify the type of smoothing to use for the contour map by setting 
Smoothing. The Spline setting results in greater smoothing than the Linear 
setting. Select None if you don’t want to smooth the map. See the examples
below. (If you are disp

 
laying a discrete point location map, this parameter 

as no effect.) 
 

h

 

   
 
None Linear Spline 
 
 

Selecting a cursor 
style for the contour map or 
discrete point location map 

 

Specify a cursor style for the contour map (or discrete point location map) 
by selecting an option in the Cursor Style box. The available styles are 
shown below. 

 

   
 
2-D Cross  Cross Hairs Target 
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Specify

point location map cursor

ing a color for 
the contour map or discrete 

 

The color in the box to the right of Cursor Color shows the color used 
display the contour map (or discrete point location map) cursor. To chang
the color, click the box. The Color dialog box (a Windows feature) appe
letting you select a color. If you need help using this dialog box, c

 

to 
e 

ars 
lick the 

?” button and then click the feature of interest. When you are finished 
lecting a color, choose OK. 

Hiding the 
contour map or discrete 

point location map cursor 

“
se
 
 

 

If you want to hide the cursor for the contour map (or discrete point 
location map), select Hide Cursor. 

 
 

Setting the contour parameters The features in the Contour Map box let you specify how to display the 
he table below describes the available settings of Options 

d shows examples of the map elements they display. (The settings do not 

colors representing spectral intensities.) 
 
 

contour map. T

 

an
affect points in a discrete point map, which are always displayed in solid 

Select this… To display this… 

Color Fill 
Only

 

Areas of solid color without lines separating the areas. 

 

 
 

For a line map or line depth profile the areas represent 
ranges of spectral intensity. 

For an area map or area depth profile the areas 
represent the specified type of value. 
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Select this… To display this… 

Contour Lines 
Only 

Colored contour lines (“isolines”) with the areas 
between the lines not filled with color. 

 

 
 

For a line map or line depth profile the lines represent 
single spectral intensities. 

For an area map or area depth profile the lines represent 
pecified type of value. the s

Contour Lines Areas of solid color with black lines separating the areas.
And Color Fill  

 
 

For a line map or line depth profile the areas represent 
ranges of spectral intensity. 

For an area map or area depth profile the areas 
represent the specified type of value. 
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Type the desired number of contours in the Number Of Contours text 
box. Increasing the number of contours makes the change in contour value 

f shapes in the map. 

Preserving the X-Y proportion 

from one location to another appear more gradual and smoothes the edges 
o
 
 
Select Preserve X-Y Proportion if you 

 

want the shape of the contour map 
r discrete point location map) maintained when you resize the map (by 

dragging the borders of its pane or by resizing the map window or profile 
window). If this option is not selected, the height and width of the map can 
change independently when you resize the map. 
 
 

3-D View 
display parameters 

This section explains the display parameters available on the 3-D View tab:

 

(o
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Selectin
resolution of the 3-D image 

g the Specify the relative resolution of the 3-D image by setting Resolution. 
Increasing the resolution increases the degree of detail and smoothness
the image.

 

 of 
 However, this can slow the rendering of the image and your 

teractions with it (such as zooming in and rotating the image). 

opacity of the 3-D image

in
 
 

Setting the 
 

Set the opacity of the 3-D image by typing a number from 0 to 100 in the 
text box in the Opacity box or by dragging the small vertical bar below the 

xt box to the left or right. Reducing the opacity lets you see peak shapes 
rough other, closer peaks as though they were translucent. The 

te

 

th
illustrations below show the effects of changing the opacity from 100% to 
50%. 

 

 
 
100% opacity 
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50% opacity 

Selecting a cursor 
style for the 3-D image 

 
 
Specify a cursor style for the 3-D image by selecting an option in the 

ursor Style box. The Wireframe Planes option displays outlines of three 

 

ursor location and extension lines that connect those lines to 
e axes. These cursor styles are shown below. 

 

C
imaginary orthogonal (perpendicular) planes that intersect at the cursor 
location. Perpendicular lines that pass through that location appear as well.
The Extended Cross Hairs option displays perpendicular lines that pass 
hrough the c t

th

     
 
Wireframe planes 
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Extended cross hairs 
 
 

Selecting a navigation mode The Navigation Mode options let you specify a method for manipulating 
the 3-D image. The table below describes the available options. 
 
 

Option How to Manipulate the 3-D Image 

Rotate To rotate the image, drag an edge or corner as though you 
 image. 
e point, 

the image continues to move in an “animated rotation.” 

 

were swinging that point around the center of the
If you release the mouse button while dragging th

To stop this rotation, click the image. 

Combined In addition to the manipulation techniques described for 
the Rotate option, you can drag vertically across the image 
with the right mouse button held down to enlarge or 
shrink the image. You can also hold down the Shift key 
and drag the image in any direction to move it within the 
pane (as you can with the Pan option). 

Zoom To enlarge or shrink the image, drag vertically across it. 

Pan Drag the image in any direction to move it within the 
pane. 

 
 
In all modes you can enlarge or shrink the image by pointing at it and 
turning the mouse wheel (if present). 
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 Note  3-D image, 
ointing to Navigation Mode and choosing a mode from the pop-up 

S 

Displaying the 3-D 
image in perspective 

You can also specify a navigation mode by right-clicking the
p
menu. 

 
Select Perspective if you want the 3-D image displayed in perspective (with 
fo

 

reshortening that creates the illusion of depth). 

Clipping the data 
outside the color range 

 
 
Select Clip Data Outside Color Range if you want data outside the spectral 

tensity range specified by the color bar not to be displayed in the 3-D 
age. (This option does not effect the 3-D image if Show Full Volume is 

he illustrations below show a 3-D image before and after being clipped. 

in
im

 selected.) This results in the display of only the data in the intensity range 
of interest. 
 
T
Note that the spectral intensity range specified by the color bar in the first 
illustration is narrower than the full intensity range of the map data. This 
lets you see more color gradations, and thus more detail, in the intensity 
range of interest. In the second illustration the new color bar range matches 
the narrowed spectral intensity range. 

 

 
 
3-D image before clipping 
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Clipped 3-D image 

Displaying an outline box 

 
 
Select Show Outline Box if you want the outer limits of the 3-D image to 
e indicated by lines that form a bounding box around the image. Here is 
 example: 

b
 an

 

 
 
 

Displaying the map 
title above the 3-D image 

Select Show Title if you want to display the map title above the 3-D image 
in a map window, or the profile type above the 3-D image in a profile
window. You can change the title by using Show Map Info in the Atlµs 
menu. See “Viewing information about a map” for more information. 
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Displaying 
surfaces in the 3-D image 

Select Show Surface if you want to display map data in the form of a 3-D 
image that appears as a surface plot (a warped, interpolated surface). 
 
For a line map (or line depth profile) each point o n the surface of the plot 

presents the spectral intensity value at a particular frequency and distance 

or an area map (or area depth profile) each point on the surface represents 
e value of the specified type at an X-Y location on the sample (or X-Z 

 
 
 
 
 

You can also specify this type of 
display by right-clicking the 3-D image, 
pointing to 3-D Display and choosing 
Show Surface from the pop-up menu. 

re
along the line on the sample (or within the sample). 
 
F
th
location within the sample). 
 
Here is an example showing the 3-D image of a line map: 

 

 
 
3-D image of two-dimensional data displayed as a surface plot 

 
 Note You cannot select both Show Surface and Profile Lines. See “Displaying 

rofile lines in the 3-D image” for information about using Profile Lines. S 

Displaying the 3-D 
image as a wireframe 

p
 
 
Select Wireframe if you want to display map data in the form of a 3-D 
image that appears as a wireframe surface plot, with lines connecting poi
having the same vertical-axis value. This is similar to the surface plot
displayed by the Show Surface option, except gaps appear between the
wireframe lines. (If you are displaying an area map or area depth profile a
have selec

nts 
 

 
nd 

ted both Wireframe and Show Surface, the wireframe is overlaid 
n the surface plot.) See “Displaying surfaces in the 3-D image” for more 

information. 
 

 

o
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Here is an example showing the 3-D image of a line map: 

 

 
 
3-D image of two-dimensional data displayed as a wireframe surface plo

 
If you are displaying an area map or area depth profile, Wireframe is 
available 

t 

 Note 
only if you have not selected Show Full Volume. See “Displaying 

e full volume of the 3-D image” for information about using Show Full 

Smoothing the 3-D image 

th
Volume. S 

 
 
Se

 

lect Smoothing if you want the 3-D image to have smoother edges and 

Displaying the full 
volume of the 3-D image 

more blended color transitions. 

 
 
If you are displaying an area map or area depth profile, you can select Show 
Full Volume to display the full volume of the three-dimensional data, using 
iso-surfaces that are similar to two-dimensional contour lines. This shows 
where the volume data crosses intensity grade value thresholds. The setting 
of Number Of Iso-surfaces determines the number of grades (iso-surfaces) 
to display. See “Setting the number of iso-surfaces or contours to display” 
for more information. 
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In the example below, the X position and Y position on the microscope 
stage are indicated by the two Position axes and frequency is indicated by 
the vertical axis. Values (such as spectral intensity) are indicated by colors, 
as specified by the color bar. 

 
 
 
 
 

You can also specify this type of 
display by right-clicking the 3-D image, 
pointing to 3-D Display and choosing 

Show Full Volume from the pop-up menu. 

 
 
Full volume displayed in 3-D image 

 Note  you select Show Full Volume, Wireframe is not available. See 
reframe” for information about using 

ireframe. S 

the 3-D image cursor 

 
If
“Displaying the 3-D image as a wi
W
 
 

Specifying a color for The color in the box to the right of Cursor Color shows the color used to 
display the 3-D image cursor. To change the color, click the box. The 
Color dialog box (a Windows feature) appears allowing you to select a 
color. If you need help using the features in this dialog box, click the “?
button and then click the feature of interest. When you are finished 
selecting a color, choose OK. 

 ” 

Hiding the 3-D image cursor 

 
 

 

If you want to hide the cursor for the 3-D image, select Hide Cursor. 

 
 

Setting the number of iso-
surfaces or contours to display 

 

If Show Full Volume is selected, the Number Of Iso-surfaces parameter is 
available. Specify the number of iso-surfaces to display in the 3-D image by 
typing a number in the Number Of Iso-surfaces text box or by clicking the 
up and down arrows to the right of the text box. An iso-surface is an 
intensity value grade, a generalization of the two-dimensional contour line. 
It shows where the volume data crosses an intensity grade value threshold. 
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If Show Full Volume is not selected, the Number Of Contours parameter 
 available. Specify the number of contours to display in the 3-D image by 

p and down arrows to the right of the text box. 

r information about 
sing Show Full Volume. 

lines in the 3-D image 

is
typing a number in the Number Of Contours text box or by clicking the 
u
 
See “Displaying the full volume of the 3-D image” fo
u
 
 

Displaying profile 

 

Select Profile Lines if you want profile lines representing values of constant 
grade to appear in the 3-D image. This gives the image the appearance o
having been sliced with equally spaced imaginary planes. Here is an 
example showing a line map with

f 

 the profile lines in the X-Z plane: 

 

 
 
3-D image of line map data with profile lines 

 
Use Profile Orientation to specify the orientation of the lines; that is, in 
which plane the lines lie. Use Number Of Profiles to set the number of 
profile lines. See “Specifying the orientation of the profile lines” for 
information about using Profile Options. See “Setting the number of 
profile lines in the 3-D image” for information about using Number Of 
Profiles. 
 

222 OMNIC Atlµs User’s Guide Thermo Fisher Scientific 



Displaying Map Data 

The illustration below shows an example of the 3-D image of an area m
with Show Full Volume selected. The colors of the profi

ap 
le lines indicate 

lue. See “Displaying the full volume of the 3-D image” for information 
out using Show Full Volume. 

 

va
ab

 
 
3-D image of area map data showing full volume 

 Note elect both Show Surfa rofile Lines. See “Displaying 
rfaces in the 3-D image” for information about using Show Surface. S 

 
 

Specifying the 
orientation of the profile lines 

 
You cannot s ce and P
su

 

If you have selected Profile Lines to display profile lines in the 3-D image, 
specify the orientation of the lines by setting Profile Orientation. The 
following illustrations show the available orientations:  X-Z Plane, X-Y 
Plane and Y-Z Plane. Use Number Of Profiles to specify how many profile 
lines appear in the image. See “Displaying profile lines in the 3-D image” 
for information about using Profile Lines. See “Setting the number of 
profile lines in the 3-D image” for information about using Number Of 
Profiles. 
 

 Note If profile lines with X-Y orientation were projected onto the same 
horizontal plane, the lines would match the contour lines in the contour 
map, if displayed. S 
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Profile lines with X-Z orientation 

 

 
 
Profile lines with X-Y orientation 
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Profile lines with Y-Z orientation 
 
 

Setting the number of 
profile lines in the 3-D image 

If you have selected Profile Lines to display profile lines in the 3-D image, 
ecify the number of lines by typing a number in the Number Of Profiles 
xt box or by clicking the up and down arrows to the right of the text box. 

plan ile lines in the 3-D image” for 
formation about using Profile Lines. See “Specifying the orientation of 

sp
te

 
Use Profile Orientation to specify the orientation of the lines (in which 

e the lines lie). See “Displaying prof
in
the profile lines” for information about using Profile Orientation. 
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Video display parameters 
 
The video display parameters appear on the Video tab: 

 
 
The next sections explain how to use these features. 
 
 

Changing the 
brightness and contrast 

 

Use Gamma to improve the appearance of the video image. (The term 
“gamma” refers to part of a mathematical expression relating the input and 
output signals of a display device.) Drag the vertical bar to the right to 
increase brightness and reduce contrast; drag the bar to the left to reduce 
brightness and increase contrast. 
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Selecting a cursor 
style for the video image 

Specify a cursor style for the video image by selecting an option in the 
sor Style box. The available styles are shown below. Cur

 

 

     
 
Solid Cross  Focus 

 

     
 
Hollow Cross  Cross Hairs 
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Setting the video 
annotation parameters 

If you want annotation to be visible in the video image, select Show Video 

 

Annotation. This allows you to set the other parameters in the Video 
ion box. 

If you want the connecting lines for text annotation to appear in the video 
image, select Connecting Lines. See “Connecting text annotation with a 
line” and “Adding text annotation” in the “Preparing for Data Collection” 
chapter for information about creating text annotation that is connected 
with lines. 
 
If you want the border of text annotation to appear in the video image, 
select Border. See “Displaying a border around text annotation” for more 
information. 
 
To change the color of displayed video annotation, click the Annotation 
Color box. The Color dialog box (a Windows feature) lets you select a 
color. If you need help using the features in this dialog box, click the “?” 
button and then click the feature of interest. When you are finished 
selecting a color, choose OK. 

 
 

Displaying markers 

Annotat
 

 

Select Show Map Markers if you want markers added with the marker tool 
to appear in the video image. You can also toggle the display of markers by 
right-clicking the video image and choosing Show Markers from the pop-up 
menu. See “Adding a marker” in the “Preparing for Data Collection” 
chapter for information about adding markers. 
 
 

Specifying colors for the 
video image cursor and markers 

 

 

The color in the box to the right of Cursor Color shows the color used to 
display the video image cursor. To change the color, click the box. The 
Color dialog box (a Windows feature) appears allowing you to select a 
color. If you need help using the features in this dialog box, click the “?” 
button and then click the feature of interest. When you are finished 
selecting a color, choose OK. 
 
The color in the box to the right of Marker Color shows the color used to 
display markers in the video image. To change the color, use the same 
technique as described above for the cursor color. For more information 
about markers, see “Adding a marker” in the “Preparing for Data 
Collection” chapter. 
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Setting the 
display limits data in the active map window or profile window. Follow these steps: 

. 
 
 ts dialog box appears: 

 
 
 
 

The X Range and Y Range 
features in the Map View Ranges 

box are available only for area maps. 
The Map View Ranges features are 

not available for discrete point maps. 

Use Display Limits in the View menu to specify the axis display limits for 

 
1 Choose Display Limits from the View menu. 

The Display Limi
 

 
 
 
2. Type the desired frequency limits in the X Limits Start and End text 

boxes in the Spectral Limits box. 
 

 Note You can also use the view finder to change the frequency limits. See “Using 
map window” for details. S 
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 For a line map (or line depth profile) this sets the display limits for the
frequency axes of the contour map (and corresponding area

 
 of the sky 

view control), spectral display pane, 3-D image and white area of the 

 

 

view finder, as indicated by the arrows in the illustration below: 

 

 
 
Line map (and line depth profile) frequency axes 
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 For an area map (or area depth profile) this sets the display limits for 
the X-axis of the spectral display pane and white area of the view finder, 
as indicated below: 

 

 

 

 
 
Area map (and area depth profile) frequency axis 

 Note If you have selected Show Full Volume on the 3-D View tab of the Display 
etup dialog box, the entered frequency limits also determine the spectral 

ima
“Displaying the full volume of the 3-D image” for information about using 

 

S
range of area map (or area depth profile) data that is visible in the 3-D 

ge, without changing the limits of the image’s vertical axis. See 

Show Full Volume. S 

 

Thermo Fisher Scientific OMNIC Atlµs User’s Guide 231 



Displaying Map Data 

 For a discrete point map this sets the display limits for the X-axis of the 
spectral display pane, as indicated below: 
 
 

 

  
 
Discrete point map frequency axis 
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3 Type the desired spectral intensity limits in the Y Limits Start and
End text boxes in the Spectral Limits box. 

For a line map (or

.  

 
  line depth profile) this sets the display limits for the 

vertical axis of the spectral display pane, 3-D image and profile pane, as 
indicated below: 

 
 

  
 
Line map (and depth profile) spectral intensity axes 
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 For an area map (or area depth profile) this sets the display limits fo
the Y-axis of the spectral display pane, as indicated below: 

 

r 

 

  
 
Area map (and area depth profile) spectral intensity axis 
 

234 OMNIC Atlµs User’s Guide Thermo Fisher Scientific 



Displaying Map Data 

 For a discrete point map this sets the display limits for the Y-axis of the
spectral display pane, as indicated below: 

 
 

 

  
 
Discrete point map spectral intensity axis 

. If you are setting the display limits for a discrete point map, choose 

e Map View Ranges box. 
 
For an area map or area depth profile, type the X distance limits in 
the X Range Start and End text boxes in the Map View Ranges box. 

 

 
 

4
OK; the procedure is finished. 

 
 For a line map or line depth profile, type the distance limits in the 

Distance Start and End text boxes in th
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 For a line map (or line depth profile) this sets the display limits for the 
distance axis of the contour map (and corresponding area of the sky 
view control), video image, 3-D image and profile pane, as indicat
below: 

ed 

 

 

 

 
 
Line map (or depth profile) Y (or Z) spatial axes 
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 For an area map (or area depth profile) this sets the display limits for 
the X distance axis of the contour map (and corresponding area of the
sky view control), video image, 3-D image and X-profile pane, as 
indicated below: 

 

 

 

 

 
 
Area map (and area profile) X spatial axes 
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5. If you are setting the display limits for a line map or line depth 
profile, choose OK; the procedure is finished. If you are setting the 
limits for an area map or area depth profile, type the Y (or Z) 
distance limits in the Y Range Start and End text boxes in the Map 
View Ranges box. 

 
 This sets the display limits for the Y (or Z) distance axis of the contour 

map (and corresponding area of the sky view control), video image,  
3-D image and Y-profile pane, as indicated below: 

 

 

 

 
 
Area map (or area depth profile) Y (or Z) spatial axes 

 
 
6. Choose OK. 
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Displaying the
current profile 

or a saved profile 

 Show 
ed 

 data collection or created and saved after collection. You can 
ulate the display of the data (for example, by using Display 

etup in the View menu). You cannot process the data using the Process 
enu commands. 

g 
dow, click the Close button 

abeled “X”) in the upper-right corner. 

nu 
 

. Choose Show Current Profile from the Atlµs menu. 

ou have not save with the map, the current profile 
 e 
sa

 
2. Select the desired profile from the drop-down list box. 
 
 
3. Choose OK. 

s 

 

 If you are displaying an area map or area depth profile, you can use
Current Profile in the Atlµs menu to display a profile that was creat
during map
then manip
S
m
 
Profiles are displayed in a profile window, which is very similar to a map 
window. See “Using map windows” for information about manipulatin
the parts of the window. To close the win
(l
 
If a map window is displayed, you can use Profile Setup in the Atlµs me
to create a new profile and save it with the map. See “Creating a profile” in
the “Processing and Analyzing Map Data” chapter for details. 
 
Follow these steps to display a profile: 
 
1
 
 If y d multiple profiles 

appears in a profile
profiles have been 

 

window and the procedure is finished. If multipl
ved, the Select Profile dialog box appears. 

 
 The profile appear
 

in a profile window. 
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Overlaying th
 

 or d
point location map 

end 2-D And Vid nu to view an image formed by 

 m
 m es. 

 
 Note You cannot overlay the video image for a depth profile. 

 
Follow these steps: 
 
1. Choose Blend 2-D 
 
 The Blend 2-D And Video window appears: 
 

 

e video Use Bl

image and
map

contour 
iscrete 

overlaying the contour map or discrete point location map and video image 
displayed in the active
relationships between

eo in the Atlµs me

ap window. This makes it easy to see spatial 
ap and video image featur

S 

And Video from the Atlµs menu. 

 
 
 The map and video image appear overlaid, with reduced opacity. This 

lets you see features of both. 
 
 By dragging the vertical bar along the Blending Proportion control, you 

can adjust the contribution each image makes to the overlaid image. 
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 You can zoom in on an area of interest by using the mouse to draw a 
box around the area and then clicking inside the box. If desired, drag 
the handles on the sides or corners of the box to adjust its size and 
shape before clicking inside it. To return the overlaid image to its 
original size, double-click it. 

 
 You can copy the blended image to the Windows Clipboard by clicking 

the Copy button. You can then paste the image using another 
Windows application that uses the Clipboard. 

 
 You can print the blended image by clicking the Print button. 
 
 
2. To close the window, click the Close button. 
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 Processing and Analyzing Map 
Data 
 
 
This chapter explains how to process map data displayed in a map window. 
After you have processed a map, you can save your changes with Save Map 
or Save Map As in the File menu. See the “Saving and Exporting Map 
Data” chapter for complete information. 
 
 

Creating a profile Use Profile Setup in the Atlµs menu to create a new profile from a line 
map, area map or depth profile displayed in the active map window. The 
term “profile” is used to refer to any of the ways of representing map data 
described in the table below and in the next section. The table also 
describes the information you need to specify for each profile type. The 
numerical values shown are just examples. 
 
 

Profile Type What the Profile Shows Needed Information 

Chemigram The integrated spectral intensity of a 
specified spectral region for each 
sample point. 

The frequency limits of the spectral region and 
baseline endpoints: 

 

 
 

Profiles created using the Chemigram and Peak 
Area Of One Peak profile types are identical. 

Peak Height Of 
One Peak 

The corrected height of the specified 
peak for each sample point. 

The frequency location of the peak and the 
baseline endpoints: 
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Profile Type What the Profile Shows Needed Information 

Peak Height Ratio 
Of Two Peaks 

The ratio of the corrected heights of 
two specified peaks for each sample 
point. 

The frequency locations of the two peaks and 
their baseline endpoints: 

 

 

The parameters for the peak whose height will be 
the numerator in the ratio are labeled “Ratio 
Numerator”; the parameters for the denominator 
peak are labeled “Ratio Denominator.” 

Peak Area Of One 
Peak 

The corrected area of the specified 
peak for each sample point. 

The frequency limits of the peak and baseline 
endpoints: 

 

 
 

Profiles created using the Chemigram and Peak 
Area Of One Peak profile types are identical. 

Peak Area Ratio Of 
Two Peaks 

The ratio of the corrected areas of 
two specified peaks for each sample 
point. 

The spectral regions of the two peaks and their 
baseline endpoints: 

 

 

The parameters for the peak whose area will be 
the numerator in the ratio are labeled “Ratio 
Numerator”; the parameters for the denominator 
peak are labeled “Ratio Denominator.” 
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Profile Type What the Profile Shows Needed Information 

Functional Group The correlation between the 
integrated spectral intensities of the 
map spectra and the weighted 
intensities of the selected functional 
group within the spectral regions 
specified for the group. This lets you 
quickly find the locations on the 
sample where absorptions most 
characteristic of the functional group 
occurred. 

Turn off Auto Threshold and set 
Background Threshold to 0 and 
Foreground Threshold to 1 in the 
Display Setup dialog box before 
creating this profile type. See “Setting 
the thresholds automatically” and 
“Specifying the background and 
foreground thresholds” in the 
“Displaying Map Data” chapter for 
more information. 

The identity of the functional group. 

To specify a predefined functional group (a set of 
more than fifty functional groups is provided with 
the software), select the Predefined Groups option 
and then select a group from the Functional 
Group drop-down list box and a type from the 
Type drop-down list box. The available types 
depend on the functional group you have selected. 

 

 
 

To specify a functional group you have defined 
using Edit Functional Groups in the Atlµs menu, 
select the User-Defined option and then select a 
group from the Functional Group drop-down list 
box. (The Type drop-down list box is not 
available for user-defined groups.) 

 

 
 

See “Viewing, editing or creating functional 
groups” in the “Processing and Analyzing Map 
Data” chapter for details on defining your own 
functional groups. 
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Profile Type What the Profile Shows Needed Information 

Correlation Map The correlation between the map 
spectra and the specified reference 
spectrum. This lets you find the 
locations of the reference compound 
(or similar compounds) on the 
sample. The resulting correlation 
intensity values of the map spectra 
are analogous to the match values of 
library spectra displayed after a 
spectral search. A higher intensity 
value indicates a greater similarity to 
the reference spectrum. A value of 
1.0 indicates that the map spectrum 
and reference spectrum are identical. 

Turn off Auto Threshold and set 
Background Threshold to 0 and 
Foreground Threshold to 1 in the 
Display Setup dialog box before 
creating this profile type. See “Setting 
the thresholds automatically” and 
“Specifying the background and 
foreground thresholds” in the 
“Displaying Map Data” chapter for 
more information. 

The spectrum to use as the reference: 

 

 
 

If you want to use the spectrum in the spectral 
display pane, select Use Current Spectrum. 

If you select Use Spectrum From Disk, type the 
pathname of the desired spectrum in the text box, 
or use the Browse button to locate and select a 
spectrum. 

 
 

 Note Profiles created using the Chemigram and Peak Area Of One Peak profile 
types are identical. S 

 
In each case a profile created from a map is displayed in a profile window, 
which closely resembles a map window. 
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Follow these steps to create a profile using the line map or area map 
displayed in the active map window: 
 
1. Choose Profile Setup from the Atlµs menu. 
 
 The Profile Setup window appears: 
 

  
 
 
2. Set Profile Type to the desired profile type. 

lect, text boxes, a drop-down list box or 
option buttons may appear allowing you to enter or select the needed 

 
 

. Enter or select the appropriate information. 

 You can use the palette tools to specify some information graphically 
within the spectral display pane. 

 
• If you are creating a Chemigram, use the region tool or peak area 

tool to select a spectral region. See “Selecting a spectral region” or 
“Specifying peak areas and baselines” if you are not familiar with 
using the tools.  

 
 Depending on the type you se

information. See the table earlier in this section for a description of 
these items. 

3
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• If you selected the Peak Height Of One Peak or Peak Height Ratio
Of Two Peaks options, use the peak height tool to spec

 
ify the peak 

or peaks and a baseline. See “Specifying peak locations and 
plete information. 

 
• If you selected the Peak Area Of One Peak or Peak Area Ratio Of 

Two Peaks options, use the peak area tool to specify the peak or 
peaks and a baseline. (You can also use the region tool if you don’t 
need to manipulate the baseline endpoints graphically.) See 
“Specifying peak areas and baselines” for details on using the peak 
area tool. See “Selecting a spectral region” for information on using 
the region tool. 

 

tem if you 
need information on using the view finder. 

le window. Below is an example 

 

baselines” for com

 You can change the displayed spectral region by using the view finder 
below the spectral display pane. See the OMNIC Help sys

 
  
4. Click the Create button to create the new profile. 
 
 The new profile appears in a profi

showing a profile created from an area map. A profile created from an 
area depth profile would be similar. 
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 Below is an example showing a profile created from a line map. A 
profile created from a line depth profile would be similar. 

 

  
 
 You can use Display Setup in the View menu to change how data is 

displayed just as you would for a map window. See “Setting the display 
parameters” in the “Displaying Map Data” chapter for details. 

 
 If you don’t want to save the profile, the procedure is finished. 
 
 
5. To save the profile, click the Save button. 
 
 The Save Profile dialog box appears. 
 
 
6. Type a title for the profile in the text box. 
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7. Choose OK. 
 
 You can open the profile later by using Show Current Profile in the 

Atlµs menu. See “Displaying the current profile or a saved profile” in 
the “Displaying Map Data” chapter for details. 

 
 

Using the tool palette The tool palette in the Profile Setup window contains tools for 
manipulating the displayed spectrum and specifying peak information for 
creating profiles (see “Creating a profile” for details). The next sections 
explain how to use the tools. 
 

 Note The annotation tool is not used for creating a profile. S 

 
 

Zooming in on a 
portion of a spectrum 

 

You can enlarge a portion of the displayed spectrum just as you would in a 
spectral window. Simply use the selection tool to draw a box around the 
area and then click inside the box. 

 
 

Selecting a spectral region 

 

Use the region tool to specify a spectral region for the profile. When you 
select the tool, two vertical lines with triangular handles appear in the 
spectral display pane. Drag the lines to the desired starting and ending 
limits of the region. The area defined by the spectrum, the two lines and 
the baseline is shaded:  Blue shading indicates positive area (above the 
baseline). Gray shading indicates negative area (below the baseline). The 
total area is the sum of all the positive and negative areas. 
 
Here is an example of a selected region: 
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If Profile Type is set to a type that uses a spectral region and baseline, the 
specified values appear in the appropriate text boxes. 
 
 

Finding the X and Y 
values of a data point 

 

You can use the spectral cursor tool to find the exact X and Y values of a 
data point in the displayed spectrum. Simple select the tool and then click 
the point. The values appear above the tool palette. Here is an example: 

 

 
 
 

Specifying peak 
locations and baselines 

 

When you create a new profile using the Peak Height Of One Peak or Peak 
Height Ratio Of Two Peaks options, you can use the peak height tool to 
specify the peak or peaks graphically. 
 
 
Specifying a single peak 
 
Follow these steps to specify a single peak for the Peak Height Of One 
Peak option (for creating a profile): 
 
1. Set Profile Type to Peak Height Of One Peak. 
 
 
2. Select the peak height tool. 
 
 A vertical line with a diamond-shaped handle appears in the spectral 

display pane. A baseline also appears with two triangular handles 
indicating the current baseline endpoints. See the illustration in the 
next step. 
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3. Drag the line to the desired peak location, and adjust the baseline 
by dragging the endpoints to new frequency locations.  

 
 Here is an example: 
 

  
 
 The specified values appear in the appropriate text boxes. 
 
 
Specifying two peaks 
 
Follow these steps to specify two peaks for the Peak Height Ratio Of Two 
Peaks option (for creating a profile): 
 
1. Set Profile Type to Peak Height Ratio Of Two Peaks. 
 
 
2. Select the peak height tool. 
 
 A vertical line with a diamond-shaped handle appears in the spectral 

display pane. A baseline also appears with two triangular handles 
indicating the current baseline endpoints. See the illustration in the 
preceding procedure. 

 
 
3. Drag the line to the desired numerator peak location, and adjust 

the baseline by dragging the endpoints to new frequency locations.  
 
 The specified values appear in appropriate the Ratio Numerator text 

boxes. 
 
 
4. Click one of the Ratio Denominator text boxes. 
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5. Drag the line to the desired denominator peak location, and adjust 

the baseline by dragging the endpoints to new frequency locations.  
 
 The specified values appear in the appropriate Ratio Denominator text 

boxes. 
 
 

Specifying peak 
areas and baselines 

 

When you create a new profile using the Chemigram, Peak Area Of One 
Peak or Peak Area Ratio Of Two Peaks options, you can use the peak area 
tool to specify the peak or peaks graphically. (You can also use the region 
tool; see “Selecting a spectral region” for details.) 
 

 
Specifying a single peak area 
 
Follow these steps to specify the area of a single peak for the Peak Area Of 
One Peak option or to specify a spectral region for the Chemigram option 
(for creating a profile): 
 
1. Set Profile Type to Chemigram or Peak Area Of One Peak. 
 
 
2. Select the peak area tool. 
 
 Two vertical lines with triangular handles appear in the spectral display 

pane. A baseline also appears with two triangular handles indicating the 
current baseline endpoints. See the illustration in the next step. 

 
 
3. Drag the lines to the starting and ending limits of the desired 

spectral region, and adjust the baseline by dragging the endpoints 
to new frequency locations. 

 
 The area defined by the spectrum, the two lines and the baseline is 

shaded:  The area defined by the spectrum, the two lines and the 
baseline is shaded:  Blue shading indicates positive area (above the 
baseline). Gray shading indicates negative area (below the baseline). 
The total area is the sum of all the positive and negative areas. 
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 Here is an example of a specified area: 
 

  
 
 The specified values appear in the appropriate text boxes. 
 
 
Specifying two peak areas 
 
Follow these steps to specify the areas of two peaks for the Peak Area Ratio 
Of Two Peaks option (for creating a profile): 
 
1. Set Profile Type to Peak Area Ratio Of Two Peaks. 
 
 
2. Select the peak area tool. 
 
 Two vertical lines with triangular handles appear in the spectral display 

pane. A baseline also appears with two triangular handles indicating the 
current baseline endpoints. See the illustration in the preceding 
procedure. 

 
 
3. Drag the lines to the desired starting and ending limits of the 

numerator spectral region, and adjust the baseline by dragging the 
endpoints to new frequency locations. 

 
 The area defined by the spectrum, the two lines and the baseline is 

shaded:  The area defined by the spectrum, the two lines and the 
baseline is shaded:  Blue shading indicates positive area (above the 
baseline). Gray shading indicates negative area (below the baseline). 
The total area is the sum of all the positive and negative areas. 

 
 The specified values appear in the appropriate Ratio Numerator text 

boxes. 
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4. Click one of the Ratio Denominator text boxes. 
 
 
5. Drag the lines to the desired starting and ending limits of the 

denominator spectral region, and adjust the baseline by dragging 
the endpoints to new frequency locations.  

 
 The specified values appear in the appropriate Ratio Denominator text 

boxes. 
 
 

Converting a 
map to other units 

You can use the Process menu commands listed below to convert the 
spectra in an infrared map to different Y-axis units. 
 
 

Use this command… To convert to these units… 

Absorbance
 

absorbance 

% Transmittance
 

% transmittance 

Other Conversions
 

Kubelka-Munk, % reflectance or log (1/R) 

 
 
For more information and instructions, find “units” in the OMNIC Help 
system Index and go to the appropriate topic:  “Converting spectra to 
absorbance,” “Converting spectra to % transmittance” or “Converting 
spectra to special units” (for the Other Conversions command). 
 
If you convert a map’s units, you will be asked whether to save the map 
when you close it. We recommend that you convert and then save a copy 
of the map using a different file name (with Save Map As in the File 
menu), unless you are sure that you want to change the original data 
permanently. 
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Reprocessing a map Reprocess Map in the Atlµs menu lets you transform the interferogram data 
for an infrared map using different transform parameter settings or ratio the 
map spectra against a different background in order to improve the final 
data. You can use any stored background spectrum and change the settings 
several parameters. Only maps collected with the interferograms saved can 
be reprocessed. See “Saving interferograms with the map” in the “Preparing 
for Data Collection” chapter for more information. 
 
Follow these steps to reprocess the active infrared map: 
 
1. Choose Reprocess from the Process menu. 
  
 The Reprocess dialog box appears showing the current settings of the 

transform parameters. 
 
 
2. If you want to change the setting of a parameter, select a setting 

from the drop-down list box to the right of the parameter name. 
   
 You can select a resolution that is less than or equal to that of the 

original map. 
 
 
3. If you want to reprocess the map using a different background, use 

the Browse button to locate and select a background. 
 
 
4. When the parameters and background file are set the way you want 

them, choose OK to reprocess the map. 
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Retrieving 
interferograms saved 

with map spectra 

Choose Retrieve Interferograms from the Process menu to display in a 
spectral window the sample and background interferograms for the selected 
sample point of the infrared active map. (To select a point, click it in the 
contour map, video image or 3-D image.) To be retrieved and displayed, 
the interferograms must have been saved when the map spectra were 
collected. See “Saving interferograms with the map” in the “Preparing for 
Data Collection” chapter for more information. 
 
If you discover a problem with the transformed data, you may be able to 
diagnose the problem by examining the interferogram. 
 
 

Saving an 
area map profile 

as a CSV text file 

Use Save Profile As CSV Text in the Atlµs menu to save all the profile data 
of an area map in a map window or profile window as a CSV (comma-
separated values) text file. You can open the saved file later using an 
application that opens CSV files. Follow these steps: 
 
1. Choose Save Profile As CSV Text from the Atlµs menu. 
 
 The Save As dialog box appears. 
 
 
2. Type a file name in the File Name text box. 
 
 Use the file extension .CSV. 
 
 
3. Locate and open the directory where you want the profile saved. 
 
 
4. Choose OK. 
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Truncating the 
spectral and spatial 

ranges of a map 

Use Truncate Data Set in the Atlµs menu to permanently delete from the 
active map all the spectral data outside a specified spectral region and 
spatial area of the sample. This is useful for reducing the size of large maps 
and speeding up interactions with them. It is also useful for eliminating 
noisy data. If you think you may need the deleted data later, save the map 
using a different name before you truncate the spectral range. 

 
Follow these steps: 
 
1. Choose Truncate Data Set from the Atlµs menu. 
  
 The Truncate Data Set dialog box appears. Here is an example showing 

the parameters for an area map: 
 

 
 
 
 
 

For a line map or line 
depth profile only one spatial 

dimension appears. It represents 
distance along the line of the map. 

 
 For an area depth profile, 

spatial Z limits appear instead 
of Y limits. They represent depth. 

 
For a discrete point map only 

the spectral range can be changed. 

  
 
 The Current Limits box displays the current spectral frequency limits 

and, below them, the current X and Y spatial limits, if applicable. 
 
 For an area depth profile, the spatial X values indicate the horizontal 

distance limits (along the top edge of the mapped vertical area), and the 
spatial Z values indicate the vertical distance limits. 
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2. Type the desired spectral frequency limits in the Spectral text boxes 
in the New Limits box. 

 
 The spectra in the resulting map will contain data only within these 

limits. 
 
 
3. Type the desired spatial limits in the Spatial text boxes in the New 

Limits box (if available). 
 
 The resulting map will contain only those spectra collected at sample 

points within these limits. 
 
 
4. Choose OK.  
 
 The spectral data outside the specified regions is deleted from the map. 

This can take several minutes.  

 
  Truncating the spectral range of a map 

 

  You can use Truncate Data Set to isolate spectral regions having 
relatively high signal-to-noise ratios (SNR). If the SNR is poor, it will 
be poorest at the low-wavenumber end of the spectral range. You can 
eliminate that portion of the range by truncating the map spectra. If 
you fail to eliminate bad data from the map, misleading profiles may 
result, especially if the map has been baseline-corrected.  
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Extracting a line map 
from an area map 

Use Extract Line Map in the Atlµs menu to create a new line map from 
spectra contained in the active area map. The new map is displayed in a 
new map window. Follow these steps: 
 

 Note If you prefer to specify the line numerically, skip to step 2. S 

 
1. Use the mouse to draw the desired line across the area contour map 

or the video image. 
 
 If a line map icon (shown below) appears next to the pointer when it is 

in the contour map pane or video pane, you can draw the line in either 
pane. 

 

  
 
 If the line map icon is absent, first right-click anywhere in the contour 

map pane or video pane, point to Cursor Mode in the pop-up menu 
and then choose Extract Line Map. You can then draw a line in either 
pane. 

 
 Here is an example showing a line drawn in the video pane: 
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 You can move the line or change its length or slope:  Simply point to 
the line’s center or an endpoint so that directional arrows appear, and 
then drag the line or the endpoint to the desired location. 

 
 
2. Choose Extract Line Map from the Atlµs menu. 
 
 The Extract Line Map dialog box appears: 
 

 
 

 
 

If you drew a line in 
step 1, the X and Y values of its 

endpoints appear in the dialog box. 

 
 
 The minimum and maximum X and Y values of the map data appear 

below the text boxes. The X and Y values of the start and end of the 
line must be within this range of values. 

 
 
3. Type the X and Y values you want used for the line endpoints in the 

appropriate text boxes, or make any desired changes to the 
displayed values. 

 
 
4. Choose OK. 
 
 The line map is calculated and displayed in a new map window. 
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Viewing, 
editing or creating 
functional groups 

Use Edit Functional Groups in the Atlµs menu to view, edit or delete 
existing user-defined functional groups or create new functional groups to 
be used for creating profiles. A functional group in OMNIC Atlµs shows 
the locations of a chemical functional group on a sample. 
 
When you specify the spectral regions for a functional group, you also 
specify a weighting factor for each region. The weighting factor determines 
the degree to which a region influences spectral differentiation. Using a 
weighting factor for each region is necessary, since many functional groups 
have more than one band that can be used to confirm the group’s presence 
in a sample. Assign a larger weighting factor to regions that are more 
helpful in differentiating the group from other groups. 
 
After you create a functional group, it becomes available for your selection 
when you set up a profile with Profile Setup in the Atlµs menu.  See 
“Creating a profile” in the “Processing and Analyzing Map Data” chapter 
for details on creating profiles. 
 
Follow these steps to view, edit or create functional groups: 
 
1. In the map window, display a spectrum of a compound that 

contains one or more functional groups of interest. 
 
 Displaying a spectrum that contains bands caused by the functional 

groups can help you specify the spectral regions for the groups 
graphically. (You will also be able to specify the regions by typing their 
numerical region limits.) 
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2. Choose Edit Functional Groups from the Atlµs menu. 
 
 The Edit Functional Groups window appears with the spectrum in the 

pane near the top of the window. Here is an example: 
 

  
 
 The Region Information box contains a table showing the frequency 

limits of the spectral regions currently specified for the functional group 
indicated by the Current Functional Group drop-down list box. If you 
click a row of the table, the spectral region specified by that row is 
indicated in the pane by a shaded area between two vertical region 
markers. An arrow near the left edge of the table shows which spectral 
region is currently indicated in the pane. When needed, a scroll bar is 
provided for scrolling rows of the table into view. 

 
 Each spectral region has a weighting factor, shown in the Weight 

column of the table. 
 
  
3. To view the region information for a particular functional group, 

select the group from the Current Functional Group drop-down list 
box. 
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4. If desired, edit the region information for the current functional 
group. 

 
 To do this, click the row of the table that specifies the spectral region 

you want to change and then drag the handles of the region markers in 
the pane to the desired frequency limits. The X values of the marker 
locations appear in the readout below the pane to help you position the 
markers precisely. 

 
 You can also specify a region limit by double-clicking the current limit 

in the table, typing a new value and then pressing Enter. 
 
 You can change the view of the spectrum to see a region more clearly 

by using the view finder below the pane. (See the OMNIC Help system 
if you need information on using the view finder.) If you want to 
display the spectrum “full scale” so that it fills the pane vertically, click 
the Full Scale button at the bottom of the window. 

 
 If you want to change the weighting factor for a region, double-click 

the factor in the table, type a new value and then press Enter. 
 
 You can add a spectral region to the table by clicking the Add button in 

the Region Information box. A row is added to the bottom of the table. 
Edit the region limits and weighting factor in the row as described 
above. 

 
 You can delete an entire spectral region specification by clicking its row 

in the table and then clicking the Delete button in the Region 
Information box. 

 
 
5. If desired, create one or more new functional groups. 
 
 To create a group, type a title for the group in the New Group Title box 

and then click the Add button in the Group Information box. The new 
title appears in the Current Functional Group drop-down list box. 

 
 Specify the spectral regions for the group and their weighting factors by 

using the editing methods described above. 
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 You can delete an entire functional group specification by selecting the 
group from the Current Functional Group drop-down list box and then 
clicking the Delete button in the Group Information box. 

 
 
6. If desired, change the title of one or more functional groups. 
 
 To edit a title, first select the group whose title you want to change 

from the Current Functional Group drop-down list box. The title text 
is automatically selected and ready to change. Type a new title or use 
standard techniques to edit the title text. 

 
 
7. When you are finished viewing or specifying the functional groups 

and their spectral regions, choose OK. 
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Correcting 
map spectra 

OMNIC Atlµs provides features for correcting map spectra in the following 
ways: 
 
• Remove dispersion effects. 
• Remove the effects of water absorptions. 
• Remove the effects of carbon dioxide absorptions. 
• Automatically correct the baselines of all the spectra in a map. 
• Correct attenuated total reflection (ATR) spectra for the shifting of 

infrared absorption bands and the effects of variation in depth of 
penetration. 

 
The next sections explain how to use the features. 
 
 

Correcting the 
baselines of map 

spectra automatically 

Use Automatic Baseline Correct in the Process menu to automatically 
correct the tilted baselines of map spectra, with the baseline points selected 
by the software. In OMNIC Help Topics find “baseline” in the Index and 
go to “Correcting baselines automatically” for more information and 
instructions. 
 
If you correct a map, you will be asked whether to save the map when you 
close it. We recommend that you correct and then save a copy of the map 
using a different file name (with Save Map As in the File menu), unless you 
are sure that you want to change the original data permanently. 
 
 

Using 
Advanced ATR Correction 

Use Advanced ATR Correction in the Process menu to correct attenuated 
total reflection (ATR) spectra in the active map for the shifting of infrared 
absorption bands and the effects of variation in depth of penetration. In 
OMNIC Help Topics find “ATR correction” in the Index and go to 
“Using Advanced ATR Correction” for more information and instructions.
 
If you correct a map, you will be asked whether to save the map when you 
close it. We recommend that you correct and then save a copy of the map 
using a different file name (with Save Map As in the File menu), unless you 
are sure that you want to change the original data permanently. 
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Correcting map spectra 
for dispersion effects 
or water and carbon 
dioxide absorptions 

Use Other Corrections in the Process menu to correct map spectra for 
dispersion effects (select the Kramers-Kronig option) or water or carbon 
dioxide absorptions. In OMNIC Help Topics find “Other Corrections 
command” in the Index and go to “Using Other Corrections” for more 
information and instructions. 
 
If you correct a map, you will be asked whether to save the map when you 
close it. We recommend that you correct and then save a copy of the map 
using a different file name (with Save Map As in the File menu), unless you 
are sure that you want to change the original data permanently. 
 
 

Blanking a 
spectral region 

Use Blank in the Process menu to delete the data points in the specified 
spectral region of your map spectra. This is useful, for example, when the 
spectra contain totally absorbing peaks that would cause poor library search 
results. In OMNIC Help Topics find “Blank command” in the Index and 
go to “Blanking a spectral region” for more information about the uses of 
Blank. 
 
If you blank a spectral region of a map, you will be asked whether to save 
the map when you close it. We recommend that you blank the region and 
then save a copy of the map using a different file name (with Save Map As 
in the File menu), unless you are sure that you want to change the original 
data permanently. 
 
You can specify the spectral region graphically or numerically, as explained 
in the following procedures. 

 
 
Follow these steps if you want to specify the spectral region graphically: 
 
1. Set the spectral display pane cursor to region mode if it is in zoom 

mode. 
 
 The cursor is in zoom mode if no vertical lines with triangular handles 

appear in the pane. To set the cursor to region mode, right-click 
anywhere in the pane, point to Cursor Mode in the pop-up menu and 
then choose Region. Two vertical lines appear (see the illustration in 
the next step). 
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2. Drag the lines by their triangular handles to the desired starting 
and ending frequencies. 

 
 Here is an example: 
 

  
 
 The peak area between the two lines is shaded. The data points in this 

region will be deleted. 
 
 
3. Choose Blank from the Process menu. 
 
 The data points in the region are deleted: 
 

  
 
 
Follow these steps if you want to specify the spectral region numerically: 

1. Set the spectral display pane cursor to zoom mode if it is in region 
mode. 

 
 The cursor is in region mode if two vertical lines with triangular 

handles appear in the pane. To set the cursor to zoom mode, right-click 
anywhere in the pane, point to Cursor Mode in the pop-up menu and 
then choose Zoom. 
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2. Choose Blank from the Process menu. 

 The Blank Range dialog box appears. 

 
. Type the X-axis limits of the region to blank in the Frequency Start 

and Frequency End text boxes. 
 

4. 
 
 nd of 

 
 

 

 

3

 
Choose OK. 

The data points in the region are deleted. See the example at the e
the preceding procedure. 
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Replacing a 
spectral region 

with a straight line 

Straight Line in the Process menu lets you replace the selected region of 
your map spectra (or the displayed region if no region is selected) with data 

oints that form a straight line. Use Straight Line to remove unwanted 

Hel
“Replacing a spectral region with a straight line” for more information. 
 
If you replace a spectral region of a map, you will be asked whether to save 

e  
then save a copy of the map using a different file name (with Save Map As 
in the File menu), unless you are sure that you want to change the original 
data

lained 
in t

 
 
Foll
 
1. play pane cursor to region mode if it is in zoom 

mode. 
 

appear in the pane. To set the cursor to region mode, right-click 

 

2. Drag the lines by their triangular handles to the desired starting 
and ending frequencies. 

 
 Here is an example: 

p
spectral features in order to improve the appearance of spectra. In OMNIC 

p Topics find “Straight Line command” in the Index and go to 

th map when you close it. We recommend that you replace the region and

 permanently. 
 
You can specify the spectral region graphically or numerically, as exp

he following procedures. 

ow these steps if you want to specify the spectral region graphically: 

Set the spectral dis

 The cursor is in zoom mode if no vertical lines with triangular handles 

anywhere in the pane, point to Cursor Mode in the pop-up menu and 
then choose Region. Two vertical lines appear (see the illustration in 
the next step). 
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 The peak area between the two lines is shaded, and a baseline shows 
where the straight line will appear when the region is replaced. 

 

 
 
3. Choose Straight Line from the Process menu. 
 
 The region is replaced with a straight line: 
 

 
 

 
Follow these steps if you want to specify the spectral region numerically: 
 
1. Set the spectral display pane cursor to zoom mode if it is in region 

mode. 
 
 The cursor is in region mode if two vertical lines with triangular 

handles appear in the pane. To set the cursor to zoom mode, right-click 
anywhere in the pane, point to Cursor Mode in the pop-up menu and 
then choose Zoom. 

 
 
2. Choose Straight Line from the Process menu. 
 
 The Straight Line Range dialog box appears. 
 
 
3. Type the X-axis limits of the region you want to replace in the 

Frequency Start and Frequency End text boxes. 
 
 
4. Choose OK. 
 
 The region is replaced with a straight line. See the example at the end 

of the preceding procedure. 
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Smoothing

n you 

re that you want to change the original data permanently. 

Smoothing map spectra 
by specifying the number 

of smoothing points 

ectra 
ral 

peaks obscured 
by noise. 

 Note setting 
matically, use 

Automatic Smooth as explained in the next section. An automatic smooth 

f 
ed 

in the following procedure. 
 

 Important The smoothing algorithm smoothes all sharp peaks, including sample 
peaks. Be careful when smoothing spectra with real sample peaks that are 
narrow, since these features will also be smoothed. S 

 
 Note Smoothing degrades the effective spectral resolution of the data and can 

remove (“smooth out”) small spectral features. An alternative to smoothing 
is to collect more scans. S 

 

 map data The following sections discuss using Smooth, Automatic Smooth or Pixel 
Addition in the Process menu to smooth your map data. 
 
If you smooth a map, you will be asked whether to save the map whe
close it. We recommend that you smooth the map and then save a copy of 
the map using a different file name (with Save Map As in the File menu), 
unless you are su
 
 
Use Smooth in the Process menu to improve the appearance of map sp
by preferentially smoothing the high-frequency component of the spect
data. Smoothing is useful for improving the appearance of 

 
To smooth spectra manually by specifying the degree of smoothing (
the number of points), use Smooth. To smooth spectra auto

often gives a satisfactory result and is faster than a manual smooth. S 

 
The degree to which a spectrum is smoothed depends on the number o
smooth points used and the selected polynomial order. These are explain
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Follow these steps to smooth the spectra in the active map: 
 

 
 The Smooth window appears: 

 

1. Choose Smooth from the Process menu. 

 

 
 
 The spectral display pane contains the spectrum collected at a point 

indicated by the cross hairs in the video image. Except for the case of a 
line depth profile, you can display a different spectrum by clicking 
another point in the video image or dragging the cross hairs. The 
location of the point appears below the spectral display pane. 

 
If you select Replace Original Map Spectra With Processed Spectra (the 
default), the original spectra will be replaced by the smoothed spectra 
when you choose OK. If this option is not selected, the original map 

 smoothed 

 

 
 
2. Specify whether to replace the original map spectra. 

 

will appear in the map window and both the original and
spectra will be saved in the map file. When you open the map later, you 
will be asked whether to display the original or processed spectra. 
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3 Specify the desired number of smooth points by setting Number Of 
Smooth Points. 

The value to the right of the number of points represents the frequ
range that is considered when smoothing a point in a spectrum. T

. 

 
 ency 

he 
value is the product of the number of smooth points and the data 

 
 You

larg
ould normally smooth using the minimum number of points that 

produce the desired result. 
 
 For moderate smoothing of a spectrum at 4- or 8-wavenumber 

resolution, start with 5, 7 or 9 points. Compare the sharpest bands in 
e original spectra with the same bands in the smoothed spectra to 

determine whether the resolution was degraded significantly. If the 
resolution was not significantly degraded, increase the number of points 
and smooth again if needed. Otherwise, decrease the number of points 
and smooth again. 

 
 
4. 
 
 You can set the polynomial order to any number from 1 to 6. A higher 

ord
Typ r average 
smoothing. 

 Note e han the setting of Points. 

zero. S 

 
 

5. To 
 
 The smoothed spectrum is overlaid on the original spectrum. You can 

 

spacing. 

 can set the number of points to any odd number from 5 to 25. A 
er number of points results in a greater degree of smoothing. You 

sh

th

Specify the desired polynomial order by setting Polynomial Order. 

er results in less smoothing; lower orders cause more smoothing. 
ically a setting of 3 (for cubic polynomial) is used fo

 
h  setting of Polynomial Order must be smaller tT

If the polynomial order is greater than the number of data points for 
smoothing, any additional polynomial coefficients are automatically set to 

see the effects of your settings, choose Apply. 

change the settings and choose Apply again to see the effect of the new 
settings. 
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6. When you are finished, choose OK. 
 
 

Smoothing map 
spectra automatically 

Use Automatic Smooth in the Process menu to improve the appearance of 
map spectra by preferentially smoothing the high-frequency component of 
the spectral data. Smoothing is useful for improving the appearance of 
peaks obscured by noise. In OMNIC Help Topics find “Automatic 
Smooth command” in the Index and go to “Smoothing spectra 
automatically” for more information and instructions. 
 

 you want to specify the number of smoothing points, use Smooth in the 
rocess menu. See the preceding section for details. 

 

If
P
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Changing 
the data spacing 

Use Change Data Spacing in the Process menu to change the spatial
spectral spacing of the active map. (For a discrete point map only the 
spectral data spacing can 

 and 

be changed.) Spatial data spacing is distance 
between adjacent sample points on the sample surface. Spectral data 

acing is the number of wavenumbers between data points in a spectrum. 
 is determined by the resolution and zero filling settings used when you 

collect the data. 
 

 you use this command to change the spectral data spacing to a higher 

dds 

 have the same spectral data spacing. 
If the maps were collected using different spacings, you can use this 
command to change the spacing of one to match the other. 

must match that of the 
andard spectra used to develop the method. Use this command when 

necessary to change the spectral data spacing of the map to match the 
andards before creating a profile showing quantitative analysis results. 

 

sp
It

If
value, the software deresolves the data. If you change the spectral data 
spacing to a lower value, the software zero fills the data; that is, it a
interpolated data points between the existing data points. 
 
You can best compare two maps if they

 
In quantitative analysis the spectral data spacing 
st

st
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Follow these steps to change the data spacing of a map: 

1. 
 
 The Change Data Spacing dialog box appears. Here is an example: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

For a discrete point map only the 
spectral data spacing can be changed. 

 

 
Choose Change Data Spacing from the Process menu. 

 
 
 The current dimensions (in steps) of the map and the number of data 

points per spectrum appear at the top of the dialog box. 
 
 

. Change the spatial data spacing if desired. 
 

int map. 

 The current step size (the distance between points) is considered to be 
1. Changes you make to the step size will be relative to this value. 

For a line map or line depth profile the New Width value shows the 

2

 Skip to step 3 if you are displaying a discrete po
 

 
 

number of steps in the line; the New Height value does not apply. 
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 For an area map the New Width value shows the number of steps along 
the width of the map, and the New Height value shows the number of 
steps along the height of the map. For an area depth profile the New 
Width value shows the number of horizontal steps, and the New 
Height value shows the number of vertical (Z dimension) steps. 

 
• To increase the step size, and thus remove existing sample points 

from the map to spatially deresolve the data, type a value greater 
than 1 in the Step Size text box. The New Width and New Height 

. 
 

ages all the data equally, resulting in 
smaller peaks. 

• To decrease the step size, and thus add interpolated sample points 
n the 

ange. 
 

ate values. 
 
 
3. Cha
 

The current data spacing appears in the Data Spacing drop-down list 
box. 

 points 
from the spectra to deresolve the data, set Data Spacing to a greater 
value. The New Number Of Points value automatically decreases to 
reflect the change. 

 

e Extrema setting tends to preserve the full amplitude of 
peaks. The Average setting averages all the data equally, resulting in 
smaller peaks. 

values, if applicable, automatically decrease to reflect the change. 
 
 Then specify the algorithm for the operation by setting Algorithm

The Preserve Extrema setting tends to preserve the full amplitude of
peaks. The Average setting aver

 

between existing points in the map, type a value less than 1 i
Step Size text box. The New Width and New Height values, if 
applicable, automatically increase to reflect the ch

 Then specify the interpolation to use for adding sample points by 
selecting an algorithm from the Algorithm drop-down list box. The 
Linear Interpolation setting calculates the intensity values of the 
new points in a simple, linear manner. The Spline Interpolation 
setting uses a cubic polynomial to calcul

nge the spectral data spacing if desired. 

 

 
• To increase the data spacing, and thus remove existing data

 Then specify the algorithm for the operation by setting Algorithm. 
The Preserv
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• To decrease the data spacing, and thus add interpolated data 
points between existing points in the spectra, set Data Spacing to a 
smaller value. The New Number Of Points value automatically 
increases to reflect the change. 

 
 Then specify the interpolation to use for adding data points by 

selecting an algorithm from the Algorithm drop-down list box. T
Linear Interpolation se

he 
tting calculates the intensity values of the 

new points in a simple, linear manner. The Spline Interpolation 
setting uses a cubic polynomial to calculate values. 

 
 
4. Choose OK. 
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Performing 
math operations 
on map spectra 

in how 
 use these commands. 

 

Performing a 
scaled subtraction 

on map spectra 

Use Subtract in the Process menu to subtract a spectrum from the spectra 
of the active map. 
 
If you perform a subtraction on a map, you will be asked whether to save 

e map when you close it. We recommend that you perform the 
subtraction and then save a copy of the map using a different file name 
(with Save Map As in the File menu), unless you are sure that you want to 
change the original data permanently. 
 
Follow these steps to perform a scaled subtraction: 

Choose Subtract from the Process menu. 
 
 The Subtract window appears: 
 

OMNIC Atlµs provides several commands in the Process menu for 
performing math operations on map spectra. The next sections expla
to

 

th

 
1. 

  
 
 The upper spectral display pane contains the spectrum collected a

point indicated by the cross hairs in the video image. Except for the 
case

t a 

 of a line depth profile, you can display a different spectrum by 
clicking another point in the video image or dragging the cross hairs. 
The location of the point appears below the color bar. 

 
 The lower spectral display pane is used to display the result spectrum. 
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2. Specify the spectrum to subtract. 

• To subtract the spectrum displayed in the upper spectral display pan
select Use Current S

 
e, 

pectrum. You can display a different spectrum by 
clicking another location in the video image. 

dow 
 

ol” in the “Displaying Map Data” chapter for 
details. 

 
trum in the 

text box, or use the Browse button to locate and select a spectrum. 

 
3. 
 
 ed spectrum will be multiplied by a subtraction factor before 

being subtracted from the map spectra. This lets you compensate for 

Use Auto Factor. 
 
• To use a constant factor that you specify, select Use Constant Factor 

and then type the desired factor in the Constant text box. 
 
 
4. To see the subtraction result, choose Apply. 
 
 You can change your settings and choose Apply again to see the effect 

of the new settings. 
 
 
5. When you are satisfied with the subtraction result, choose OK. 
 
 

 
 You can use the sky view control just as you would in a map win

to adjust the display of the video image. See “Adjusting the display
with the sky view contr

 
• To subtract another spectrum stored on a disk, select Use Spectrum

From Disk. Then type the pathname of the desired spec

 

Specify the subtraction factor. 

The specifi

unequal spectral intensities in the specified spectrum and the map 
spectra, giving better subtraction results. 

 
• To use a subtraction factor that is calculated automatically, select 
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Subtracting 
a component 

or contaminant 
from map spectra 

 to subtract 
from the spectra of the active map the spectral data due to a particular 

n of a reference spectrum 
at contains the undesirable peaks, you allow the software to automatically 

ete will best eliminate those peaks. In 
OMNIC Help Topics find “component” in the Index and go to 
“Subtracting a component or contaminant from a mixture spectrum” for 
more information. 
 
If you perform a subtraction on a map, you will be asked whether to save 
the map when you close it. We recommend that you perform the 
subtraction and then save a copy of the map using a different file name 
(with Save Map As in the File menu), unless you are sure that you want to 
change the original data permanently. 
 
Follow these steps to subtract a component or contaminant from a map: 
 
1. Choose Automatic Region Subtract from the Process menu. 
 

The Automatic Region Subtract dialog box appears. 
 
 
2. Specify the reference spectrum that contains the component peaks. 
 

• To use the spectrum displayed in the spectral display pane of the map 
window, select Use Current Spectrum. 

 

 Spectrum 
From Disk. Then type the pathname of the desired spectrum in the 

 
 
3.  

 
The software uses this region to automatically determine the 
subtraction factor. 

 
. Choose OK. 

 
 

Use Automatic Region Subtract command in the Process menu

component or contaminant. By selecting the regio
th
d rmine the subtraction factor that 

 

• To use another spectrum stored on a disk, select Use

text box, or use the Browse button to locate and select a spectrum. 

Enter the X-axis limits of the region that contains the component
peaks in the Frequency Start and Frequency End text boxes. 

 

 

4
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Multiplying map 
spectra by a number 

 multiply each data point in a your 
ap spectra by a number of your choice. This is useful when you want to 

By making the intensity of a peak in one spectrum match that of the same 
peak in another spectrum, you can see how the relative intensities of the 
ther peaks compare. In OMNIC Help Topics find “Multiply command” 

mber” for more 
formation and instructions. 

 
If you multiply a map by a number, you will be asked whether to save the 
map when you close it. We recommend that you perform the 
multiplication and then save a copy of the map using a different file name 
(with Save Map As in the File menu), unless you are sure that you want to 
cha  
 
 

Converting map 
spectra to their first 

and second derivatives 

Use Derivative in the Process menu to convert the spectra in the active map 
to their first or second derivatives. 

The first derivative is useful for revealing peaks that appear as shoulders in 
the original spectra. It shows the rate of change across the entire spectrum. 

are 
minimum points in the first derivative curve are the points of maximum 
rate of change and not the maximum and minimum points of the original 

eaks. The maximum and minimum points of the original peaks have a Y 
value of zero in the first derivative. 
 

se the second derivative to find the exact location (center) of shoulders in 
the original spectra. It shows the change in the rate of change across the 
spectrum. This curve is more complex than the first derivative, with 
significantly narrower bands. The second derivative is useful for finding 
exact peak locations since peaks in the second derivative appear at the same 
locations as peaks in the original spectrum. The second derivative has more 
baseline noise than the first derivative. For each derivative operation you 
perform, the noise level increases slightly, the signal strength decreases 
dramatically and the signal-to-noise ratio decreases. 
 

Use Multiply in the Process menu to
m
scale the spectra so that data of very different intensities can be compared. 

o
in the Index and go to “Multiplying a spectrum by a nu
in

nge the original data permanently. 

 

This means that in the first derivative, shoulders become narrower and thus 
easier to see. It is important to remember that the maximum and 

p

U
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You can specify that the conversion be done using no filter, using 
Savitzky-Golay derivative filter, or using the Norris derivative filter: 
 
• Select the First Difference De

the 

rivative option if you do not want to use a 
filter. 

itsky-Golay Derivative option is useful for improving the 
red by noise. It uses the specified 

number of data points and polynomial order to determine the degree of 

that produce the desired result. Typically a setting of 7 is used for 
average smoothing. 

s 
original spectrum with the same bands in the smoothed 

spectrum to determine whether the resolution was degraded 
significantly. If it was not, increase the number of data points and 
smooth again if needed. 

 
 You can set the polynomial order to any number from 1 to 6 (the 

default value is 3). A higher polynomial order results in less smoothing; 
lower orders cause more smoothing. Typically a setting of 3 (for cubic 
polynomial) is used for average smoothing. 

 
 Note The setting of Polynomial Order must be smaller than the setting of Points. 

If the polynomial order is greater than the number of data points for 
smoothing, any additional polynomial coefficients are automatically set to 

ro. S 

 
 Important The Savitzky-Golay algorithm smoothes all peaks. Smoothing degrades the 

effective spectral resolution of the data and can remove (“smooth out”) 
small spectral features, including sample peaks, especially those in mid-IR 
spectra. S 

 

 
• The Sav

appearance of peaks that are obscu

smoothing for the conversion. 
 
 You can set the number of data points to any odd number from 3 to 

51. A larger number results in a greater degree of smoothing. You 
should normally smooth using the minimum number of data points 

 
 For moderate smoothing of a spectrum at 4- or 8-wavenumber 

resolution, start with a setting of 5, 7 or 9. Compare the sharpest band
in the 

ze
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• The Norris Derivative option is typically applied to near-IR spectra. It 
is often used to enhance a sharp band that is overlapped by another 
broad band. It is also useful for improving the appearance of peaks that 

 segment length and gap between 
segments to determine the degree of smoothing. We define the gap 
between segments as the distance, in number of data points, between 
two consecutive segments. 

  
, 

 
You can set the size of the gap to any number from 1 to 20 (the default 
value is 5). Increasing the gap may enhance a sharp band that is 
overlapped by another broad band. A larger gap will also produce larger 
differences for broad peaks and tend to lower the resolution of the 
spectrum. 

 
 you convert a map, you will be asked whether to save the map when you 

the 
unless you are sure that you want to change the original data permanently. 
 

are obscured by noise. 
 
 The Norris Derivative option uses the

 
You can set the segment length to any odd number from 1 to 51 (the
default value is 5). Increasing the length results in greater smoothing
since the length determines how many points are averaged. 

 

If
close it. We recommend that you convert the map and then save a copy of 

map using a different file name (with Save Map As in the File menu), 
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Follow these steps to convert map spectra to their derivatives: 

1. 
 

The Derivative window appears: 

 

 
Choose Derivative from the Process menu. 

 
 

 
 
 The spectral display pane contains the spectrum collected at a point 

indicated by the cross hairs in the video image. Except for the case of a 
line depth profile, you can display a different spectrum by clicking 
another point in the video image or dragging the cross hairs. The 
location of the point appears below the spectral display pane. 

 
 
2. Specify whether to replace the original map spectra. 
 
 If you select Replace Original Map Spectra With Processed Spectra (the 

default), the original spectra will be replaced by the derivative spectra 
when you choose OK. If this option is not selected, the original map 
will appear in the map window and both the original and derivative 
spectra will be saved in the map file. When you open the map later, you 
will be asked whether to display the original or processed spectra. 

 
 
3. Select a derivative order from the drop-down list box. 
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4. Select the filter option to use. 
 
 If you selected First Difference Derivative, go to step 6. If you selected 

another option, continue with the next step. 

5. ion. 

• If you selected Savitsky-Golay Derivative, set Points to an odd 

to any number from 1 to 6; a higher setting 
results in less smoothing. 

• If you selected Norris Derivative, set Segment Length to an odd 
number from 1 to 51; a higher setting results in greater smoothing. 
Set Gap Between Segments to any number from 1 to 20; a higher 
value tends to lower the resolution of the spectrum. 

 
 

. To see the effect of your settings, choose Apply. 

 n 
new 

7. 
 
 

 
 

Set the parameters for the selected filter opt
 

number from 3 to 51; a higher setting results in greater smoothing. 
Set Polynomial Order 

 

6
 

The derivative spectrum is overlaid with the original spectrum. You ca
change the settings and choose Apply again to see the effect of the 
settings. 

 
 

When you are finished, choose OK. 
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Performing 
spectral math operations 

Use Spectral Math in the Process menu to perform spectral math 
operations on spectra in the active map. When you choose the comm
the Spectral Math window appears letting you select one of the operations 
described in the following table. 
 

and, 

 
Operation Description 

A The original spectrum is unchanged. 

A + k he factor k is added to the Y value of each data point. Use the Factor 
utton as explained in the following procedure to specify k. 

T
b

-log(A) The software calculates the negative logarithm of the Y value of each data 
point. This is the inverse of the exp(-A) operation. 

exp(-A) power 
f the Y value; that is, e-Y. This is the inverse of the -log(A) operation. 

For each data point the natural log base e is raised to the negative 
o

Mean Center-Channel ified spatial 
ortion of the map and then subtracts the average from each spectrum in 
e map. 

The software calculates the average of the spectra in the spec
p
th

Mean Center-Spectrum For each map spectrum the software calculates the average Y value for all 
the data points in the spectrum and then subtracts this value from the Y 
value of each data point. The average Y value of each resultant spectrum is 
zero. You can specify spectral regions to exclude before the average Y 
values are calculated. 

Variance Scaling For each map spectrum the software calculates the standard deviation of 
the Y values of all the data points in the spectrum and then divides the Y 
value of each data point by the standard deviation. The standard deviation 
of the Y values of all the data points in each resultant spectrum is one. 
You can specify spectral regions to exclude before the average Y values are 
calculated. 
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Follow these steps to perform spectral math operations on the spectra in
active map: 
 
1. Choose Spectral Math from the Process menu. 
 
 The Spectral Math window appears: 

 the 

 

 

 
 
 The upper spectral display pane contains the spectrum collected at a 

point indicated by the cross hairs in the video image. Except for the 
case of a line depth profile, you can display a different spectrum by 
clicking another point in the video image or dragging the cross hairs. 
The location of the point appears below the color bar. 

 
 You can use the sky view control to zoom in on an area in the video 

image just as you would in a map window. You can also zoom in by 
drawing a box around an area and clicking inside the box. If desired, 
drag the handles on the sides or corners of the box to adjust its size and 
shape before clicking inside it. 

 
You can zoom in on an area of the spectrum by drawing a box around 

uld in a map 
window. 

 

 
the area and clicking inside the box. You can also change the displayed 
spectral region by using the view finder just as you wo
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 The lower spectral display pane contains the spectrum that results from 
the spectral math operation you perform (explained below). 

 You can adjust the size of the lower spectral display pane, the video 
image and the view finder by dragging their pane borders. 

 
 
2. Set Operation to the desired operation. 

3.  the Factor button to specify the value of 
factor k. 

When you choose Factor, the Spectral Math Factor dialog box appears. 
Type a new factor in the text box and then choose OK. 

 
 
4. If you selected Mean Center-Channel and want to use only a 

portion of the spatial area of the map for the operation, specify the 
portion. 

 
 To do this, click the video image. A box (mask) appears representing 

the area that will be used. Here is an example: 
 

 

 

 
 

If you selected A + k, use
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 Adjust the location, size and orientation of the box so that it surrounds
the desired area. To move the box, point

 
 to its center and then drag the 

box. To resize the box, drag any side. To rotate the box, drag any 

 
You can use the area outside the box for the operation instead of the 
area inside the box by selecting Invert Mask. 

 
5. If you selected Mean Center-Spectrum or Variance Scaling, specify 

 
 
 

corner. 

 

 

the region information. 

Use the features in the Region box: 

  
 
 Specify the number of regions to exclude from the calculation by 

 of 

 
cy values in the 

Start and End text boxes or by dragging the triangular region marker 

 

 

. When you are satisfied with the result spectrum, choose OK. 

setting Number Of Regions. If you select 0, the entire spectral range
the map will be used. 

Specify the limits of the first region by typing frequen 

handles in the lower spectral display pane. The specified region is 
shaded. 

 
 To specify the next region, click the Next button and then use the 

techniques described above. You can click the Back button to return to 
the settings for the previous region. You can click the Remove button
to delete a region. 

 
 
6. Choose Calculate. 
 
 The result spectrum appears in the lower spectral display pane. 

 
7
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Normalizing the 
frequency of the data 

alize 

n 
rence laser frequency of 15,798.0 

avenumbers. 

Normalizing the 
scale of the data 

se Normalize Scale in the Process menu to change the Y-axis scale of the 

 
 and go to “Normalizing 

the scale of spectra” for more information and instructions. 

 

Use Normalize Frequency, if available in the Process menu, to norm
the frequency of the active map. This repositions the data points at 
standard locations; that is, the locations they would be at if they had bee
collected using a system with a refe
w
 
In OMNIC Help Topics find “frequency” in the Index and go to 
“Normalizing the frequency of a spectrum” for more information and 
instructions. 
 
 
U
active map to a “normal” scale:  the Y values of the data points range from 
0 to 1 for the highest peak (or from 10% to 100% transmittance). This 
normal scale is typical of spectra in commercial spectral libraries. 

In OMNIC Help Topics find “scale” in the Index
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Shifting 
and unshifting 

FT-Raman map data 

ou  
Cus
inst
go to “How to convert a Raman spectrum  (or map) to Raman shift,” 
“How to shift a Raman spectrum (or map) using a specified frequency” or 

 
 

Splitting a map into 
separate data files 

ollow the steps below to use Split Map in the Atlµs menu to split the 
t map, or just a 

portion of the data, into separate .SPA, .GAML, .CSV or .JDX (JCAMP-
X) files. The new files are created by copying the specified portion of the 

map; the original map remains intact on the disk. 
 

ou can use Open in the File menu to open multiple .CSV or .JDX files 
split from a map. For instructions, choose OMNIC Help Topics from the 
Help menu, find “CSV file format” in the Index and go to the “Opening a 
CSV text file” topic. The provided instructions apply to both .CSV and 
.JDX files. 
 

. Choose Split Map from the Atlµs menu. 
 
 The Split Map dialog box appears. If you are splitting an area map, it 

looks like this: 
 

 

Y  can shift and unshift FT-Raman map data by using Raman Shift,
tom Shift and Unshift in the Raman menu (if present). For 
ructions, in Raman Help Topics find “Raman shift” in the Index and 

“How to unshift a Raman spectrum (or map).” 

F
active line map, area map, depth profile or discrete poin

D

Y

1

 
 
 The Data Range values indicate the ranges of the X and Y dimensions 

of the data in the map, respectively, in micrometers. 
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 e 
: 

 

dimension is used instead of the 
Y dimension. It represents depth. A 

lower value indicates a shallower depth. 

 

If you are splitting a line map, line depth profile or area depth profile, th
dialog box looks like this

 
For a depth profile the Z 

 

The D
 
 ata Range values indicate the range of the distance dimension of 

e data in micrometers. 
 
 If you are splitting a discrete point map, the dialog box looks like this: 
 

 

th

 
 
 
2. Specify the starting and ending values of the portion of the map 

you want to split. 
 
 For an area map, type the starting and ending values for both the X and 

Y dimensions in the Start Split and End Split text boxes. 
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 For a line map or depth profile, type the starting and ending values in 
the Start Split and End Split text boxes. 

 
 For a discrete point map, type the starting and ending values in the 

Start Point and End Point text boxes. 
 
 

. Type a base name for saving the spectral data files in the Base Name 
text box. 

 The Target File readout shows the pathname that will be used for 
d consists of the specified base 

name, a four-digit number that will increase by one for each successive 
file saved, and an extension. Enter a unique, descriptive base name of 
up to four characters that will help you identify the files later. 

 
 
4. Specify the file type to use for the files by setting File Type. 
 
 
5. Specify the directory that contains the map. 
 
 To do this, choose Select Path. The Select Path dialog box appears. 

Locate and select the directory; it should appear in the Look In box 
when you are finished. Then click the Select button. 

 
 
6. Choose OK. 
 
 The map is split into separate files, which are stored in the specified 

directory. This may take several minutes. After the map is split, a dialog 
box appears showing where the last file (and the preceding files) has 
been saved. 

 
7. 

 After you finish this procedure, you can start working with the new files 
using the features of OMNIC. For example, to open one of the new 
files, use Open in the File menu. 

 
 

3

 

saving the files. The file name at the en

 

Choose OK. 
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Quantifying a map 
qua
sections explain how to specify a quant method using Quant Setup and 
qua
 
 

Specifying 
a quant method 

Use Quant Setup in the Analyze menu to specify a quant method for 
uantifying a line map or area map. In OMNIC Help Topics find “quant 

method” in the Index and go to “Selecting a quant method” for more 
information and instructions. 
 
 

Quantifying the map After you have specified a quant method with Quant Setup in the Analyze 
menu (see the preceding section), use Quantify in that menu to quantify 

 

 

 

Use Quant Setup and Quantify in the Analyze menu to perform a 
ntitative analysis on a line map, area map or depth profile. The next 

ntify the map using Quantify. 

q

the active line map, area map or depth profile. Follow these steps: 

1. Choose Quantify from the Analyze menu. 
 
 The Quantify window appears: 

 
 

The spectral display pane contains the spectrum collected at the point 
indicated by the cross hairs in the video image. You can display a 
different spectrum by using the arrow tool to click another point in the 
video image or drag the cross hairs. The location of the point appears 
below the spectral display pane. 
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 You can zoom in on an area in the video image by drawing a box 
around the area in the video image and clicking inside the box. If 
desired, drag the handles on the sides or corners of the box to adjust its 

 
You can zoom in on an area of the displayed spectrum by drawing a 
box around the area and clicking inside the box. 

 
2. Type the pathlength in the Pathlength text box. 

 
3. fy only a portion of the spatial area of the 

map, specify the portion by using a mask. 

size and shape before clicking inside it. 

 

 

 

If you want to quanti

 

 
You can select the rectangle mask

tool by clicking it, or by right-clicking
the video image and choosing Rectangle 

Mask Tool from the pop-up menu. 

 
. A box appears: 

 

Several masks are available:  To use a rectangular mask, select the
rectangle mask tool and click the video image

 
 

 
 
 Adjust the location, size and orientation of the box so that it surrounds 

the desired area. To move the box, point to its center and then drag the 
box. To resize the box, drag any side. To rotate the box, drag any 
corner. 
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You can select the circle mask 

tool by clicking it, or by right-clicking 
the video image and choosing Circle 
Mask Tool from the pop-up menu. 

 

To use a circular mask, select the circle mask tool and click the video 
image. A circle appears: 

 
 

 
t or right side. 

 Adjust the location and size of the circle so that it surrounds the desired 
area. To move the circle, point to its center and then drag the circle. To
resize the circle, drag its top or bottom or lef

 

 
You can select the polygon mask 

tool by clicking it, or by right-clicking 
the video image and choosing Polygon 

Mask Tool from the pop-up menu. 

ick additional perimeter points to form the desired shape. Grid 
lines appear inside the polygon as you create it. To complete the 
polygon, either double-click the last perimeter point or click close to 
the starting point. Here is an example showing a completed polygon 
mask: 

To use a polygonal mask, select the polygon mask tool and click the 
location on video image where you want the polygon perimeter to start. 
Then cl
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 You can adjust the shape of the polygon by dragging a corner point or 
side of the polygon. To start over, draw a new polygon as explained 
above. The old polygon will be displayed in reverse video and t
disappear. 

hen 

alysis instead of 
the area inside the mask by selecting Invert Data Mask. 

 
 
4. Choose OK. 
 
 The results appear in a new window: 
 

 
 
 
 
 
 
 
 
 
 
 
 

You can change the size of the 
panes by dragging their borders. 

 
 You can use the area outside any mask shape for the an

 
 
 You can use Display Setup to change how data is displayed in this 

window. See “Setting the display parameters” in the “Displaying Map 
Data” chapter for details. 
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 The spectral display pane displays the spectrum collected at the point 
indicated by the cross hairs in the contour map (described below). You 

ent 

information choose OMNIC Help Topics from the Help menu, find 

 
 To display the results for a component measured by the quant method, 

click the desired component number near the lower-left corner of the 
e 

r other measured value of that component. When you 
point to a box, the value of that component appears. 

 
 Note he quant method determines which values are measured. The name of the 

quantitative analysis software used to develop the method was shown in the 

documentation that came with your quantitative analysis software for 
mplete information on interpreting the analysis results. 

 and 
contour map, which show the relative distribution of the component 

e 

distribution of the colors by adjusting the color bar just as you would in 
 

 
You can adjust the display of the 3-D image and contour map by using 
the sky view control just as you would in a map window. See “Using 
map windows” in the “Displaying Map Data” chapter if you need help. 

 
 You can print the entire window by using Print in the File menu. You 

can print individual panes by right-clicking the pane and choosing Print 
from the pop-up menu. 

 
 

can display a different spectrum by clicking another point in the 
contour map or by dragging the cross hairs. You can display a differ
spectral region in this pane by using the view finder. For more 

“view finder” in the Index and go to the “View finder” topic. 

window. The height of the box above each number indicates th
concentration o

T

Origin box when you selected a method using Quant Setup. See the 

co S 

 
The results for the clicked component appear in the 3-D image 

across the sample surface. The vertical axis of the 3-D image indicates 
the concentration or other measured value of the component, as do th
colors used in the 3-D image and contour map. You can adjust the 

a map window. See “Using map windows” in the “Displaying Map
Data” chapter for more information. 
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5. To save the results in a map file that you can open later, choose 
Save Map As from the File menu. 

 
 See “Saving a map with a new file name or in a different location” in 

the “Saving and Exporting Map Data” chapter for instructions. 
 
 
6. To close the window, click the Close button (labeled “X”) in the 

upper-right corner. 
 
 Depending on the quantitative analysis method you are using, you may 

be prompted to enter needed information. Follow the instructions that 
appear on the screen. 

 
 If you want to find the locations of components in the sample, leave 

the window open and use RGB Display in the Atlµs menu. See 
“Finding components locations” for details. 

 

Thermo Fisher Scientific OMNIC Atlµs User’s Guide 301 



Processing and Analyzing Map Data 

Principal 
component 

analysis (PCA) 

and

 
 

P Use Principal Component Analysis in the Atlµs menu to find the variance 
in an area map or area depth profile in terms of its principal components. 
The command reduces the dimensionality of the data set; that is, rather 
than looking at all of the spectral frequencies, you combine the information 
into a few values that describe the variation in the data. 
 
The first principal component found describes the combination of spectral 
locations with the largest spectral variance in the map. The second principal 
component describes the second largest source of variance, and so on. 
 
After you perform an analysis, you can use RGB Display in the Atlµs menu 
to blend specific results to find the locations of components in the sample. 
See “Finding component locations” for details. 
 
You can reduce the noise in your PCA results by using PCA Recalculation 
in the Atlµs menu. See “Recalculating principal component analysis results” 
for details. 
 
Follow these steps to perform a principal component analysis of the map in 

 
1. 
 
 If you have processed the map using Smooth or Derivative in the 

d 

 

The next sections explain how to perform a principal component analysis 
 recalculate the results to reduce noise. 

erforming a principal 
component analysis 

the active map window: 

Choose Principal Component Analysis from the Atlµs menu. 

Process menu and did not replace the original data with the processe
data, a prompt appears. Here is an example: 
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 Select the form of the data to use for the analysis and then choose OK. 
See “Smoothing map spectra by specifying the number of smoothing 

first and second 
derivatives” for more information. 

 
 The Principal Component Analysis window appears: 
 

 

points” and “Converting map spectra to their 

 
 

 click another point in the 
video image or drag the cross hairs. The location of the point appears 
below the spectral display pane. 

 
 You can zoom in on an area in the video image by drawing a box 

around the area in the video image and clicking inside the box. If 
desired, drag the handles on the sides or corners of the box to adjust its 
size and shape before clicking inside it. To redisplay the entire video 
image, right-click the image and then choose Full Range from the pop-
up menu. 

 
 You can zoom in on an area of the displayed spectrum by drawing a 

box around the area and clicking inside the box. To redisplay the entire 
spectrum, right-click the spectrum and then choose Full Range from the 
pop-up menu. 

 The spectral display pane contains the spectrum collected at the point 
indicated by the cross hairs in the video image. You can display a 
different spectrum by using the arrow tool to
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2 Select the desired options in the Statistical Processing box. 

Mean-Centering By Area (X,Y) and Variance Scaling help remove 
effects that are unrelated to variation in chemical composition; fo
example, effects caused by variation in sample thickness or scattering. 

Mean-Centeri

. 
 
 

r 

 
 ng By Spectrum helps remove effects caused by baseline 

variation. 

 
3. Set Number Of Factors to the desired number of principal 

 
 
 
 
4. s 

 
Specify the limits of the first region by typing frequency values in the 
Start and End text boxes or by dragging the triangular region marker 

 
To specify the next region, click the Next button and then use the 
techniques described above. You can click the Back button to return to 
the settings for the previous region. 

 

 

components. 

To change the setting, click the up or down arrow button. 

Use the features in the Regions box to specify the spectral region
for the analysis. 

 
 First specify the number of regions by setting Number Of Regions. If 

you select 0, the entire spectral range of the map will be used. 

 

handles in the spectral display pane. The specified region is shaded. 
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5. If you want to use only a portion of the spatial area of the map, 
specify the portion by using a mask. 

 

 
You can select the rectangle mask 

tool by clicking it, or by right-clicking 
the video image and choosing Rectangle 

Mask Tool from the pop-up menu. 

Several masks are available:  To use a rectangular mask, select the 
rectangle mask tool and click the video image. A box appears: 
 

 
 
 Adjust the location, size and orientation of the box so that it surrounds 

the desired area. To move the box, point to its center and then drag the 
box. To resize the box, drag any side. To rotate the box, drag any 

 
corner. 

 
You can select the circle mask 

tool by clicking it, or by right-clicking 
the video image and choosing Circle 
Mask Tool from the pop-up menu. 

To use a circular mask, select the circle mask tool and click the video 
image. A circle appears: 
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 Adjust the location and size of the circle so that it surrounds the desired 
area. To move the circle, point to its center and then drag the circle. To 
resize the circle, drag its top or bottom or left or right side. 

 

 
You can select the polygon mask

tool by clicking it, or by right-clicking 
the video image and choosing Polygon

Mask Tool from the pop-up menu.

To use a polygonal mask, select the polygon mask tool and click the 
location on video image where you want the polygon perimeter to start. 
Then click additional perimeter points to form the desired shape. Grid 
lines appear inside the polygon as you create it. To complete the 
polygon, either double-click the last perimeter point or click close to 
the starting point. Here is an example showing a completed polygon 
mask: 
 

 

 
 

 
 
 You can adjust the shape of the polygon by dragging a corner point or 

side of the polygon. To start over, draw a new polygon as explained 
above. The old polygon will be displayed in reverse video and then 
disappear. 

 k during an image analysis and 
have not exited the software (the saved mask is still in memory), the 

l be 
used for the analysis. See “Performing an image analysis” in the 
“Analyzing Images” chapter for information about saving a binary 

 
 You can use the area outside any mask shape for the analysis instead of 

the area inside the mask by selecting Invert Data Mask. 
 
 

 
If you saved a binary image as a mas

Use Image Mask check box is available. If you select it, the portion of 
the map that corresponds to the black area of the saved mask wil

image as a mask. 
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6. Choose OK. 
 
 The analysis results appear in a new window: 
 

 
 
 
 
 
 

You can change the size of the 
panes by dragging their borders. 

 

You can use Display Setup to change how data is displayed in this 
 
 

 The spectral display pane at the top of the window contains the 
spectrum collected at the point indicated by the cross hairs in the 
contour map (described below). You can display a different spectrum 
by clicking another point in the contour map or by dragging the cross 
hairs. You can display a different spectral region in this pane and in the 
principal component pane below it by using the view finder. For more 
information choose OMNIC Help Topics from the Help menu, find 
“view finder” in the Index and go to the “View finder” topic. 

 
 The principal component pane displays the principal components one 

at a time. Its vertical axis is used for the coefficient value, an indicator 
of relative contribution to spectral variance. 

 

window. See “Setting the display parameters” in the “Displaying Map 
Data” chapter for details. 
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 To display a component, click the desired component number near the 
lower-left corner of the window. The height of the box above each 
number indicates the overall relative strength of that component as a 
source of spectral variance. The first component is normally the 
strongest source. “R” represents the residual. If the box for the residual 
is large, it may indicate that additional components should be used in a 
new analysis. 

 
 The 3-D image shows the strength (measured along the vertical axis) of 

the current component over the mapped area of the sample. 
 
 The contour map is a two-dimensional representation of the strength of 

the current component over the mapped area. It shows which of the 

re used to indicate strength. You can adjust the 
distribution of the colors by adjusting the color bar just as you would in 
a map window. See “Using map windows” in the “Displaying Map 
Data” chapter for more information. 

 
 

lp. 

7. 
enu. 

See “Saving a map with a new file name or in a different location” in 
nstructions. 

 

8. 
right corner. 

 

 

individual map spectra contribute the most to each of the sources of 
variance. Colors a

 You can adjust the display of the 3-D image and contour map by using
the sky view control just as you would in a map window. See “Using 
map windows” in the “Displaying Map Data” chapter if you need he

 
 

To save the analysis results in a map file that you can open later, 
choose Save Map As from the File m

 
 

the “Saving and Exporting Map Data” chapter for i

 
To close the window, click the Close button (labeled “X”) in the 
upper-

 If you want to find the locations of components in the sample, leave 
the window open and use RGB Display in the Atlµs menu. See 
“Finding components locations” for details. 
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Recalculating 
principal component 

analysis results 

prove the results of a 
rincipal component analysis by reducing noise contributed by particular 

information about using the Principal Component Analysis command. 
 
Follow the steps below to use PCA Recalculation. The principal 
omponent analysis results must be displayed in the active window when 

you choose the comm
 
1. Choose PCA Recalculation from the Atlµs menu. 
 
 The PCA Recalculation dialog box appears. This dialog box lets you 

specify the contiguous components to retain when the analysis is 
recalculated. By omitting one or more noisy components (or the 
residual) at the beginning and end of the sequence, you can produce a 
result with less no

 
 
2. Specify the first c

To Use. 
 
 
3. Specify the last component to retain by setting Last Component To 

Use. 
 
 

Use PCA Recalculation in the Atlµs menu to im
p
components. See “Performing a principal component analysis” for 

c
and. 

ise. 

omponent to retain by setting First Component 
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4. Choose OK. 
 

The analysis results appear in a new window: 
 

 
 
 
 
 
 

You can change the size of the 
panes by dragging their borders. 

 

 
 This window is very similar to a map window. See “Using map 

windows” for information about manipulating the parts of the window. 
 
 
5. To save the results in a map file that you can open later, choose 

Save Map As from the File menu. 
 
 See “Saving a map with a new file name or in a different location” in 

the “Saving and Exporting Map Data” chapter for instructions. 
 
 
6. To close the window, click the Close button (labeled “X”) in the 

upper-right corner. 
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Using Multivariate 
Curve Resolution 

Mu
components are present in the active area map or area depth profile, as well 
as the locations and concentrations of those components. This is an 
enhancement over normal map analysis, since the estimates of the pure 
components and the concentrations are computed at the same time. Also, 
unlike the principal components that result from principal component 

sear
 
Follow these steps to use MCR: 
 
1. Choose Multivariate Curve Resolution from the Atlµs menu. 
 
 The Multivariate Curve Resolution window appears: 
 

 

ltivariate Curve Resolution (MCR) lets you estimate which pure 

analysis (PCA), the pure component spectra that result from MCR can be 
ched against spectral databases. 

 
 
 The spectral display pane contains the spectrum collected at the point 

indicated by the cross hairs in the video image. You can display a 
different spectrum by using the arrow tool to click another point in the 
video image or drag the cross hairs. The location of the point appears 
below the spectral display pane. 

 
 Note The displayed spectrum does not affect the MCR calculation. It only helps 

you define the spectral regions to use for the calculation. S 
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 You can zoom in on an area in the video image by drawing a box 
around the area in the video image and clicking inside the box. If 
desired, drag the handles on the sides or corners of the box to adjust its 
size and shape before clicking inside it. To redisplay the entire video 
image, right-click the image and then choose Full Range from the pop-
up menu. 

 
 ou can zoom in on an area of the displayed spectrum by drawing a 

box around the area and clicking inside the box. To redisplay the entire 
spectrum, right-click the spectrum and then choose Full Range from the 
pop-up menu. 

 
 
2. Use the features in the Regions box to specify the spectral regions 

for the analysis. 
 
 First specify the number of regions by setting Number Of Regions. If 

you select 0, the entire spectral range of the map will be used. 
 
 Specify the limits of the first region by typing frequency values in the 

Start and End text boxes or by dragging the triangular region marker 
handles in the spectral display pane. The specified region is shaded. 

 To specify the next region, click the Next button and then use the 
techniques described above. You can click the Back button to return to 
the settings for the previous region. 

 
 
3. Specify the number of components to quantify. 
 
 You can type a number from 1 to 10 in the Number Of Pure 

Components text box or click the up and down arrow buttons to the 
right. 

 
 Note MCR requires a large amount of computer processing power and speed. 

Depending on its capability, your computer may not be able to calculate 
more than four or five components. We recommend starting with a small 
number of components and increasing the number in increments of one. S 

 

Y
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4. Specify an algorithm by setting Baseline. 
 

 data 
from dropping below a zero baseline (Y values are always positive). 
Select None if you don’t want to ensure positive Y values. 

 
 

 The available algorithms, described in the table below, prevent the

Setting Description 

None The baseline is allowed to drop below zero. 

Constant A constant baseline is added as a “component” for 
each spectrum. This baseline value is determined 
along with the amount of each component. 

Linear Two “components” are added for each spectrum. 
One is the constant part of the linear baseline, and 
the other is the sloping part of the linear baseline. 

Quadratic Three “components” are added for each 
spectrum. One is the constant part of the quadratic 
baseline, the second is the sloping part of the 
quadratic baseline, and the third is the curved part 
of the quadratic baseline. 
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5 If you want to use only a portion of the spatial area of the map, 
specify the portion by using a mask. 

. 

 

 
You can select the rectangle mask 

tool by clicking it, or by right-clicking 
the video image and choosing Rectangle 

Mask Tool from the pop-up menu. 

l and click the video image. A box appears: 
 

Several masks are available:  To use a rectangular mask, select the 
rectangle mask too

 
 
 Adjust the location, size and orientation of the box so that it surrounds 

he 
ate the box, drag any 

corner. 

the desired area. To move the box, point to its center and then drag t
box. To resize the box, drag any side. To rot
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You can select the circle mask 

tool by clicking it, or by right-clicking 
the video image and choosing Circle 
Mask Tool from the pop-up menu. 

To use a circular mask, select the circle mask tool and click the video 
image. A circle appears: 
 

 
 
 Adjust the location and size of the circle so that it surrounds the desired 

area. To move the circle, point to its center and then drag the circle. To 
resize the circle, drag its top or bottom or left or right side.  
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You can select the polygon mask 

tool by clicking it, or by right-clicking 
the video image and choosing Polygon 

Mask Tool from the pop-up menu. 

To use a polygonal mask, select the polygon mask tool and click the 
location on video image where you want the polygon perimeter to start. 
Then click additional perimeter points to form the desired shape. Grid 

 to 
ed polygon 

mask: 
 

lines appear inside the polygon as you create it. To complete the 
polygon, either double-click the last perimeter point or click close
the starting point. Here is an example showing a complet

 
 
 You can adjust the shape of the polygon by dragging a corner point or 

side of the polygon. To start over, draw a new polygon as explained 
above. The old polygon will be displayed in reverse video and then 
disappear. 

 
 If you saved a binary image as a mask during an image analysis and 

have not exited the software (the saved mask is still in memory), the 
Use Image Mask check box is available. If you select it, the portion of 
the map that corresponds to the black area of the saved mask will be 
used for the analysis. See “Performing an image analysis” in the 
“Analyzing Images” chapter for information about saving a binary 
image as a mask. 

 
 You can use the area outside any mask shape for the analysis instead of 

 

the area inside the mask by selecting Invert Data Mask. 
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6. Choose OK. 

The analysis results appe
 
 ar in a new window. Here is an example: 
 

 
 
 
 
 

You can change the size of the 
panes by dragging their borders. 

 
 You can use Display Setup to change how data is displayed in this 

window. See “Setting the display parameters” in the “Displaying Map 
Data” chapter for details. 

 
 The spectral display pane at the top of the window contains the 

spectrum collected at the point indicated by the cross hairs in the 
contour map (described below). You can display a different spectrum 
by clicking another point in the contour map or by dragging the cross 
hairs. You can display a different spectral region in this pane and in the 
principal component pane below it by using the view finder. For more 
information choose OMNIC Help Topics from the Help menu, find 
“view finder” in the Index and go to the “View finder” topic. 

 
 The component pane displays the components one at a time. Its 

vertical axis is used for the coefficient value, which is proportional to 
the concentration. 
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 To display a component, click the box above the desired component 
number near the lower-left corner of the window. The height of the 
box indicates the relative portion of the total composition attributed to 
that component. When you point to a box, the portion is shown as a 
numerical value. 

 
 The 3-D image shows the relative concentration (measured along the 

vertical axis) of the current component over the mapped area of the 
sample. 

 
 The contour map is a two-dimensional representation of the relative 

concentration of the current component over the mapped area. Colors 
are used to indicate concentration. You can adjust the distribution of 
the colors by adjusting the color bar just as you would in a map 
window. See “Using map windows” in the “Displaying Map Data” 
chapter for more information. 

 
 You can adjust the display of the 3-D image and contour map by using 

the sky view control just as you would in a map window. See “Using 
map windows” in the “Displaying Map Data” chapter if you need help. 

 
 
7. To save the analysis results in a map file that you can open later, 

choose Save Map As from the File menu. 
 
 See “Saving a map with a new file name or in a different location” in 

the “Saving and Exporting Map Data” chapter for instructions. 
 
 
8. To close the window, click the Close button (labeled “X”) in the 

upper-right corner. 
 
 If you want to find the locations of components in the sample, leave 

the window open and use RGB Display in the Atlµs menu. See 
“Finding components locations” for details. 
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Finding
component locations 

Use RGB Display in the Atlµs menu to blend specific analysis results to 
find the physical locations of components in the sample. You can this 
ommand after you perform a principal component analysis (or open saved 

results), use Multivariate Curve Resolution (or open saved results), or 
sing 

Follow the steps below to use RGB Display. The results of using Principal 
m t be 

displayed in the active window when you choose the command. 

 

 
 
 
 
 

The spectral display pane does not 
appear for quantitative analysis results. 

 

c

quantify a map. See “Performing a principal component analysis,” “U
Multivariate Curve Resolution” or “Quantifying the map” for information 
about performing the mentioned operations. 
 

Co ponent Analysis, Multivariate Curve Resolution or Quantify mus

 
1. Choose RGB Display from the Atlµs menu. 

 The RGB Display window appears: 
 

 
 
 
2. Select up to three items to blend from the list of items near the top 

of the window. 
 
 The list includes the principal components and the residual. To select 

an item, click it. If you change your mind, click the item again. 
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 Click the up and down arrow buttons as needed to bring items into 
view in the box. 

 
 The selected items are overlaid in the top pane (see the illustration in 

the next step). The vertical axis of the pane indicates the relative 
contribution of the component to the spectral variance. 

 
 You can change the height of the top pane and the others by dragging 

their borders up or down as desired. 

e 
nd blue used to display the first, second and 

 
p. 

 
 
3. Click the Blend button. 
 
 A contour map of each selected item appears in the center pane of th

window, with red, green a
third maps, respectively. The name of the component or residual 
appears above each map. The pattern of color in a map indicates how
the strength of the component is distributed across the area of the ma
Here is an example: 

 

  

ether the colors of 
the selected images. 

 

 
 A blended image of the selected items appears in the bottom pane. The 

colors in the blended image result from adding tog
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 The Red, Green and Blue controls to the right of the blended image let 
you adjust the intensity of the colors. Simply drag the small vertical 
bars to the left or right. 

 
 

 new file name or in a different location” in 
the “Saving and Exporting Map Data” chapter for instructions. 

 
 Note You can copy the contents of the bottom four panes by right-clicking the 

pane and choosing Copy from the pop-up menu. S 

 

e 

 

4. To save the results in the same file that contains the principal 
component analysis results, choose Save Map As from the File 
menu. 

 
 See “Saving a map with a

 
5. To close the window, click the Close button (labeled “X”) in th

upper-right corner. 
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 Analyzing Images 
 
 
The Image Analysis command in the Atlµs menu lets you set up and 
perform “feature sizing,” a type of analysis in which you measure, count o
identify features in a chemical image (two-dimensional contour map) or 
video image. You can use the analysis to determine… 
 
• The distribution of chemical or visual features on or in a sample. 
• The size o

r 

f the features. 
• The percentage of the mapped portion of the sample that the features 

occupy. 
 
The next sections describe the filters you can use in an analysis and the 
morphology options you can select. Then “Performing an image analysis” 
pro
 
 

vides a step-by-step image analysis procedure. 
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U
scale filters 

When you choose Image Analysis from the Atlµs menu, the software 
converts the full-color chemical or video image into a gray scale image and 

applying gray scale filters, available 
Filters tab. The filters belong to classes whose names indicate their general 
purpose. The table below describes the available filters. Refer to this table 
when selecting filters during the procedure in “Performing an image 
analysis” later in this chapter. 
 
 

sing gray 

displays it in the Image Analysis window. You can enhance this image by 
through the Filter Setup button on the 

Class Filter Description 

Smoothing Mean Convolution filter that replaces every pixel with the average value of all the 
pixels within the convolution kernel. It also reduces the level of the salt-
and-pepper (impulse) noise. 

 Weighted Mean Convolution filter with different coefficients in the convolution kernel that 
give more importance (weight) to central pixels within the convolution 
neighborhood. The result of this convolution is less blurred than that of 
the Mean filter. It also reduces the level of the salt-and-pepper (impulse) 
no

When you select this filter, the Set button becomes available in the 
Advanced column in the Image Processing Setup dialog box. When you 
click the button, the Advanced Options For Weighted Mean Filter dialog 
box appears. Set the averaging coefficient and choose OK. 

ise. Also known as Lowpass and Gaussian filters. 

 ve Mean Convolution filter that is similar to the Mean filter, except that a pixel is 
used to compute the mean if, and only if, the difference between that pixel 
and the center pixel is less than or equal to the specified maximum 
difference. The result of this convolution is less blurred than that of the 
Mean filter. It also reduces the level of high-frequency (salt-and-pepper) 
noise. 

When you select this filter, the Set button becomes available in the 
Advanced column in the Image Processing Setup dialog box. When you 
click the button, the Advanced Filter Options dialog box appears. Set the 
maximum difference for the filter and choose OK. 

Adapti

 Open Nonlinear filter that computes the morphological erosion followed by the 
dilation using a circular structuring element as the kernel. It removes small 
low-intensity (dark) features and smoothes the edges. 
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Class Filter De

 Close Nonlinear filter that computes the morphological dilation followed by the 
ero
high-intensity (bright) features and smoothes the edges. 

scription 

sion using a circular structuring element as the kernel. It removes small 

Noise Removal Rank Nonlinear filter whose response is based on ordering (ranking) the pixels 
within the kernel and then replacing the central pixel with a value from the 
ranking. It effectively cancels even
noise and reduces gray-level oscillations without blurring. However, it may 
shift the edges of the image. 

W
Advanced column in the Image Processing Setup dialog box. When you 
click the button, the Advanced Filter Options dialog box appears. Set the 
rank difference percentage and choose OK. 

ly distributed salt-and-pepper (impulse) 

hen you select this filter, the Set button becomes available in the 

 Median Special case of the Rank filter (see the description above) that uses the 
median value for the pixel result. 

 See the description in the Smoothing class.Open  

 Close See the description in the Smoothing class. 

Sharpening High-boost Convolution filter that enhances differences in gray levels. It acts like a 
Laplace edge enhancement added back to the original image. 

When you select this filter, the Set button becomes available in the 
Advanced column in the Image Processing Setup dialog box. When you 
click the button, the Advanced Options For High-boost Filter dialog box 
appears. Set the filter coefficients and choose OK. 

 Gated Rank Similar to the Rank filter but uses two percentile values:  low and high gate 
values. The result central pixel in the kernel neighborhood will be either 
the low or high gate value, whichever is closer to the value of the central 
pixel. Tends to make spatial areas more evenly distributed, also canceling 
some noise. 

When you select this filter, the Set button becomes available in the 
Advanced column in the Image Processing Setup dialog box. When you 
click the button, the Advanced Filter Options dialog box appears. Set the 
low rank and high rank percentages and choose OK. 
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Class Filter Description 

 MinMax Special case of the Gated Rank filter that replaces the central pixel with 
either the minimum or maximum value from the kernel neighborhood, 
whichever is closer to the intensity of the center. Tends to enlarge and 
smooth the brightest and darkest areas in an image without changing 
intermediate areas. Also cancels some impulse noise. 

When you select this filter, the Set button becomes available in the 
Advanced column in the Image Processing Setup dialog box. When you 
click the button, the Advanced Filter Options dialog box appears. Set the 
rank difference percentage and choose OK. 

Edge Detection Sobel Two-pass convolution filter that enhances edges and small areas where 
intensity changes. Also blanks large areas with constant intensity. Useful for 
defect inspection. 

 Morph Gradient Computed as the difference between the morphological dilation and 
erosion with a circular structuring element. Highlights sharp gray-level 
transitions in the input image. 

 Convolution filter that enhances image edges and small areas where 
int ensity. Useful for 
de

W
Advanced column in the Image Processing Setup dialog box. When you 
cli
ap

Laplace 
ensity changes. Also blanks large areas with constant int
fect inspection. 

hen you select this filter, the Set button becomes available in the 

ck the button, the Advanced Options For Laplace Filter dialog box 
pears. Select the desired coefficients and choose OK. 

Contrast 
Adjustment 

Histogram 
Stretch 

Enhances the contrast in the significant portion of the image; that is, where 
the histogram peak intensities exceed a specified threshold. This filter is 
useful when a sharpening filter has produced an image whose important 
areas have low contrast. 

When you select this filter, the Histogram Stretching dialog box appears. 
Specify a clip threshold by typing a percentage value from 0.1 to 10 in the 
text box or by using the slider. Peaks that are less than the specified 
percentage of the maximum peak value are reduced to zero. Peaks that are 
within the specified percentage of the maximum peak value are increased to 
the maximum value. The range of values of the remaining peaks is 
“stretched” to go from zero to the maximum value. Choose OK to apply 
the filter. 
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 If you set Filter Class to All Filters, all of the filters listed above become 
available. S 

 
Morphology options Mo s 

you want to size. The table below describes the histogram parameters that 
become available when you select feature parameters on the Morphology 
tab (available through the Setup button on the Feature Sizing tab). Where 
appropriate, illustrations convey the meaning of the histogram parameters 
using an example image. Refer to this table when setting morphology 
options during the procedure in “Performing an image analysis” later in 
thi
 
 

Note 

rphology refers to the size, shape and measurements of the image feature

s chapter. 

Selected Feature 
Parameter 

Available Histogram 
Parameters 

Description 

Area Area eature area, as the number of pixels in the feature times pixel area, in 
current units squared. At the bottom of the results table, three 
additional values appear:  Total Image Area is the area of the entire 
image. Total Feature Area is the sum of the areas of the measured 
features. Feature Area Percentage is the percentage of the total image 
area that is within the measured features. 

F

Dimensional Perimeter Sum of the distances between centers of adjacent pixels on the feature 
perimeter, times pixel width, in current units. 

 
 Increasing X

 Perimeter

In
cr

ea
si

ng
 Y

 

 Circularity Perimeter squared divided by (4 pi times pixel area). 
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Selected Feature 
Parameter 

Available Histogram 
Parameters 

Description 

Location ss  X Center Of Ma X center of mass, as the average value of feature pixel X coordinate.

 
 Increasing X

Y center of mass,
Y ref

X ref
X center of mass

In
cr

ea
si

ng
 Y

 

 Y Center Of Mass Y center of mass, as the average value of feature pixel Y coordinate. See 
the preceding illustration. 

 X Ref To define the X Ref value, the software searches all horizontal chords 
along the Y center of mass to find the center of the largest horizontal 
chord. See the preceding illustration. 

 Y Ref True center of mass. See the preceding illustration. 
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Selected Feature 
Parameter 

Available Histogram 
Parameters 

Description 

Projection of the feature on the X-axis. 

 

Feret X Feret 

 Increasing X

Y feret

Y min

Y max

In
cr

ea
si

ng
 Y

X feret

X min X max  

 Y Feret Projection of the feature on the Y-axis. See the preceding illustration. 

 X Min Minimum value of the feature pixel X coordinate. See the preceding 
illustration. 

 X Max Maximum value of the feature pixel X coordinate. See the preceding 
illustration. 

 Y Min Minimum value of feature pixel Y coordinate. See the preceding 
illustration. 

 Y Max Maximum value of the feature pixel Y coordinate. See the preceding 
illustration. 

Fiber/Stringer Length Derived length of the feature or fiber, after it is straightened into a 
rectangle of equal area and perimeter, in current units. 
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Selected Feature 
Parameter 

Available Histogram 
Parameters 

D

 Width Feature projection perpendicular to the maximum projection, in 
current units. 

 

escription 

 Increasing X

 Orientation

 Width

In
cr

ea
si

ng
 Y

 

 Aspect Ratio Maximum projection divided by pixel width. Unitless. 

 Orientation Angle between the positive X-axis and the maximum feature 
projection, in degrees. Clockwise rotation from the X-axis is a positive 
orientation angle. See the preceding illustration. 

Projections Max Projection Maximum feature projection (maximum caliper dimension), as the 
largest separation between points on the feature convex perimeter, in 
current units. 

 
 Increasing X

M

Max projection

in projection

In
cr

ea
si

ng
 Y
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Selected Feature 
Parameter 

Available Histogram 
Parameters 

Description 

 Min Projection Minimum feature projection (minimum caliper dimension), as the 
smallest separation between points on the feature convex perimeter, in 
current units. See the preceding illustration. 

 Mean Projection M
shortest altitude of all triangles drawn between pixels on the convex 
perimeter, in current units. Triangle bases are defined by adjacent 
p

inimum feature projection (minimum caliper dimension), as the 

ixels, and peaks by pixels on the opposite side of the feature. 

 Standard Deviation Standard deviation of the projection measurements.  

Internal Internal Perimeter Internal perimeter, as the sum of distances between centers of adjacent 
pixels on the perimeters of feature inclusions, times pixel width, in 
current units. 

 
 Increasing X

In
cr

ea
si

ng
 Y

Inclusion

Internal
perimeter

 

 Internal Area The number of non-feature pixels completely surrounded by feature 
pixels multiplied by pixel area, in current units squared. 

 Internal Count The number of discrete inclusions. 

Convex Convex Area Convex area, as the number of pixels inside the feature convex 
perimeter, times pixel area, in current units. 

 Convex Circularity Convex circularity, as convex perimeter squared, divided by (4 pi times 
convex area). Unitless. 
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Selected Feature 
Parameter 

Available Histogram 
Parameters 

Description 

 Convex Length Convex length, derived as the length of a feature or fiber after it is 
straightened into a rectangle of equal area and perimeter, in current 
units. 

 Convex Perimeter Convex perimeter, as the sum of distances between centers of adjacent 
p
u

 

ixels on the feature convex perimeter, times pixel width, in current 
nits. 

 Increasing X

Convex perimeter
In

cr
ea

si
ng

 Y
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Performing an 
image analysis 

When you perform an image analysis, you first specify filters and intensity 
thresho
chemic
sizing t
features
window
Follow 
 
1. 
 
 See “Zooming in and out on map data” or “Adjusting the display with 

the sky view control” in the “Displaying Map Data” chapter for 
information on displaying only a portion of the data. 

 
 

 Choose Image Analysis from the Atlµs menu. 

 
 
 
3.  OK. 
 

 Note The Chemical Image option is not available for line maps or line depth 
pro
 

lds to designate the features of interest in the video image or 
al image (two-dimensional contour map). You then perform feature 
o obtain information about the size and distribution of these 
. You can perform an analysis on an image displayed in a map 
, profile window, PCA results window or MCR results window. 
these steps: 

Display the portion of the data that you want to analyze. 

2.
 

The Image Analysis dialog box appears. 

Select the type of image you want to analyze and then choose

files. S 
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 The Image Analysis window appears, with the Filters tab in front: 
 

 
 
 
 
 
 
 
 
 
 
 
 

You can change the sizes of the panes by 
dragging the borders that separate them. 

Video image or chemical imageX profile Y profile

Sky view controlHistogram

 
 The Filters tab lets you define and view profiles that show image 

intensity along the image cross hairs. For a video image, this is the gray 
level intensity; for a chemical image, this is the spectral intensity. 

 
 Each profile pane shows the image intensity along the corresponding 

cross hair in the image. You can move the cross hairs by dragging them 
or clicking a new location. The coordinate values of the current 
location appear below the histogram. 

 
The image pixels whose intensity falls within the intensity thresholds 
appear in red. You can adjust the thresholds by dragging the red 
threshold lines in either profile pane or in the histogram. You can also 
set the thresholds numerically by typing values in the Thresholds text 
boxes. 
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 To reset the thresholds to their original values (or to values determined 
by Auto-threshold in the Filter Setup dialog box, as explained in the 

 
 e thresholds and using optional gray scale filters 

(explained in the next step), you designate the pixels that make up the 

 
 f 

r 

 
4. If you want to specify filters that can enhance the image and let you 

locate features of interest, click the Filter Setup button. 
 

 Note This step should be performed only if you need to enhance the image by 
oothing it, sharpening it or removing noise. If you skip this step, 

 

next step), click the Reset button. 

By adjusting th

features to be analyzed on the Feature Sizing tab. These pixels will 
appear in black in the binary image displayed on that tab. 

The histogram shows the relative distribution of the intensity values o
the image pixels. (The X-axis is in intensity units.) Darker shades of 
gray are used in the histogram to represent lower intensities, and lighte
shades represent higher intensities. These shades correspond to the 
shades found in the image. 

 

sm
continue with step 5. S 

Thermo Fisher Scientific OMNIC Atlµs User’s Guide 335 



Analyzing Images 

 When you click the button, the Filter Setup dialog box appears: 

 

 

 
 
 At the top of the dialog box is a table that lets you specify gray scale 

filters to use for the analysis. The available filters are grouped into filter 
classes. See “Using gray scale filters” earlier in this chapter for 
descriptions of the filters in each class. Follow these steps to add or 
change the settings for a filter: 

 

Class column. The filters in that class 
become available. 

 
b. Select the desired filter from the drop-down list box in the Filters 

column. 
 
c. Specify the number of times to apply the filter by typing a number 

in the Iterations column. Normally one iteration is enough. 
 

a. Select the desired class from the drop-down list box in the 
appropriate row in the Filter 
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d. Select the desired kernel size (3-by-3 or 5-by-5) from the drop-
down list box in the Size column. The kernel is a matrix of pixels 
that will be passed over each pixel in the image. The intensity of the 
pixel under the kernel is replaced by the sum of each pixel intensity 
in the kernel times the coefficient value of the corresponding kernel 
pixel. Depending on the filters you have specified, the coefficient 

e. If the Set button is available in the Advanced column, click the 

 
 

lete Filter column. 
  

Binarization classifies the gray-level image pixels as either foreground or 
background, based on a calculated threshold. If you want the software 
to automatically calculate the optimal threshold, select Auto-threshold. 
This is often gives a good starting point for binarization. (You can still 

ters tab using the 
techniques explained in the preceding step.) Specify a thresholding 
algorithm by setting Thresholding Algorithm. The following table 
describes the optimization criteria of available algorithms: 

 
 

values can be positive or a mixture of positive and negative. 
 

button if you want to set advanced options for the filter. The 
Advanced Filter Options dialog box appears. Set the provided 
options and choose OK. 

To delete a filter from the table, click the Delete button in the filter’s 
row in the De

 

adjust the thresholds more precisely on the Fil

Setting Description 

Variance Minimizes the ratio of between-class variance to 
within-class variance for the bright and dark classes. 
This works best when the histogram has two or 
more peaks. 

Entropy Calculates the optimal threshold that maximizes the 
sum of the information (Shannon) entropies of the 
bright and dark classes. This works even if the 
histogram has only one pronounced peak (that is, a 
unimodal histogram). 
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Setting Description 

Moments Calculates the threshold based on preserving the 
statistical moments in the histogram. This is the 
fastest algorithm, since it has a direct formula for 
the threshold position. 

 
 
 Features can appear as either dark areas on a light background, or light 

areas on a dark background. If you want the software to automatically 
determine whether the background is light or dark, select Auto-detect 

mes that 
area is 

background, do not use Auto-detect. Instead, examine the image to 
select 

 
 l 

 Is Less Than (Pixels) and select the desired hole 
size threshold, in pixels, from the drop-down list box to the right. The 
equivalent size in micrometers appears to the right. You can also type a 
value in the text box. The largest dimension of each hole will be used to 
determine whether the hole is filled. Select All if you want all holes, 
regardless of size, to be filled. 

 
 To delete small features, select Remove Small Features Whose 

Diameter Is Less Than (Pixels) and select the desired feature size 
threshold, in pixels, from the drop-down list box to the right. You can 
also type a value in the text box. The largest dimension of each feature 
will be used to determine whether the feature is deleted. 

 
 To create a small gap between features that are connected, select 

Separate Touching Features. 
 
 
5. Choose OK to close the Filter Setup dialog box. 
 
 The effects of your settings appear on the Filters tab. 
 

in the Background Intensity box. In this case the software assu
most of the image area is background. If less than half of image 

determine whether the background is light or dark. If it is dark, 
Dark Background; if it is light, make sure Dark Background is not 
selected. 

To fill “holes” in features so that the features appear solid, select Fil
Holes Whose Diameter
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6 Work with the displayed data and image as desired. . 

 o 
reap
Filt

 
 You can measure items in the image:  Right-click the image, point to 

ursor Mode, choose Ruler from the pop-up menu, and then drag 

the histogram. You can manipulate the ruler just as you would in the 
Atlµ he 
Preparing for Data Collection” chapter if you need help. To remove 

nd choose Select 
And Zoom from the pop-up menu. 

 hen the ruler is not being used, you can zoom in on an area of 
te ng 

inside the box, just as you would in a map window. See “Zooming in 
and out on map data” in the “Displaying Map Data” chapter for 
details. 

 
 You can use the sky view control to change the display of the image just 

as you would to adjust the display of data in a map window. For details 
see “Adjusting the display with the sky view control” in the “Displaying 
Map Data” chapter. 

 
 You can copy the image or either profile to the Windows Clipboard. 

Simply right-click the pane and choose Copy from the pop-up menu. 
You can then paste the copied item into programs that allow pasting 
from the Clipboard. 

 
 You can save the image or either profile as a .bmp, .jpg or .tif file by 

right-clicking the pane and choosing Save from the pop-up menu. 
Specify a file name, location and file type in the dialog box that appears 
and then choose Save. You can open the file later using a program that 
opens files of its type. 

 
 You can print the binary image, spectrum, histogram or results table by 

right-clicking the pane and choosing Print from the pop-up menu. 
 
 

 
If you change threshold values to improve the binarization and want t

ply the previously specified filters (see step 3), click the Apply 
ers button. 

C
across the image to draw a ruler. The measured distance appears below 

s window. See “Moving the ruler” and “Resizing the ruler” in t
“
the ruler, right-click the map, point to Cursor Mode a

 
W
in rest by drawing a box on the image or in a profile pane and clicki
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7. Click the Feature Sizing tab. 
 

 

 

 Here is an example: 

View finder

Spectrum at cursor locationBinary image

 
 
 The upper-left pane displays the binary image created using the settings 

you specified on the Filters tab. 
 
 The upper-right pane displays the spectrum collected at the current 

location of the cursor cross hairs in the image. You can move the cross 
hairs by dragging them or clicking a new location. The coordinate 
values of the current location appear below the view finder. 

 
 The bottom two panes will be used later to display the feature sizing 

results. 
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 You can use the view finder to change the frequency limits just 
would in a map window. You can also change your view of the data by 
drawing a box on the image or in the spectral display pane and clic
inside the box, just as you could on the Filters tab. See the instruction
in step 2 if you need help. 

as you 

king 
s 

 
You can use a ruler to measure items in the image just as you could on 

 
 ming 

 the image and 
choose Save Image As Mask from the pop-up menu. The mask remains 

 
 

. Click the Setup button to specify the feature sizing measurements 

 
The Feature Sizing Setup dialog box appears: 

 

 
the Filters tab. See the instructions in step 2. 

You can save the binary image as a mask you can use when perfor
a principal component analysis. Simply right-click

in memory until you exit the software. See “Performing a principal 
component analysis” in the “Processing Map Data” chapter for more 
information. 

8
and sieves to use for the analysis. 
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 The Morphology tab lets you specify the feature sizing measurements 
to use for your analysis. In the Feature Parameters box select the 
parameters to include in the results table on the Feature Sizing tab of 
the Image Analysis window. 

 
 When you select a feature parameter, appropriate settings become 

available in the Histogram Parameter drop-down list box. Select the 
histogram parameter to plot in the histogram pane on the Feature 
Sizing tab. (You will be able to plot different parameters by clicking 
column headings in the results table on the Feature Sizing tab.) 

 
 See “Morphology options” earlier in this chapter for detailed 

descriptions of the available feature and histogram parameters. 
 
 The Sieves tab (shown below) lets you speed up the analysis by 

specifying one or more sieves that retain only those features that have 
certain characteristics. For example, you could specify a sieve to retain 
only those features whose perimeter is less than 4 micrometers or 
greater than 20 micrometers. Features must pass all the listed sieve 
criteria to be retained. 
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 Follow these steps to specify each sieve you want to use: 
 

a. Select a feature parameter from the center drop-down list box on 
the Sieves tab. These are the same parameters that can be selected 

ology tab. See “Morphology options” for detailed 
descriptions of the parameters. 

 

 

c. Click the Add button to add the sieve to the list. 

 Note 
 

from the Histogram Parameter drop-down list box on the 
Morph

b. Select the desired Boolean operators from the drop-down list boxes 
beside the feature parameter and enter values in the text boxes. 
Selecting a parameter determines the unit that appears, if any.

 

 
Each feature parameter can have only one sieve. S 

 To delete a sieve, select it in the list and click the Delete button. 
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9. Choose OK to close the Feature Sizing Setup dialog box. 

 on the Feature Sizing tab. Here is an 
example: 

 

 
 The analysis results appear

 

Image pane Map pane

Binary image with features colored

Histogram Results table  
 
 Each feature is assigned a consecutive number and displayed in a 

different color in the image. The numbers appear in the Feature # 
column of the results table. 

 
 Note If there are more than 16 features, the colors are reused in sequence as 

needed. S 

 
 For each feature the results table lists the results for the parameters you 

specified in the preceding step. Scroll bars are provided when needed to 
let you bring table columns or rows into view. When you click a cell in 
the table, the corresponding feature appears in red in the image. 
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 To see a plot of the results for a particular parameter, click the 
appropriate column heading. The plot appears in the histogram to th
left of the table. The X-axis of the histogram indicates the feature 
number; the Y-axis depends on the selected p

e 

arameter. As you move 
the mouse over the histogram, the vertical bar at the current X value 

he pane. 

pectrum, histogram or results table to 
the Windows Clipboard. Simply right-click the pane and choose Copy 
from the pop-up menu. You can then paste the copied item into 

age, spectrum, histogram or results table as a 
.bmp, .jpg or .tif file by right-clicking the pane and choosing Save from 
the pop-up menu. Specify a file name, location and file type in the 

 
ng a program that opens files of its type. 

You can print the binary image, spectrum, histogram or results table by 
 pane and choosing Print from the pop-up menu. 

10. To close the Image Analysis window, click the Close button 
(labeled “X”) in the upper-right corner. 

 
 

appears in green, and the Y value appears at the top of t
 
 You can copy the binary image, s

programs that allow pasting from the Clipboard. 
 
 You can save the binary im

dialog box that appears and then choose Save. You can open the file
later usi

 
 

right-clicking the
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 Saving and Exporting Map Data 

Saving a map  menu to save the active line map, area map 
r depth profile. You can open the map later using Open in the File menu 
ee “Opening a map or files from a split map” in the “Opening and 

 map with a different file name or in a different location, use 
ave Map As in the File menu. See the next section for details. 

.DAT) file by using Export in the 
ile menu, as explained in “Exporting map data.” 

Saving a map with 
a new file name or 

in a different location 

se Save Map As in the File menu to save the active line map, area map, 
f 

nding principal components using a different file name or location. You 
g Open in the File menu (see 

Opening a map or files from a split map” in the “Opening and Importing 
a ing a principle component analysis,” 

Quantifying a map” or “Finding component locations” in the “Processing 
nd Analyzing Map Data” chapter for information about PCA analyses, 

ocations, respectively. 

ollow these steps: 

. Choose Save Map As from the File menu. 

 The Save As dialog box appears. 
 
 

 
 
This chapter explains how to save and export map data you have collected 
or processed. 
 
 
Choose Save Map from the File
o
(s
Importing Map Data” chapter). 
 
If the map has not been saved before, the Save As dialog box appears. See 
the next section for instructions for using the dialog box. 
 
To save the
S
 
You can also export a map as an ENVI (*
F
 
 
U
depth profile, PCA results, quantitative analysis results, or the results o
fi
can open the map or other item later usin
“
M p Data” chapter). See “Perform
“
a
quantifying a map or finding component l
 
F
 
1
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2. Type the desired file name in the File Name text box. 
 
 Use the extension .MAP. 

  interferograms were saved when the map was collected, the name of the 

name will be retained.) See “Saving interferograms with the map” in the 
reparing for Data Collection” chapter for more information. S 

. Locate and open the directory where you want the item saved. 

. Choose Save. 

 
Note If

interferogram file will also be changed. (The “_IFG” portion of the file 

“P
 
 
3
 
 
4
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S
map background 

 

 
. Choose Save Map Background from the File menu. 

The Save As dialog box appears. 

. 
 

Use the extension .SPA. 

. Locate and open the directory where you want the background 
saved. 

 
4. Choose Save. 
 
 

aving the current Use Save Map Background, if available in the File menu, to save the 
current map background. See “Collecting an FT-IR or FT-Raman map 
background” in the “Collecting Map Data” chapter for information about
collecting map backgrounds. Follow these steps: 

1
 
 
 
 
2 Type the desired file name in the File Name text box. 

 
 
 
3
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Exporting map data Use Export in the File menu to save the map displayed in the active map 
window as an ENVI software file. Follow these steps: 
 
1. Choose Export from the File menu. 
 
 The Save As dialog box appears. 
 
 
2. Type a file name in the File Name text box. 
 
 
3. If you want the map exported to a different directory, locate and 

open that directory. 
 
 
4. Choose Save. 
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 Printing 
 
 
This chapter explains how to print a map window or profile window, items 
displayed in a map window and Mosaics. If you have not already selected 
and set up a printer, use Printer Setup in the File menu before printing. In 
OMNIC Help Topics find “printer” in the Index and go to “Setting up the 
printer” for more inform
 
 

ndow, profile 
ndow or quant 

 window 

Use Print in the File menu to print the active map window, profile window
or quant results (“Quantify”) window, with its currently displayed panes. 

ation. 

Printing a map 
wi

wi
results

You can use Options in the Edit menu to specify how to print the window; 
for example, whether to print the panes on separate pages. See “Specifying 
how to print map windows” in the “Preparing for Data Collection” chapter 
for details. 
 
You can also print individual panes of the window. See “Printing items 
displayed in a map
 

  To print a Mosaic of video images displayed in the navigation pane, use 
Print Mosaic in the Atl ained in “Printing a Mosaic.” S 

 
Follow these steps to print the active map window or profile window: 
 

 The Print dialog
 
 
2. Set the print parameters as desired. 
 
 

ose Print. 
 
 

 window” for details. 

Note
µs menu as expl

1. Choose Print from the File menu. 
 

 box appears. 

3. Cho



Printing 
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d 
in a map window, 
profile window or 

quant results window 

ow these steps to print an layed in a map window, 
profile window or quant resu
 
1. Right-click the item you want to print. 
 
 You can print the contour map (or discrete point location map), video 

image, spectral display pane and 3-D image. 
 
 
2. Choose Print from the 
 

 dialog box app

 
 
4. Choose Print. 

 

Printing Foll

items displaye
 individual item disp
lts window: 

pop-up menu. 

 The Print ears. 
 
 
3. Set the print parameters as desired. 

 



Printing 
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 a Mosaic After you have used Capture Mosaic in the Atlµs menu to display a Mosaic 
of video images for a sample area, you can print the Mosaic, along with the 
navigation pane axes, on paper by using Print Mosaic in the Atlµs menu. 
See “Capturing a Mosaic of video images for a sample area” for more 
information on displaying a Mosaic in the navigation pane. 
 
Follow these steps to print a Mosaic: 
 
1. Choose Print
 
 The Print dialog box appears allowing you to set the parameters for 

printing. 
 
 
2. Set the paramet
 
 
3. Choose OK. 

 

Printing

 Mosaic from the Atlµs menu. 

ers as desired. 
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